MEMO

TO: CADD Users

FROM: CADD Committee; Ron Henke (chairperson), Jon Collado, Diane Gunsch,
Nancy Horner, Diane Laub, DeLane Meier, Brian Raschke and Joyce Schmidt
(secretary)

DATE: July 26, 2007

SUBJECT: CADD Standards Implementation

The North Dakota Department of Transportation (NDDOT) wants to stress the importance of
following the CADD Standards. These standards increase the readability and consistency of
design plans. When the format is consistent, readers can find information quicker and a standard
level of professionalism is met and maintained.

CADD Standards are also needed for automation. CADD Standards allow applications such as
MicroStation and GEOPAK to work together. CADD tools and settings can be adjusted for one
particular way of drawing and designing. These tools can be set up once and used on multiple
projects. In order to make the most of these tools, the CADD Standards need to be used. The
NDDOT is expecting full implementation of the standards. The CADD Standards must be
followed.

If you are having difficulties applying the CADD Standards to a particular task, please contact
the CADD Specialist or a CADD Standards Representative.

20/jdc



CADD Standards

TABLE OF CONTENTS
May 2016

Support
Manuals and TULOFIAlS..........oooiiviiei e (UNE “12)evveeeernnns 1.1
The CADD Specialist and Support Groups ..........ccevveverivesverieseenee (May “16).veerveeneens 1.2
Standards COMMUTIEE ........cocviiii i (Feb “15).urrreerrrinns 1.3

Project Administration

ProJECt DIFECIOIIES ..oovveeiiecie et (DEC “10).rererrrere 2.1
File Naming CoNVENLIONS .......cccoevviieiieieeie e (SEPt “15) wovvvrrrerrernn. 2.2
Aareadme File and Directory Cleaning ..........ccccceeveiieiiiieiiesineeiinns QUIY “07) wrvverererereren 2.3
Standards DIFECIOTY ......ocveiiveieeiesee e (SR 2.4
Configuration Settings, Preference Settings and User Interface........ (March “14).............. 25
e o U o] 1o ] S (OCt “05) oo 2.6
CADD Standard Revisions (When to Use Old Standards)................ (OCt “08) w.oovrorre 2.7
Taking Electronic Drawings into the Field...........c.ccccoocevieiiviiennenee. (OCt “08) ..oovorr 2.8
Final Plan DelIVEIY .......c.oooiiiiiiie e (SEPt“13)vrrrerrrrinns 2.9
[ P T Al D1 (] 01U 1o ] R (April “09) vvve.vveee. 2.10
CUITENT SOTEWAIE ... (May “16).eereeerrines 2.11
Current RESOUICE FIlES.......ooiiviiiciie e (May “16)...veeenee.. 2.12
Software License AQre€mMeNtS ........covveiveiiieeiiesie e sie e sneesree e (SEPt“10) vrvreerrrnns 2.13
MicroStation
SO FHIBS ..ttt e e e e e e e e e e e e e n e (DEC “10).rerrrrreren 3.1
(€] (0] 2= L@ 5 T |1 S F SRS [ Ts) P 3.2
MicroStation Templates, Tools and Task Navigation ....................... (Sept “13) crvvrrererrrrren 3.3
[NV Z=T £ (Sept *10) vovvvvrrrrrernn. 3.4.1
“BYLEVEI” SELHINGS ..oovviiiicciie et TETIVEE ) D 3.4.2
(A= I I o] = 1= (Sept “10) ovvvverrrrernn. 3.4.3
LINE STYIES ..o (Sept “10) crvvrrererrrrren 3.5
GRS e e e [ATIVEE ) P 3.6
ANNOLALION AN FONES ...eiieiiii ittt e e e e e (May “16Y..rerrrrrrrre 3.7.1
P o] o (YA LA 0] T (SR 3.7.2
DIMENSIONING .....eiitiiiiie ettt aeere e (Sept “10) crvvrrervrrrrrer 3.8
Patterning and HatChing.........cccocovveviiieii e (G R10) J— 3.9
[d (0] B B T 1 V/=T £ TR (Sept “10) crvvrrererrrrren 3.10
PrINt OFQANIZEN ......ccvveieeie e [ Ts) P 3.11
Referencing Drawings and Attaching Rasters.........cccccoeveiveiieeinnnns (May “16Y..rerrrrrrrre 3.12
Printing Rasters (PICLUIES) ......ccvevveiieiieieece e (OCt “08) ..ovvrore 3.13

ANNOLALION SCAIE ...t (Sept “10) crvvrrervrrrrrer 3.14



CADD Standards

GEOPAK
GEOPAK USEr PrefereNCES ....cooeveeeeeeeieee et eaeee e e e e (OCt “08) vovvvvrererereren 41
GEOPAK Database (GPK) .......ccoceriririiiiisisieiese e (OCt “05) oo 4.2.1
Coordinate GEOMELIY .......veiieeieeciie s QUIY “07) v 422
ProjJECt IMANAGET .......eeveeiiecieeie et e e (OCt “05) oo 4.3
Design and Computation Manager .........cccceevveeveeiiieeiieiine e sie e (OCt *08) oo 4.4
Digital Terrain Model (DTM).....cccooiviiieiiee e QUNe “12).ovvree 4.5
Survey Manager Database ..........cccveevveiieiiieciic e (DEC “10)...rrrerre. 4.6
Cross Sections and Earthwork ...........ccocvvveveiieiieiiec e (DEC “13)..orrrrrrre 4.7
CrosS SECHION INTEIVAL ....vvveeeeiee et ETIVEE ) D 47.1
ROAAWAY DESIGNET .c.vveieeie et Q) J— 4.7.2
Criteria Files and Related Input Files ........cccccoeviieiieiieiiiciece, (NOV “11) erovererererere 47.3
SIOPE StAKE REPOIS .....vvevieieeie ettt nee s [T J— 4.7.4
BAITNWWOIK . ..eeeeieeeeeee ettt e e e e s e e e et e e e e e e e reees (APFil “13).ererererere. 475
DTMs for Automated Machine Guidance (AMG) .......ccccccevverieenenne. (March “14)............. 4.7.6
AMG DEIVEIADIES ...ttt e (May “16Y..rerrrrrrrre 4.7.7
Cross Section Sheet Layout Files .........cccooveveeiiiiieiisic e [GIIRET) N 4.8
Plan Sheet LIDIary.......ccccveieeie i (May “16Y..rerrrrrrrre 49
SUPET EIBVALION ......oviiiecc et [TV J— 4.10
Legal Description EQItOr.........ccoovviiiiiiieiic e (OCt “08) vovvvrrererereren 411
Survey Alignment Data SNeets .........cccovviveveeie i [GEIRCL) F— 4.12

Bentley Map

Geographic Coordinate Systems (GCS) .....cccovvvvverveieiiene e seeniens [GLISRET) N 5.1

Rasters and Geographic Coordinate SyStems ..........cccccevvvveveeiiieeninns (NOV*10) oo 5.2

Web Map Services and Raster Manager...........cccoeceviveresivesveriesennn [V J— 5.3
Axiom

Axiom Title BIOCK MaNager .........cccvevveieiieiiee e e (OCt “08) ..oovovr 6.1

Axiom FileRename and FileReSEQUENCE .........cceevveeiieiie e (OCt “08) vovvvvrererrrerene 6.2

Other Standards and Procedures

As-built Plans (Record Drawings) ........ccceevververesieeneenieseeseeseeseenens (May “16)...ccccccovre. 7.1
Arc Internet Mapping SEIVICE........cvveiieiiee e (NOV “11) oo 7.2
Tags, Professional Stamping and Signing ........ccccccevveveiieeieereseeee. (G RT0) J— 7.3
Addendums and Change OFders .........ccevvieerveresieeieee e (May “16)...ccccccovre. 7.4
Roadway Inventory Management SYStem .........cccccceevvivviiieiieiiieeninns (Mar “11) ..oooverrrrnn. 7.5
Incorporating Microsoft Word and Excel Documents...............c....... (OCt “08) ..ovvrore 7.6
Scanning Documents into PDF Plan SetS.........cccccovveviieiiciiiccieene, (OCt “08) vovvvvrererrrerene 7.7

Miscellaneous Help

Using MicroStation Files in Microsoft Word ............cccccvevevveinennn, (G J— 8.1
Bentley VIBW ....oooviiiiicc s (OCt “08) vovvvvrererrrerene 8.2



APPENDIX

Sept 2015
Plan Production File
Referencing Tree.....
Custom Line Styles.

Cell Libraries ..........

CADD Standards

Naming Standards..........cccocevvvererennne.

Known Problems with CADD Applications.............ccccceeuee.
Organized by Application

NDDOT Approved Abbreviations..........cccccevevvereiieeinenenn

Utility Company Abbreviations............cccceevvveiivere e e

Patterning ...............
Plan (Border) Sheets

Electronic Field Boo

K COOBS ..o,

GEOPAK Earthwork and Criteria .......ccccceveeeeceeieeeeeeseeeen,

MicroStation / GEOPAK Standards Request Form...............

Keyboard characters

Tips for Printing PDF Plan Sets.........cccccovvvievie s

Macro, VBA and MDL INAEX ......eovveeeeeeeeeeeeeee e

Tag Set Index...........
Dimension Styles....

Drawing Production

GUIANCE ..o

Roadway Designer GUIAaNCE.........cccvevveivereiieseeresee e

(AUG “14) e e A
(AUG “14) ceiiieeeieeeeeeeeeeeeeeeeeeeee e, Al0
(AUG “10) cuveeeeieeeirie e e e e e e e e eeeabi s B
LT ) O C
TR ) T D
(M5 “13) tereeeeeeeeerrrnisseeeeereesesrnn s E
(M5 “13) tereeeeeeeeerrrnisseeeeereesesrnn s F
(Do) N G
LTI T F T H
) P, |
L L) F TR J
(MY “00). 1 seeeereerrrrnnsssreeereeessrnnnnnens K
LTI o) F L
[ L) M
[ ) J N
(AUG “10) 1evvreeeereeerrrieesseeeeeeeessranens O
(AUG “10) 1evvreeeereeerrrieesseeeeeeeessranens p
T =) N Q
(NOV “11) 1sveeeeeeeerrriieeseeeeeeeesnnn s R


http://www.dot.nd.gov/manuals/design/caddmanual/appendixa.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixa.pdf#page=10
http://www.dot.nd.gov/manuals/design/caddmanual/appendixb.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixc.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixd.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixe.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixf.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixg.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixh.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixi.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixj.pdf
http://www.dot.nd.gov/forms/sfn51169.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixl.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixm.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixn.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixO.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/appendixp.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/AppendixQ/Drawing_Production_Guidance.pdf
http://www.dot.nd.gov/manuals/design/caddmanual/AppendixR.pdf

CADD Standards

Support

1.1 Manuals and Tutorials
June 2012

Internet Resources

This manual, CADD Standards manual, is available on the NDDOT Internet Web site:
www.dot.nd.gov/manuals/design/caddmanual/caddmanual.pdf. Users should review this web
site for all future revisions.

The Procedures for Calculating Final Earthwork Quantities manual is available on the
NDDOT intranet site: www.dot.nd.gov/manuals/design/caddmanual/nddot-procedures-for-
calculating-final-earthwork-quantities.pdf.

NDDOT Server Network Resources

Axiom manuals are located under their respective folders under
M:\APPS\Production\Design\AxiomV8.

A variety of “How To” reference videos and guides are available under S\SUPPORT\How_To.

Chapter 21 —Surveys and Photogrammetry, CADD Editing, is available at
S\SUPPORT\Teams\Survey\NonMicroStationData\DraftingStandards\Level 1\CH21 CADD
Editing Standards.pdf
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1.2 The CADD Specialist and Support Contacts

May 2016

The CADD Specialist (Jon Collado, 328-4439) provides technical engineering related support for
CADD programs. His other duties include:

Researching and maintaining CADD technologies
Providing application specific training
Coordinating engineering related standards development and implementation

The CADD Specialist is the primary contact for technical engineering related CADD support
questions. Support from co-workers is also important. Here is a list of other users who may be
able to help you:

GEOPAK - Survey / DTM:
Troy Zornjak

GEOPAK - Alignments / COGO:
Ranka Samardzic, Garrett Hartl

GEOPAK - Earthwork:
Ranka Samardzic, Garrett Hartl

Corridor Modeling:
Darell Arne

MicroStation:
Travis Cork, Kris Altepeter, Chad Frisinger

Information Technology:
Diane Gunsch, Kai Christensen

Adobe Acrobat:
Travis Cork, Garrett Hartl

GuidSign:
Travis Cork
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1.3 Standards Committee

Feb 2015

Members: Jon Collado (chairperson), Brian Raschke, Troy Zornjak, Sarah BaeHurst, Diane
Gunsch and Travis Cork

The Standards committee is responsible for developing, maintaining, documenting and providing
training for the NDDOT CADD standards. The standards committee is not responsible for
enforcing the standards. If a user has a problem or cannot use one of the standards, they should
fill out the MicroStation / GEOPAK Standards Request form, SFN 51169.
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Project Administration

2.1 Project Directories
Dec 2010

The sharing of information is a vital part of the success of a NDDOT project. Thus, when a new
project begins, a centralized directory structure is needed. Since it is important that data is
shared but not corrupted by unauthorized users, the Department has established a standard
procedure for directory creation and file naming.

Users should contact the “Help Desk” within the Information Technology Division if they need
to set up a new project directory. Users should contact the “Help Desk” by email (-grp-dot Help
Desk). The email request should include the project number. The Help Desk will setup the
standard root directories on the central CADD server. NDDOT project numbers consist of a
funding code, district, highway, agreement number, and mile point. A typical number may be:
NH-8-013(031)389. The directory created for this project would be as follows:
r:\project\80013389.031.

Each directory has the appropriate security access set by division. Thus, Bridge staff is only
allowed write access to the Bridge subdirectory. Other directories will be “read only” for Bridge
staff. The directory under the r:\project\80013389.031 directory would consist of the following
subdirectories:

As-built (Assigned District or Construction Division)
Bridge (Bridge Division)

Design (Roadway Design Sections)

District (Any of the 8 District offices)

Consultant  (Hired Consultant Firm)

Material (Materials & Research Division)

ROW (Right of Way Section)

Survey (Surveys and Photogrammetry Section)
Traffic (Traffic Section)

Utilities (Technical Support Section, Utility Coordination Plans)
ePlans (Electronic Plans)

Computer Services has optimized levels of security so that project related folders, up to and
including the above root directories, cannot be deleted or edited. However, any folder can be
created by an individual user, past that level. Obviously, users need to follow certain
conventions of folder and file naming in order to effectively communicate with others.

Under each of these root directories, there are unique folders that describe the specialized
operations of these users. For example, the users in Surveys and Photogrammetry would use the
following directory when they are working on electronic field book data:
r:\project\80013389.031\survey\EFB.
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The following are recommended subdirectories:

As-built
e Sheets ROW
e Sheets
Bridge
e (Subdirectories for each structure, Survey
name based on structure Number) e Compilation
e Consultant
Consultant e EFB
e As-built e Photos_Scans
e Bridge
e Design Traffic
e Material e Sheets
e ROW e Photos
e Survey
e Traffic Utilities
Design ePlans
e Environmental e Addendum
e Blue_Tops e Asbhuilt
e Photos e Final
e Sheets e Plan_Rev
e Preliminary
District e PSE
e Sheets

Material
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The ePlan directory is used for managing Adobe PDF files. Under the ePlan directory, subfolders
are used to organize pdf files created at particular phases of project development.

Project Development Phase Directory Name
Preliminary Project Reviews Conducted before the PS&E Preliminary
Comprehensive Review of Plans Specifications Estimates done PS E
approximately one month before the plan completion deadline.

Original version of plans first posted on the internet Final

After final plan completion and before the bid opening Addendum

After the bid opening, often used with change orders Plan_Rev

The Consultant directory is not automatically created. If consultants are involved on a project,
The Technical Support person should contact the help desk to have the consultant folder added.
Technical Support will have write access to all subfolders. Surveys and Photogrammetry will a
write access to the “consultant\survey” subfolder.

Occasionally, some projects are not associated with a project number. The project may not be
adjacent to a highway such as a wetland mitigation project. Miscellaneous projects that don’t
have standard project numbers should be stored in a subdirectory under R:\project\misc\. A brief
project description could be used as the project subdirectory name. The sub directory structure
will be set up the same as a normal project. Users should call the help desk to get a base
subdirectory created.

Right of Way plots that are not associated with a highway project are stored in the
“R:\project\PLATS_misc\” directory.
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Districts

Most users, including users in the NDDOT Districts, should be directly connected to the Central
Office server. If you are a NDDOT District CADD user who’s computer doesn’t automatically
connect to the Central Office server (map the r:\ drive), contact the Help Desk (328-4357).

Sometimes the speed of access across networks is not acceptable. If you are a District User that
is experiencing network performance problems, do your work on a local server (usually the g:\
drive) and move your work to the Central Office server (r:\ drive) after it is completed. After the
project information has been moved to the r drive it should be removed from the g drive. Be sure
to set up and use a project directory structure that is similar to the Central Offices. Except for the
drive letter designation, the directory and file path should be the same as the Central Offices
(example: g:\project\80013389.031\district\).

Consultants

Consultants shall set up and use a directory structure similar to the Central Office.

1. Create a project folder using the NDDOT Standard directory structure. Consultants
can revise the server or drive designation as they need (example:
X:\NDDOT\project\80013389.031). Everything after the project number (example:
80013389.031) must be setup the same as the NDDOT standard project directory.

2. Work in this directory.

3. When a project is complete copy the files to a CD or DVD.

4, If an entire project has been completed for the NDDOT (including design details), the
files should be sent to your respective Technical Support Contact within the Design
Division.

5. If only the survey work is to be done by a consultant, the files should be sent to

Surveys and Photogrammetry Section Leader.

6. Dependant on steps 4 and 5, the Technical Support Contact or the Survey and
Photogrammetry Section Leader will import the project information to the r:\ drive
and re-path reference files with Axiom Reference Manager.

All users, especially District and Consultant users, need to use the “Save Relative Path” options
when referencing files. The “Save Relative Path” option will help keep the reference path
integrity when the files are moved from one drive to another.
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2.2  File Naming Conventions
Sept 2015

MicroStation drawing names have been standardized for easy, quick and consistent identification
and they have been standardized to ease the preparation of plan plot sets. Standard names also
apply to non-drawing files that are used in a plan plot set. This section applies to names of
original files. For names of the pdf plan sets, see Section 2.9

Standard drawing names can be made up from 4 parts; prefix, plot number, suffix and suffix
modifier. The following drawing name is in accordance with the standards:
004SW_002_SCOPE.dgn

In this example the “prefix” is 004SW, the “plot number” is 002, and the “suffix” is SCOPE.
Note the underscore characters are standard name dividers. They are used after the prefix, plot
number and between the suffix and suffix modifier. The example standard name doesn’t use a
“suffix modifier”.

The “prefix” is used to divide and organize plot sets into sections. The prefix is required for all
drawings that are going to be directly incorporated into a plot set for plan production. These
plots are used to directly print a sheet in the plans. The prefix should not be used for a
referenced drawing that is indirectly included in the plans. For example, topog information
include in the plans is indirectly included in the plans because it is a referenced drawing. The
topog drawing should not have a prefix. The topog drawing would just be named TOPOG.dgn.

Appendix A lists the current standard drawing names. Check the appendix to find the correct
naming convention when creating a new file.

NDDOT | Axiom vjvg‘j'@'zj‘é':@‘@ s Ty @ i3 @Jx

The NDDOT also has a CUStOM MACIO [ fewfie | owngs Reforrced o |
that Can be used to Create a neW Explore dgn Directory Sheets ¥ DO1TS - Title Sheet

D04SW - Scope of Work

010BE - Basis of Estimate

011DT - Data Tables and Diagrams 3
020GD - General Details 3
030TP - Typical Secitons

040RM - Removal Layouts

050IM - Intlet & Manhole Summary

05501 - Drainage PP Sheets

060PP - Plan and Profile Sheets

O70CT - Countour Sheets

O75WL - Wetland, Erosion Control and Seeding Sheets
0B0LO - Layouts Other 3
D81CD - Survey Coordinate and Curve Data

0825D - Survey Data

085LS - Landscaping. Planting and Imigation Details
0%0PL - Paving Sheets

100WZ - Traffic Control

1105N - Signing

120MK - Pavement Marking

130GR - Guardrail

140LT - Lighting

1505L - Signals

160IT - Inteligent Transportation System

170ER - Bridge

17558 - Soil Boring Logs

180PT - Pits (Material Sources) 3
130HR - Haul Road Restrictions

2005 - Cross Section Sheets

Right of Way 3

Cells

drawing with a standard name. This e
macro creates a new drawing as you Todls
look up the standard name. The Macro | <™

GuidSIGN

is activated through the main NDDOT | aeer
TemaShars

pull down menu in MicroStation. It is Suickllop
named “NeW File”. Customize User Inteface

Clean User Interface

- v v | v v -

Help

The macro accommodates suffix
modifiers and the page number within
section. User will be prompted for this
information through a dialog box.

The new file will be created in the
present drawing directory. This macro
doesn’t provide options to create
drawings in other directories.

r vy v vy v v
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Some other features of this macro include a safeguard to prevent creating a drawing that already
exists (overwriting a file). Different seed files are used based on the type of drawing selected.

One limitation to this macro is metadata. This macro actually uses a file copy and open
command in the background. The file metadata is not rest with a copy command. Some
properties such as author, logged edit time and number of revisions will not be reset. These
properties don’t affect file performance and metadata is presently not a CADD Standard.

Please contact the CADD Specialist (see Section 1.2) if you need a file name that doesn’t fit the
existing naming standards.

The table on the following page lists standard sheet name prefixes.
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Section  |Section Description Sheet Name
Number Prefix
001 Title Sheet 001TS
002 Table of Contents 002TB
004 Scope of Work 004SW
006 Notes 006NT
008 Quantities 008QS
010 Basis of Estimate 010BE
011 Data Tables (Concrete Pavement Repair Locations, Coring Data, 011DT
Salvaged Base Summary, Earthwork Summary, Mass Diagram, etc)
020 General Details, Super Elevation Tables and Layouts 020GD
030 Typical Sections 030TP
040 Removals 040RM
050 Inlet & Manhole Summary, Culvert Hydraulic Data 050IM
051 Allowable Pipe List (Pipe Policy) 051AP
055 Drainage Layouts (Separate Plan and Profile Sheets for Drainage ~ 055DL
Items, Use When PP Sheets too Crowded)
060 Plan & Profile 060PP
070 Contours 070CT
075 Wetlands, Mitigation and Environmental 075WL
076 Temporary Sediment and Erosion Control 076TE
077 Permanent Sediment and Erosion Control 077PE
080 Layouts (Fencing and Miscellaneous Layouts) 080LO
081 Survey Coordinate and Curve Data 081CD
082 Survey Data Layouts 082SD
085 Landscaping 085LS
090 Paving Layouts 090PL
100 Work Zone Traffic Control 100wz
110 Signing 110SN
120 Marking 120MK
130 Guardrail 130GR
140 Lighting 140LT
150 Signals 150SL
160 ITS 1601T
170 Bridges & Box Culverts 170BR
175 Soil Boring Logs 175SB
180 Pit Plats and Borrow Areas 180PT
190 Haul Road Restrictions 190HR
199 Tied Plans Not Contractually Requiring NDDOT CADD Standards 199TI
200 Cross Sections 200XS

Note, If Signing and Marking are on the same layout sheet use section 110-Signing
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Information that is included in sections 040 Removals, 055 Drainage Layouts, 080 Layouts, 085
Landscaping, and or 090 Paving Layouts can be included in section 060 Plan and Profile instead
of segregating information in their respective drawings. If the plan and profiles don’t have
enough space to clearly communicate details, additional sections, such as 040, 055, 080, 085 and
90 should be used.

The “plot number” is used to organize drawings within a section (prefix) of the plans. When plot
numbers are used, they should start out at 001 for each section and increment up through the end
of the section. Plot numbers are used to organize sheets within a section. They are not intended
to be the sole tool to organize all the sheets within a plan plot set.

For example plan and profile sheets could be organized so that mainline plan and profile sheets
are before side street plan and profile sheets. A project may have 7 mainline plan and profile
sheets and 4 side street plan and profile sheets. The mainline sheets could be numbered 001
though 007 and each specific side street sheet could be organized by the next plot number. The
sheet that directly precedes the mainline plan and profile sheet would be numbered 008, the next
sheet would be numbered 009 and so on. Note: the plot number should be named with three
characters for sorting purposes. Zeros should be used as place holders for plot numbers less than
100. The text “2” is after the text “002”. The text “2” is also after the text “003”.

Leading zeros should not be used in the sheet title block for section and page number.

Plot numbers are not needed for drawings that are not directly used for plan plot sets. They are
optional for drawings that are directly used for a plan plot set if the full drawing name is
sufficient to sort the names in the correct order. Example: a drawing that is the only drawing
within the section would not need a plot number. A plan plot sets may not need a “plot number”
for the “Scope of Work” sheet if it is the only sheet in the section. There are no other sheets
within the “Scope of Work” section to organize.

The “suffix” part of the name is used to identify a sheet within a section by content. For example
there are many different types of Data and Table sheets. Several are in section 011. However
users need a suffix to distinguish by name the Coring Data Sheets from the Earthwork Summary
Layout sheets. For drawings that are not directly included in a plan plot set (a referenced
drawing), the suffix part of the name is the same as the name of the drawing. Example the
drawing named TOPOG.dgn has a suffix that is the entire name.

Suffix modifiers may be added after the suffix to give additional distinction to a standard
drawing name. Suffix modifiers are usually optional. They are only mandatory for as-builts,
addenda and change orders (see sections 7.1 and 7.4). If used, they should be based on the
information in the drawing. Users are to use their discretion when creating a suffix modifier.
Example, construction sign layout sheets may have suffix modifiers to indicate the phase and
location. The following drawing name is an acceptable standard name:
100WZ_012_CS_PhaselEighthSt.dgn. The suffix is CS and the suffix modifier is
PhaselEighthSt. Suffix modifiers can be used with any drawing name.
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2.3 AAREADME File and Directory Cleaning

July 2007

The AAREADME file should be an ASCI text file that helps users find data within a project
folder. Each folder within a project directory should have an AAREADME file init. This file is
simply a text file that describes the folder contents.

All AAREADME files should contain:

1.

2
3.
4.
5

Directory being described

Project Number(s)

PCN Number

Brief Project Description

Drawings that do not use the standard naming convention should be listed in the
AAREADME file. This list should also be submitted to a CADD Standards
representative in order to correct any deficiency with the Standard Naming
Convention.

List files that should not be archived. List or group files to be deleted after plan
completion, like conceptual drawings.

If a project was abandoned or shelved, a history of what was designed should be
detailed.

AAREADME files for the Survey folder should also contain:

8.
9.

10.

County Name

File Index

a. File Name
b. Progress

C. Description

Journal (in paragraph format)

It might include a dated description of how the data was collected, where it came from, or
what needs to be done in the future. Each entry should be dated and the author should attach
their name to the information in case someone has questions.

AAREADME files for Design, Traffic and District folders used for design work should also

contain:

11.
12.

13.

14.

Name of designers who worked on the files within the directory

Multiple gpk explanation (If multiple GPK files were used within one directory
explain why.)

Provide a key for correlating alignments (chains and profiles) This key should
describe what chains were used with what profiles

Explanation of Sub (children) directories.
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Example for a Survey Folder
R:\project\70002091.065\SURVEY\EFB>
NH-7-002(065)091
PCN 14794
Reconstruction, Palermo Section, Stanley, east 10 miles
Mountrail County

2dBdy.dgn
Complete EFB data and user information
Aareadme.txt
Complete this document
bdy91001.ind
Complete GPK input file for Hwy?2
Efb-Top2
TEMP DEL  Work file additional Topo data
Efb-Top3
TEMP DEL Work file additional Topo data
Efb-Bdy.dgn
In Progress  EFB Bndry data; EFB data from January 2nd needs to be added.
Efb-Top.dgn
Complete EFB Topog data; includes side road extension at station 154+65 Left.
Job001.gpk
N/A  Contains current alignment. EFB data from January 2nd will need to be added.

18 March ’04 [J. Doe]..... Tammy Doe e-mailed in five (5) .dat files, and an excel file with the
observation of the station information. These data files are the GPS observations of the control
points for the above said project. | sent these .dat files into the NGS OPUS processing center
and received back the OPUS derived coordinates. The dat files and opus results (*.doc)
documents can be found under ....

25 March ’04 [E-mail from ABC engineering]
Good Morning John,

We have completed the first segment, project number PCN14794. There are several things to
note. | changed the point numbers of the targets we discussed last week. Point numbers 312 and
313 had already been used for ... Tioga and heads east next week. Thanks for all your help.

Tim Smith, ABC Engineering
(701)555-1234
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Example for the Design, Traffic or District folders used for design
R:\project\30002269.065\D_URBAN
CMU-3-002(065)269
PCN 12345
Hwy 2 through the City of Devils Lake — Reconstruction
Files that should not be archived
All of the files in the “design\temp” folder should be deleted after final plans have been
submitted.
Designers
John Doe

Mary Jane

GPK - 001 was used by Design in the Central Office. GPK -002 was used by a consultant for
the tied city project (9" Street)

ALIGNMENTS KEY

HORIZ EXIST-V PROP-V ROADWAY

BASEO1 N-S SECTION LINE (NEW STA-STON)
BASE64 N-S SECTION LINE (OLD STA-NTO S)
PROPO1 EXSRO1 VERO1 WEST SR 34TH AVE END PROJECT 119+00
PROP02 EXMLO02 VERO2 WEST MAINLINE ROADWAY

PROP0O3  EXMLO3 VERO3 EAST MAINLINE ROADWAY

PROP04  EXSR04 VERO4 EAST SR 36TH AVE TO 32ND AVE

PROPO5  EXSRO05 VERO5 EAST SR 32ND AVE TO END PROJECT 119+00

Sub (children) directories
The “sheet” directory was used for plan cut sheets. The “details” directory was used for
plan details.
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Directory Cleaning

CADD Files should be cleaned (organized and purged) regularly during project development.
Some CADD files should also be purged after the following milestones:

1. Final Plans Have Been Submitted

2. Final Construction Records Have Been Completed (including as-built drawings)

3. Three Years After Project Completion — Final Construction Records Have Been
Completed.

Preliminary files that were only used for conceptual planning, like environmental documents,
should be kept through the design phase. The main environmental document should be stored on
FileNet. However, most conceptual planning documents on the r: drive should be purged after
the Final Plans Have Been Submitted for construction.

Microsoft Word and other word processing documents should also be purged after the Final
Plans Have Been Submitted for construction. Only documents that directly support the plans,
like plan notes, should be archived in the project directory. Other documents such as
correspondence and reports should be in FileNet. These documents should not be archived with
the project directory.

The only conceptual drawings that should be kept after the final plans have been submitted are
drawings that were displayed at a public meeting. Drawings displayed at public meetings should
be kept until Three Years After Project Completion and then discarded. Drawings displayed
at public meetings should be grouped in a project sub directory for easy identification and
protection (example r:\project\30002269.080\DESIGN\Public Hearing\). Remember that
drawings displayed at public meetings should not be edited after the meeting. You must keep an
unedited version of the drawings (including reference files). All files stored in a directory named
like “Public Meeting”, “Public Input”, “Public Hearing” or “Public Information” will be deleted
three years after the project is completed.

After the Final Plans Have Been Submitted, the only files that should be in the design folder
are files that directly support the final plans. Temporary files and files detailing alternates that
were not advanced should be deleted after the final plans have been submitted. Alternates or
options advanced as part of the plans (bidding options like a steel bridge vs. a concrete bridge)
should be archived.

Consultants submitting final plans should clean the project directory before the electronic files
for final plan submittal are packaged and delivered to the NDDOT.
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After the construction records have been completed (at the time the project is moved near-
line) some supporting project files may be deleted from the project by the Information
Technology Division. The following list of files that will be deleted at this time.

*X, *.rx GEOPAK Criteria Files

*.inp Input files used mostly for GEOPAK

*.jou GEOPAK journals

*.bak Backup files

Projdbs Directory GEOPAK Project Manager directory

*.ind User input files used for GEOPAK

* lis,*.btb *.rtb Files used for blue top books — slope stakes
*.ond User cogo output files used for GEOPAK
*.log Log files

*.cel Project cell libraries




2.4  Standards Directory

Sept 2013
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Here is a summary of the “NDDOT Standards Directory”. Files stored in this directory are used
to configure many of the operations performed in MicroStation, and GEOPAK. More extensive
descriptions of their functions are contained in the Section 2.5.

Description

Directory

Bentley View Setting Files

S\STANDARD\ BENTLEYVIEW

Axiom Support Files

S:\STANDARD\ V8l \ AXIOM

Geographic Coordinate Systems

S:\STANDARD\ V8I\ BENTLEY_MAP

Cell Libraries

S:\STANDARD\ V8I\ CELL

Configuration Files

S:\STANDARD\ V81 \ CFG

Spell checker Dictionaries,
Border Sheet Tags, and Scale
definition

S:\STANDARD\ V8l \ DATA

DGN Libraries

S:\STANDARD\ V8l \ DGNLIB

Set Up Configuration, Preference
Files

S\STANDARD\ V8I \ INSTALL

Interface Files

S:\STANDARD\ V8l \ INTERFACE

MDL Applications

S:\STANDARD\ V8l \ MDLAPPS

MicroStation Macros

S\STANDARD\ V8l \ MACROS

Central Office Plot Divers

S\STANDARD\ V8I\ PLOTDRV

Seed Files

S:\STANDARD\ V8I \ SEED

line styles, fonts, color table

S:\STANDARD\ V8I\ SYMB

Visual Basic

S:\STANDARD\ V81 \ VBA

GEOPAK Ciriteria Files

S:\STANDARD\ V8I \GEOPAK\ CRITERIA

GEOPAK D&C Manager

S:\STANDARD\ V8I \GEOPAK\ DCMAN

GEOPAK Drainage Files

S:\STANDARD\ V8I \GEOPAK\ DRAINAGE

Corridor Modeling - Roadway
Designer Files

S\STANDARD\ V81 \GEOPAK\ Roadway_Designer

GEOPAK Sheet Files

S\STANDARD\ V8I \GEOPAK\ SHEETS

GEOPAK Super Elevation Files

S:\STANDARD\ V8I \GEOPAK\ SUPERELEVATION

GEOPAK Survey Support Files

S:\STANDARD\ V8I \GEOPAK\ SURVEY
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2.5 Configuration Settings, Preference Settings, and User Interface
March 2014

Having the correct settings is required to use the NDDOT standards properly. Details of some of
these settings will be discussed shortly. But for many users, the following summary will suffice.

For most NDDOT users, the standard configuration, preference and setting files should be
correctly set up by support staff. Most of the CADD standard files are linked to the s:\ drive.
Typically if one standard setting is set up correctly, they all will be correctly set.

Most users can typically tell if their computer is set up correctly by doing the following:
1. Open MicroStation

': C:\Test_Printing.dgn [2D - V8 DGM] - MicroStation VB8i (SELECTseries 1)

File Edit Element Settings Tools Utilities Workspace Applications Window Held

Tasks 1
2. The main menu should have a “NDDOT” pull down menu. If you can see this,

everything is probably installed correctly.

Default Directories

Most user workspace files have been moved to “C:\NDDOT_CADDA\s_drive\Support\users”.
A subdirectory named after your user name should have been created under this directory. In
this explanation “jcollado” is used. But, everyone will have their own unique name. CADD
standards have been created to help you leverage this directory without having to adjust
configuration files.

The directory “c:\NDDOT_CADD\” has been structured the way it is for a couple reasons:

1. Modified local CADD files are grouped together for easer management. This standard
workspace area helps automate many user processes.

2. Files are grouped for easier portability. MicroStation-Geopak, NDDOT CADD
Standards and project information can be used locally, such as on a laptop —that is
disconnected from the network. See NDDOT CADD Standards for “Taking
Electronic Drawings into the Field”.

Files are grouped the way they are to copy some of Bentley’s default paths.

4. Files are grouped the way they are to enable networked workspaces. A very small
group of users keep workspace settings under “s:\Support\Users\”. Guidance for
these users is not discussed in this reference.

Your default user name and interface should be setup for you. These settings should be named
after your user ID.

w
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Look in: | < Local Disk (C) B oZxE N 2D-VBDGN

ﬁ] Associative_Regional_Boundary_for_Bentley.dan ﬁ] test_pattern.dagn
E] Drawing_for_Bentley_100WZ_050_Phase_3A.dan E] Zoom_Disappear_for_Bentley.dg
ﬁ] Drawing_for_Bentley_Phase_3A.dagn

E] junk2.dan

ﬁ] junk3.dan

E] junk4.dgn

ﬁ] junk&s.dgn

E]junk raster.dgn

ﬁ] junk.dagn

E] Line_Spacing_Waries_for_Bentey.dan

ﬁ]PayItemFiIters.dgn

E]Tempofﬁ-:e .dan

ﬁ]testjatternz.dgn
Kl r i
File name: Iiunk dan j Open I @
Files of type: |CAD Fies ("dgn:” dwg:" i) =l Cancel | Project: |No Project =l
[~ Open as read-only [ phicrs | < Interface: chollado )y j
A

Note, when you log on to your computer (log on to windows) use lower case. The text case isn’t
important for Windows but it is important for MicroStation (example, “jcollado” is not the same
as “Jcollado™).

User Configuration Files

Your user configuration file is named after your user id and is stored in the “user” sub directory
(example, C:ANDDOT_CADD\s_drive\Support\users\jcollado\V8i\Users\jcollado.ucf). Note, a
user may have more than one set of user configurations. Example, a user may have another
configuration file for the “Image Viewer” Application
(C:\NDDOT_CADDA\s_drive\Support\users\jcollado\ V8i\Users\iv.ucf).
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Cells

IL1) cell Library: [..\users\jcollado\ cell\COLLADO.CEL]

I [eT)e

If you put personal cell libraries in the cell el

directory (example, | SEee e Display: Wireframe 7|
C:\NDDOT_CADD\s_drive\Support\ Attach Foder... %"?ﬂ

users\jcollado\ V8i\cell), they will — Geh L

automatically be added to your cell list. o A

You should not have to search for your e Greh ;

personal cell libraries.

Mcellcells_1scale.cel

Grph
Gmoh

L=
3

.. Ncell\cells_plot_scale.cel |

.. M\cell\driveway. cel

o WM \cell\guardrail . cel Paint |Element Edit.. | Delete |
w WMicellthatch, cel

LT _cells_All_scales.cel Pattem | NONE Create... | Share |

. Micelltg_schematic. cel

. NSTAMDARD WM el \ymap. cel
L SMicellipymitmkg. cel
o PiMcel\RCBOX. cel

.M cell\Sheets. cel

o WM cell\signal_det.cel

____

COLLADO.CEL

Interfaces (Menus and Tools)

If you create a dgnlib for custom menus and tools for personal use, it should be stored in your
interface directory for MicroStation under the appropriate user subdirectory (example,
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Interfaces\MicroStation\jcollado\
jecollado.dgnlib). Changes will be appended to the Standards Interface.

Function Keys

If you create custom function keys, you should save your changes to the Fkey subdirectory and
name the file after your user ID (Example, C:ANDDOT_CADD\s_drive\Support\users\jcollado\
V8i\Interfaces\Fkeys\jcollado.mnu) This file must be named using your user ID in order for it to
be attached without editing configuration files.

Accudraw Shortcut Keys

If you edit Accudraw shortcut keys, you should save your changes to the Fkey subdirectory and
name the file after your user ID and the appended “_shortcut.txt” (Example,
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\Interfaces\Fkeys\jcollado_shortcut.txt).
This file must be named using your user ID and the appended “_shortcut.txt” in order for it to be
attached without editing configuration files.

WMS Server List

If you want to edit and use your own WMS Server List, copy the following:
S:\STANDARD\V8i\data\WmsServerList.xml, and pasted it in your user\data directory
(Example,
C:\NDDOT_CADD\s_drive\Support\users\jcollado\v8i\data\jcollado_WmsServerList.xml).
This file must be named using your user ID and the appended “_WmsServerList.xml” in order
for it to be attached without editing configuration files.
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Macros

MicroStation Basic

If you create personal Macros, you should save them to the Macro Folder (example,
C:\NDDOT_CADD\s_drive\Support\users\jcollado\V8i\macros\jdc_test.bas). If the macros are
stored in this directory, you will not have to browse for them.

VBA

If you create personal VBA, you should save them to the VBA Folder (example,
C:\NDDOT_CADD:\s_drive\Support\users\jcollado\V8i\macros\jdc_test.mvba). This is the first
place MicroStation will look for your macros.

Projects (MicroStation Shortcuts)

Does browsing the R drive for your project annoy you? Do you want to see shortcuts for only
your projects? If yes, using a project configuration file may be the answer for you. Simple
project configuration files can be copied from S\STANDARD\PCF\Test. Find the one for your
respective project and copy it to your projects subdirectory (example,
C:\NDDOT_CADD:\s_drive\Support\users\jcollado\V8i\Projects\80010932.027.pcf). If you
have a pcf file in this directory, your respective team list will be replaced with your personal list
in the MicroStation Manager dialog box. Setting the “Project” in this dialog box will
automatically point to your project subdirectory.

Lok in: | < Local Disk (C:) HoxeE 20 -V8 DGN

ﬁ]Associat've_RegionaI_Boundary_for_Benﬂey.dgn ﬂ]testJ:attern.dgn
6] Drawing_for_Bentley_100WZ_050_Phase_3A.dgn E] Zoom_Disappear_for_Bentley.dg
.ﬁ] Drawing_for_Bentley_Phase_3A.dgn

6] junk2.dgn

ﬁ] junk3.dgn

6] junk4.dgn

E] junka8.dgn

ﬁjjunk raster.dan

E] junk.dgn

.ﬁ] Line_Spacing_Varies_for_Bentley.dgn

E]Pa\,rltemFiIters.dgn

ﬁ]TempOf‘ﬁce .dgn

E] test_pattern2.dgn

Kl — B

File name: Iiunk2.dgn j

Files of type: ICAD Files (*.dgn;”.dwg;” ) j
[~ Open as read-only

If a project configuration file (pcf) has not been set up for your project — file is not in
S\STANDARD\PCF\Test, contact the CADD support specialist.
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Site Configuration Files

Most users don’t need to understand how Site Configuration files work. This section is primarily
for Consultants and other users that have to set up their own site — office.

The typical installation of Bentley software is used. The application is installed at the default
location usually “C:\Program Files (x86)\Bentley\”.

The NDDOT uses site configuration files to point to most of the CADD Standard resource files.
These files can be opened and reviewed with a simple text editor application such as notepad.
During a typical NDDOT computer setup, the configuration settings are redirected to use a
different series of configuration files.

The file

“C:\Program Files (x86)\Bentley\MicroStation V8i (SELECT series)\MicroStation\
config\app\NDDOT _Pointer_1.cfg”

points to the configuration file

“C:\NDDOT_CADD\s_drive\Support\tNDDOT _Pointer_2.cfg”

which then points to the configuration file

“S:\STANDARD\VS8i\include.cfg”

which intern points to the configuration files under the directory
S:\STANDARD\VS8i\cfg.

The second pointer (NDDOT _Pointer_2.cfg) has been added to allow non administrators on
Windows 7 the ability to disable the NDDOT CADD Standards.

There are 2 subdirectories under S:\STANDARD\V8i\cfg. The “appl” directory contains
application configuration settings modified for NDDOT work. The “user_and_groups”
directory contains configuration settings to address NDDOT work groups.

No CADD standards are stored in user configuration files. The NDDOT sets up an empty user
configuration files named after the users log on name.

Batch files were created to automate the creation of the standard user workspace. These files are
located at “S:\Standard\V8i\Install\”

The NDDOT uses a standard interface. For NDDOT users the interface file is accessed directly
from the following location;
S:\STANDARD\VS8i\Interface\lnterface_Date-Version.dgnlib
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GEOPAK Configuration File

The SS2 version of Geopak has new options for loading. The NDDOT has re-configured this
option by replacing the “geopak.cfg” file. If Geopak is installed, it will be accessible in
Microstation. The NDDOT isn’t using the new Geopak icon.

Preferences

Your user preference file is named after your user id and is stored in the “pref” subdirectory
(example,
C:\NDDOT_CADD\s_drive\Support\users\jcollado\\V8i\V8i_Home\prefs\jcollado.upf).

The following table lists some preference settings that are not set with the original MicroStation
Installation. These settings are recommended for the general user. Most of the preferences are
stored in the user preference file (upf). Make the following changes in your user preferences by
selecting “workspace > preferences”.

Preference Name Description Setting
Input>Allow ESC key | When the ESC key is enabled
to stop current selected, the current
command command is stopped and

the default command is

started.
Raster Manager > Use Active Level disabled

Default Raster
Attributes

Default level that rasters
are attached to

Level = Raster Group 1

Raster Manager > Set Geographic Coordinate =101 ]
Default Raster System from Raster Action ¥
Attributes General L]
Geo Priority Rle
Inherit GeoCS from Model Mot Inherited
Color L]
Display Print 2
Extended o3
OK I Cancel
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Raster Manager >
Georeference (tab) >
(as shown)

These are some settings
needed for working with
raster images created by
the Photogrammetry
Section

Set Raster Manager preference
Genelal] Default Attributes |

| Memary I

r Sister File Settings

[~ Use Sister File, f Present, for Georsferenced Files
[~ Save Location Info in Sister File f Required

— Default Unit Settings

Sister File: 1 Unit = |‘I.DDDDDDDDD

Feet hd
Basterfile: 1 Unit = I'I.DDDDDDDDD

Fest hd
¥ Use Unit Defirition Geokey ff Present {ovemide PCS unit)

Reference > Set Default
Attachment Preferences
> Display Raster
References

When references are
attached, they can also
automatically attach the
rasters that are attached to
the reference.

Disable

Task Navigation >
Icon Size

Makes dialog smaller,
recommend for verbose
task navigation

Small (16 x 16)

View Options >

Element Highlight color

Selection Set Color

Yellow

Yellow
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Some preferences are stored in the preference file (upf) but are not changed through “workspace
> preferences”. The following table lists some NDDOT preference settings that are different

than the MicroStation default settings, but not edited in the preference dialog box.

Preference Name

Description

Setting

File > Compress >
Options

Allow deletion of unused —
empty parts of the dgn file

All settings enabled

Settings>Snaps> Allows AccuSnap while enable
AccuSnap>Enable For | placing a fence.

Fence Create

Within the Place text Allows multiple formats disabled
command - “Apply within one text element

changes to all text”

Within MicroStation This setting is needed to enable

Print Dialog Box —
“Settings>Preferences>
Allow Paper Size
Editing

create custom plot sizes
from roll plotters

Within “Change
Attributes” tool

Defaults

Use Active Attributes: On
Level: On

Color: On

Style: On

Weight: On




CADD Standards

NDDOT Main Menu

EB&E&EMM&MIW&MWM@@WEM@HDDGTM

Tasks - 0% Mew File
Explore dgn Directony

Tasks [ =]

[Q Cesign Cells
..... , Levels
IEI&“rE? hér! rﬁ-rgﬂrﬁ ﬂr Tools
[q 020GD_Details v J AutoTURN
“{ Design H==a GuidSIGN
. Rebar
_(I qr ‘fr @r +r :'&r Mr Nr ce"?r |_'fr 4 TemaShare
j Dr G, i}'r ®> CQuickMap
_l Gr Gr -"'Ir :}r h» m’ '/Pr ?j"lr Customize User Inteface
_' E» '@, @1 h‘% @}p ﬁp @p ﬁi Clean User Interface
j %r E}‘E’: ri;r & h} Help

A B OABE T A4 4l I, aa a1 EEF M mem

J AL A W abg At a.'f, LI TR V-
de wH @ a0 % g B

jﬂl’rr bl T 3&9}#} /qr ity

jHHAﬁG@

SLLLp Ll Ll SSULp SLLLp Ll

EGCEE G

NDDOT changes to the MicroStation menu can be found in one pull down called NDDOT.

New File
This tool creates a new drawing file as you look up the standard name.

Explore DGN Directory

This tool is used to quickly open your drawing directory with Windows Explorer. It’s a quick
way to get to resource files related to your drawing.

Cells
Cell shortcuts are quick ways of opening common standards cell libraries.

Attach Levels
These tools will attach additional level libraries.
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Tools (NDDOT) Area Tool
Additional tools adopted or created by the NDDOT can be quickly CoordinateConversions ~ »
accessed from this pull out. DD Cell NDDOT

Draw Cells Along Chain
Area TOOI GlDSSEﬁ"
This is an advanced measuring and labeling tool. Not loaded with Level Symbology NDDOT
MicroStation by Default. Pan Chain

Steel Sections
Coordinate Conversions et Subsck
Caution is recommended with these tools. Don’t use these tools Utility Cell Report
unless you have received the applicable training. XY Comments

DD Cell NDDOT

This is a quick way of loading ddcell mdl and launching the NDDOT tool box for dimension
driven cells.

Draw Cells Along Chain

This is a great tool to place cells along a roadway alignment, such as placing delineators for work
zone traffic control. Some GEOPAK knowledge is required.

Glossary

This tool can be used to look up NDDOT abbreviations and send them to your clip board and
MicroStation Text editor — Word Processor dialog.

Level Symbology NDDOT
This tool is used for some typical level symbology overrides.

Pan Chain
This tool is used to pan (move and rotate) a MicroStation view based on a Geopak Alignment.

Steel Sections
This tool places a steel section shapes.

Select Subset

This tool can refine selection sets by filtering line lengths and angles. It is great for refining
Geopak Cross Section Symbology.

Utility Cell Report
This tool runs a special report that is read by NDDOT Geopak utility criteria.

XY Comments

This macro records and relates comments to a specified xy coordinate in MicroStation. Macro
centers view on coordinate as comments are reviewed. Macro includes author and priority tags
for filtering purposes.
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Other Applications

Short cuts have been created to quickly turn on and off CADD related Applications such as
AutoTurn, GuidSign, Terrashare and QuickMap. Note these applications will not work if they
are not installed on your computer.

Customize User Interface
Opens user’s dgnlib as assigned by the NDDOT standards and opens the customize dialog box.

Clean User Interface

Sometimes users accidently copy level definitions, dimension styles or text styles into their user
dgnlib. These definitions can override current NDDOT CADD standards. This tool can purge
these definitions and styles.

Help
This pull out contains shortcuts to common help references.
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2.6 Metric Support

October 2005

Presently the NDDOT is not using metric measurements for plan preparation work. At this time,
NDDOT doesn’t have standards created specifically for metric use. However, many of the
English Standards could easily be adjusted for metric use. If you need to use metric settings for
NDDOT work, contact CADD Support (see Section 1.2).

2.7 CADD Standard Revisions (When to Use Old Standards).

Oct 2008

CADD Standards often change while users are in the middle of a project. Productivity may be
increased by switching to the new standard. However, continuing to use the previous standards
may be more convenient. The previous or old CADD Standards can be used if all of the
following occur:

1. The active project is presently incorporating the previous CADD standard.

2. Productivity, project uniformity, and/or plan readability are diminished by switching
to the new standard.

3. The previous or old CADD standard is not considered a primary standard. Certain

CADD Standards revisions must be implemented immediately. The following is a

list of primary standards in which the most current version must be used:

a. Title sheet changes.

b. Standards needed to implement NDDOT software changes (example:
GEOPAK V8.11)

When a new project is started the most current version of the CADD standards are to be used.

Example: The file naming standard for alignment drawings changed January 10, 2001.
Alignment drawings were previously named align.dgn, but now they are named ds_align.dgn. If
an active project already contained an alignment drawing named align.dgn, and this file was
referenced in several other drawings, changing the name of the alignment drawing to
ds_align.dgn may take several minutes to fully implement. In this case the user may elect to
keep the old file name through the completion of the project.
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2.8 Taking Electronic Drawings into the Field

Oct 2008

This section discusses using CADD in the field. Field computers are not typically connected to
the network (CADD Servers). Several important resource files are stored on the network and if
computers can not find these resources they will not operate correctly. Some reference and raster
files use a specific (full) path. These reference and raster files may not be properly attached
when they are moved off the network (“R” drive). The following procedure discusses a method
of copying and mapping resource files to a computer that is not networked or will not be
networked when CADD tools and files are needed.

This procedure involves:

1. Copying the resource files to “C” drive. These files must be stored in a specific
location.

2. Copying the needed project drawings and files to “C” drive. These files must be
stored in a specific location.

3. Learning to use the appropriate icon - shortcut. This shortcut maps the resource files

and project files in a manor that is similar to the way the files are mapped on the
network. The shortcut creates a local “S” and “R” drive.
4, Updating resource files and project files as needed (as they change).

Note this procedure does not cover installing MicroStation and GEOPAK or checking out
licenses. A Work Management System request is required for installing MicroStation and
GEOPAK.

Step 1 can be accomplished by running a batch file or manually. Running the batch file is the
preferred method. However, the computer must temporarily be connected to the network (“S”
drive). After the computer is connected to the network, double click on the batch file
S:\STANDARD\V8I\Install\CopyStandardsLocal.bat. This file will copy the needed files
locally (on the computer’s hard drive) to the directory
“C:\NDDOT_CADDA\s_drive\STANDARD”.

Step 2 involves copying the project files needed for field work. CADD project files are stored on
the “R” drive. Files should be copied from “R:\project\*.*” to
“C:\ANDDOT_CADDA\r_drive\project\*.*”. Similar - relative paths should be used when files are
copied. Example: if the file R:\project\10083088.059\Design\Design.dgn is going to be taken
into the field, it should be copied to
C:\NDDOT_CADD\r_drive\project\10083088.059\Design\Design.dgn.
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Step 3 uses a customized desktop icon to temporarily create “S” and or “R” drives on your
computer and start MicroStation. Caution, local “S” and or “R” drives can not be created if
networked “S” and or “R” drives are already connected. Make sure your computer is
disconnected from the network before proceeding with step 3. The icon - batch file runs a
“Command Prompt” script, typically in a black dialog box. A new path “S:\” will be created.
The files in C:\ NDDOT_CADDA\s_drive and S:\ will be the exact same files. They will just have
different paths. The local “R” drive will have a similar relation to C:\ NDDOT_CADD\r_drive.

Step 3 is to remember to update the standard resource files on “C” drive as needed. This should
be done at least seasonally. To do this, just repeat step 1. Project files should also be updated on
the “R” drive as required. The “R” drive is the official location to save project CADD files.
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Final Plan Delivery
Sept 2013

The “Final Plan Delivery” includes several products. The requirements below elaborate on some
of these products including Production Drawings, Resource Files, Static Electronic Drawings
and Paper Printed Drawings. Additional requirements are also listed in the “Scope of Work for
Consultants Performing Preliminary Highway Surveys” and in other areas of the Design Manual.

1.

Production Drawings — These files are typically native MicroStation Drawings (dgn).
They are typically editable and contain more information than Static Electronic
Drawings. Information can by queried from the drawing (example; where are the 96
inch manholes). Functional Electronic Drawings usually have working relationships
with other drawings and several display options.

Production Drawings are required on projects under a direct contract with the
NDDOT.

Resource Files - These files are not directly used in the plans but can be used to help
build a project. Most are not directly printable. Examples of functional files include:
Alignments files (gpk, dc), point files (asc, csv), and surface models (dtm, tin, dc).
Several types of Functional Resource Files can be imported directly into survey
equipment.

Resource Files are required on projects under a direct contract with the NDDOT and
that require substantial earthwork. Projects that don’t involve earthwork (grading)
will not require resource files to be delivered with the plans.

Static Electronic Drawings — These files are usually more user friendly than
Production Drawings. They are easy to review, transport, and print. The only
approved “static electronic drawing” is a pdf (portable document format). Submittal
of other static electronic drawings such as tif, jpg, and pps (portable plan sets) will
only be accepted if these formats are pre-approved by the NDDOT.

Static Electronic Drawings — PDF’s are required on all projects.

Printed Paper Drawings - This document is the original PE stamped and sealed
document. Printed Paper Drawings are always required.

The “Final Plan Delivery” CD or DVD shall not include copies of the correspondence documents
and preliminary reports. If the NDDOT Technical Support Contact person requests additional
copies of the correspondence documents and preliminary reports, this information should be sent
on a separate CD or DVD.
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Production Files Requirements

Production drawings shall follow the NDDOT CADD Standards. They shall be developed with
MicroStation V8I.

Conceptual production (dgn) drawings should be delivered when the project is being developed
by a consultant that is only responsible for developing the environmental document. If the same
consultant is responsible for developing the final plans, most conceptual production (dgn)
drawings should not be submitted. Drawings that are displayed for the public (environmental
documents, public input meetings and hearings) are exceptions to this rule. Drawings that are
displayed for the public must be reproducible as shown to the public. Note static (pdf) files are
the preferred method of displaying information for the public. If static (pdf) files of information
displayed for the public are created and saved, the conceptual production (dgn) files do not need
to be saved. Production (dgn) drawings can be displayed for the public, but all the drawings
including reference files must be protected from further editing including display options. A
version of the main drawings displayed for the public and all reference files must be copied and
saved to a protected directory as read only. The protected directory should be named so that it is
easily identifiable such as “Public Meeting”, “Public Input”, “Public Hearing” or “Public
Informational”.

Production drawings shall only include files required for the development of the final plans. All
of the conceptual drawings are seldom desired (see above paragraph). The Production files shall
only include the essential (CADD Standard) files. Temporary, junk, alternative drawings not
used in the final plans, backups, and other interim drawings shall not be submitted. The goal is
to make it easy to review the project files and avoid the transmittal and storage of unnecessary
files.

Drawing display setting (levels, reference files, view attributes and other rendering settings) shall
be set and saved as they were used to create the final printed plans. The goal is to make it easy
to review and print files. The reviewer should not have to figure out what reference files need to
be turned on and what display settings need to be used.

Consultants should use the directory structure discussed in section 2.1 and they should use the
“Save Relative Path” when referencing drawings. The goal is to make project files portable.
Broken reference paths are CADD standards violations (see section 3.12 of the NDDOT CADD
Standards Manual).

Production drawings should be set to read only before the plans are signed and stamped as
required by the Board of Professional Engineers and Land Surveyors. The goal is to use the file
modify date to flag and eliminate changes to the plans after they have been signed.
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Resource File Requirements

If shapes were used in the development of cross sections, drawings of GEOPAK super elevation
shapes need to be submitted.

If cross sections are required, a working cross section drawing (includes XS origin cells) shall be
submitted.

If earth work is calculated from cross sections, the earthwork shapes shall be drawn into the
cross sections with stratified colors. The final earthwork shapes shall be kept so that they can be
compared with the earthwork log file.

Multiple gpk files for the same phase of project development shall be avoided. Different
coordinate geometry elements with the same name shall be avoided during plan development.
Different coordinate geometry elements with the same name shall be prohibited when Resource
Files are submitted as part of the plan delivery. Minimizing the number of gpk files will
minimize the chance of coordinate geometry discrepancies.
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Static Electronic Drawing Requirements

Portable Document Format (pdf) is an accepted static electronic format.

The paper size format for the pdf must match requirements for paper delivery (example, plan
sheet intended to be printed on 11x17 inch paper should be formatted to be printed on 11x17
inch paper). PDF’s should be created at 600 dpi. Supplemental images - Rasters may be printed
at a lower resolution.

The overall electronic files size of the PDF plans is a concern. The plans must be easy to
download.

1. The plans shall be divided and published in separate volumes.

a. Every separate volume shall be less than 40 MB. The individual sections, as
defined by section numbers, shall not be split between volumes. The volumes
may be spilt where the section numbers change. Designers shall use their
discretion when deciding where the splits occur.

b. Cross Sections are always published as a separate volume(s).

C. The separate volume requirements only apply to the Final Plans used for
Electronic Distribution. Separate volumes are not required for other phases of
project development, color or the PE version (used only for printing as sealing
by a Profession Engineer or Surveyor).

2. The PDF shall be optimized with Adobe Professional 10. The “PDF Optimizer” tool
usually reduces the file sizes. The following is an overview of the Optimizer

Settings.

The “PDF Optimizer” tool is found in the Adobe Acrobat Pro menu under “Save As > Optimized
PDF”. Optimizing a file can take several minutes. Copy the pdf to a local drive before using the
“PDF Optimizer” tool in order to improve performance.
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PDF Optimizer

Settings: ICustom vl

Current PDF Version: 1.5 (Acrobat 6.x)
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Transparency
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Downsample: IBicubic Downsampling to j 130  ppi for images above |225  ppi.

Compression: IJPEG VI Quality: IMedium vl

Grayscale Images :

Downsample: IBicubic Downsampling to j 150 | ppi for images above [225 | ppi,

Compression: IJPEG VI Quality: IMedium vl

Monochrome Images :

Downsample: IBicubic Downzampling to j |3DD ppi for images above [450  ppi.

Compression: IJBIGZ vl Quality: ILossy vl

All units are in pixels per inch (ppi).

¥ Optimize images only if there is a reduction in size
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¥ Flatten form fields
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[¥ Discard all alternate images
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[~ Discard document tags
[™ Convert smooth lines to curves
[~ Detect and merge image fragments
[~ Discard embedded print settings
[~ Discard embedded search index
[~ Discard bookmarks

[o]4 Cancel
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Discard User Data
Settings are as shown.
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The pdf plan set files must be named according to a standard naming convention. PDF files
should be named by combining, in the order shown, the following information:

1.

o

“Project Number”

a. If the plan set includes multiple project numbers (multiple project numbers
shown on title sheet) the project numbers should be included in the name
separated by a space character, ampersand, and another space character
(example: “SS-3-001(015)128 & SS-3-020(071)044 Final Plans 10f3
ED.pdf”). The space characters are needed for the proper word wrapping
when the document gets posted on the web.

b. If naming the pdf using multiple project numbers will create a very long name
(over 100 characters long), then only the first project number listed on the title
sheet should be used follow by the phrase “and Other Projects” (example:
“STM-SU-1-988(024)036 and Other Projects Final Plans 10f2 ED.pdf”).

Project phase such as

a “Preliminary”

b “PS&E”

C. “Final Plans”

d “Addendum1”, “Addendum?2”, ... etc
e “Plan-Rev1”, “Plan-Rev2’, ... etc

f. “Asbuilt”

The specific volume number and total number of volumes shall be included in the file
names (example “10f3”). Every volume shall be counted, including cross sections
and standard drawings. The volume suffix is only required for final plans used for
bidding purposes. The use of separate volumes is optional for other phases of project
development.

If the project requires cross sections, they must be included as a segregated file. A
separate file must be used even if there is only one cross section sheet. The file name
for cross sections shall include the abbreviation “XSEC”.

“Color” if the plan set is in color. All other sets will be assumed “black and white”.
“ED” (for electronic distribution) or “PE” (for Profession Engineer signing and
stamping).
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The following is a list of example names.
IM-2-094(070)275 Preliminary
IM-2-094(070)275 Preliminary Color
IM-2-094(070)275 PS&E
IM-2-094(070)275 PS&E Color
IM-2-094(070)275 Final Plans #of# ED

(replace # with actual numbers, example 10f3)
IM-2-094(070)275 Final Plans PE
IM-2-094(070)275 Final Plans Color ED *
IM-2-094(070)275 Final Plans Color PE *
IM-2-094(070)275 Addenduml ED
IM-2-094(070)275 Addenduml PE
IM-2-094(070)275 Plan-Revl1 ED
IM-2-094(070)275 Plan-Rev1 PE
IM-2-094(070)275 Plan-Rev2 ED
IM-2-094(070)275 Plan-Rev2 PE
IM-2-094(070)275 Asbuilt
IM-2-094(070)275 Asbuilt Color

IM-2-094(070)275 Preliminary XSEC
IM-2-094(070)275 Preliminary XSEC Color
IM-2-094(070)275 PS&E XSEC
IM-2-094(070)275 PS&E XSEC Color
IM-2-094(070)275 Final Plans #of# XSEC ED
(replace # with actual numbers, example 30f3)
IM-2-094(070)275 Final Plans XSEC Color ED *
IM-2-094(070)275 Addenduml XSEC ED
IM-2-094(070)275 Plan-Revl XSEC ED
IM-2-094(070)275 Plan-Rev2 XSEC ED
IM-2-094(070)275 Asbuilt XSEC
IM-2-094(070)275 Asbuilt XSEC Color

* At this time, color final plans are not posted on the internet for bidding purposes. They
may be used by field personnel as an added convenience. A Black and white version of
the PDF Final Plans and Addendums shall be used for the internet.

After the final plans have been completed, the pdf plan set for preliminary review should be
deleted. The pdf plan set used for PS&E review should be kept until the project is constructed
(assumed 3 years after bid opening). Versions of PDF plans created for PE stamping should be
purged after the paper set of plans has been officially approved and stamped.

Electronic Distribution Statements must be used as noted in the North Dakota Administrative
Code, Title 28, “28-02.1-08-03.9”. PDF plan sets without the electronic Distribution Statement
will not be accepted for final plans, addendums and plan revisions. The NDDOT cannot use
PDF plan sets without the Electronic Distribution Statement for electronic distribution.
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Consultants doing work for the NDDOT shall not submit pdf plan sets with an electronic PE
stamp. Plan sets with an electronic PE stamp are not to be distributed electronically.

Optically scanning the original paper plan set in order to create a pdf plan set is discouraged
because the image quality is degraded and an electronic distribution statement is needed. PDF
plan sets created directly from optically scanning the original paper plan sets must be revised
with an electronic distribution statement. The electronic distribution statement is needed
whenever the plans are distributed electronically.

Consultants must submit all types of plans in both color, and “black and white”.
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2.10 Plan Distribution

April 2009

Refer to the Design Manual for information on Plan Distribution;
[-10.02 Preliminary Plan Review
[-10.03 Plans Specifications, and Estimates (PS&E)
1-08.03 Final Plans Submittal
[-11.01 Plan Revisions Prior to Bid Opening
[-11.02 Plan Revisions After Bid Opening (Change Orders)



http://www.dot.nd.gov/manuals/design/designmanual/chapter1/DM-1-10_tag.pdf
http://www.dot.nd.gov/manuals/design/designmanual/chapter1/DM-1-10_tag.pdf#page=3
http://www.dot.nd.gov/manuals/design/designmanual/chapter1/DM-1-08_tag.pdf
http://www.dot.nd.gov/manuals/design/designmanual/chapter1/DM-1-11_tag.pdf
http://www.dot.nd.gov/manuals/design/designmanual/chapter1/DM-1-11_tag.pdf#page=2
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2.11 Current Software

May 2016

The NDDOT is presently using the following versions of software;
AutoTurn 9.1

Axiom Toolkit

Axiom Title Block Administrator 8.13c
Bentley View 08.11.07.440

GuidSign 6.1

GEOPAK 8.11.07.619

MicroStation 8.11.07.443
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2.12 Current Resource Files
May 2016

The current CADD Standard Index File is dated “5/18/2016 3:28:12 PM”. This index is used

with a macro to review your current version of NDDOT CADD Standards. From the

MicroStation menu, see “NDDOT > Tools > Index NDDOT Standard Files”. The index file
(nddotUpdatelndex.csv) is a comma separated value file that can also be manually reviewed with

a text editor or Excel.

The following tables show the update dates for CADD Standard Resource Files. The file name

shown in blue is a hyperlink.

MicroStation Files

Description File Name Updated  Posted
(Linked to Recourse)

Cell Libraries Cells.exe 4-16 5-16

Dictionaries, Annotation Scale Data.exe 2-16 5-16

Definitions, Tag Library, Geographic

Coordinate Systems, Line Styles,

Fonts and Colors, Seed Files

DGN Libraries dgnlib.exe 5-16 5-16

Macros, MDL Macros.exe 3-13 09-13

Plotting Plotting.exe 5-16 5-16

VBA VBA.exe 5-16 5-16

Workspace Configuration and Setup ConfigurationFiles.exe 5-16 5-16

Files

Geopak Files

Description File Name Updated  Posted
(Linked to Recourse)

Criteria Files Criteria.exe 11-13 12-13

Design and Computation Manager, DCM.exe 10-14 10-14

Borehole Tools

Sheet Library Sheets.exe 11-15 5-16

Super Elevation GeopakSuperElevation.exe 1-16 5-16

Survey Manager and Legal Library SMD.exe 3-16 5-16

Roadway Designer RD.exe 11-13 12-13

Other CADD Files

Description File Name (Linked to Updated  Posted
Recourse)

GuidSIGN GuidSIGN.exe 9-15 9-15



http://www.dot.nd.gov/manuals/design/caddmanual/v8/Cells.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Data.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/dgnlib.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Macros.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Plotting.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/VBA.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/ConfigurationFiles.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Criteria.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/DCM.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/Sheets.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/GeopakSuperElevation.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/SMD.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/RD.exe
http://www.dot.nd.gov/manuals/design/caddmanual/v8/GuidSIGN.exe
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2.13 Software License Agreements
Sept 2010

Most of the time, common sense and a little respect will keep you on the right legal track with
software license agreements. The NDDOT Information Technology Division will also promote
the legal use of software. So if they tell you not to do something, don’t do it. ITD completes
most of the License Agreements for NDDOT employees, but all employees need to live up to
them. At the end of this section are links to software agreements if you need to get into the
details.

There are some agreement rules that might not be widely known. These CADD Standards will
highlight a few rules that might deserve more of your attention.

1. The NDDOT has an axiom License for only the Central Office. Employees at
Materials and Research, District Offices and Field Offices shouldn’t use Axiom
products. Central Office employees shouldn’t use Axiom products on files located on
district servers. ITD will add and remove software as applicable, but sometimes there
is a little delay during employee transfers and rotational assignments. Just because
you can use Axiom doesn’t mean it’s OK.

2. Google Map imagery from the “Free Addition” shall not be used for any documents
that are used outside of the department. Don’t use a Google Map in a concept report
or public meeting. The “Professional” version of Google Earth is required for sharing
information externally.

If your using Google Map imagery for an internal purpose. Don’t remove the Google
water marks. You are using copyrighted material.

Note, the NDDOT has an Arc Internet Mapping Service that is available to all
employees. Imagery from this tool is often better than Google imagery. See section
7.2.

Axiom (accessible on NDDOT Central Office Network)
S\STANDARD\V8i\Axiom\Axiom End User Software License Agreement.pdf

Google Earth
www.google.com/accounts/tos/highlights/utos-us-en-h.html
www.google.com/accounts/TOS
www.google.com/enterprise/earthmaps/pro_features.html#faq

MicroStation (Typical location, if installed on your computer)
C:\Program Files\Bentley\MicroStation VV8i (SELECTseries)\MicroStation\Eula.pdf

GEOPAK (Typical location, if installed on your computer)
C:\Program Files\Bentley\GEOPAK\V8.11\eula.pdf



http://www.google.com/accounts/tos/highlights/utos-us-en-h.html
http://www.google.com/accounts/TOS
http://www.google.com/enterprise/earthmaps/pro_features.html%23faq

MicroStation

3.1 Seed Files

Dec 2010
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Seed files are used to set a number of DGN file parameters. When a new DGN is going to be
created, the operator needs to select the correct seed file. The seed file is actually a DGN file
itself. Presently the NDDOT is using 3 different seed files;
1. NDDOT _seed.dgn
2. NDDOT _seed_Ft&In.dgn
3. NDDOT _seed_3D.dgn

The following are some of the features adjusted in the NDDOT seed file (NDDOTseed.dgn).

NDDOT _seed.dgn

NDDOT seed Ft&In.dgn

NDDOT seed 3D.dgn

Default Font

NDDOQOT (true type)

NDDOT (true type)

NDDOT (true type)

Default Drawing Scale

17 =200

1u - 51’

17 =200’

Design File > Color

Selection Set: Yellow
Highlight Color: Yellow

Selection Set: Yellow
Highlight Color: Yellow

Selection Set: Yellow
Highlight Color: Yellow

Design File > Working
Unit Format

MU

MU:SU

MU

Design File > Working Unit = Feet Unit = Feet Unit = Feet

Units > Linear Units > Label = Label =* Label =*

Custom > Master Unit

Definition

Design File > Working Define Custom Unit: Unit = Inches Define Custom Unit:
Units > Linear Units > toggled on Label =* toggled on

Custom > Sub Unit
Definition

1000 th = 12 inches

1000 th = 12 inches

Design File > Working
Units > Advanced
Settings > Edit
>Resolution

304800 per Foot
Solids 0.62137 miles

304800 per Foot
Solids 0.62137 miles

304800 per Foot
Solids 0.62137 miles

Design File > Working DD MM SS DD MM SS DD MM SS
Units > Angels > Format
Levels - Embedded Tag DipText Tag DipText Tag DipText
Sht Text Sht Text Sht Text
Sht Stamp Text Sht Stamp Text Sht Stamp Text
Sht Lines Sht Lines Sht Lines
View Attributes ACS Triad: Off ACS Triad: Off ACS Triad: Off
Clip Volume: Off Clip Volume: Off Clip Volume: Off
Fill: On Fill: On Fill: Off
Grid: Off Grid: Off Grid: Off

“Place Note” tool

Start at “Terminator”

Start at “Terminator”

Start at “Terminator”

“Scaling” tool

Scale Dimension Values:

Off
Scale Annotations: On

Scale Dimension Values:
Off
Scale Annotations: On

Scale Dimension
Values: Off
Scale Annotations: On

Model Properties > Line
Style Scale

Annotation Scale

Annotation Scale

Annotation Scale
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3.2 Global Origins and Coordinate Systems

Sept 2010

The present NDDOT CADD standard seed files have a different Global Origin than the previous
CADD standard seed files. The new Global Originisat: x =y =2(3d)=0

The global origin in a MicroStation design file will not need to be changed if referencing is done
with the “Coincident —~World” option. This option has been set as the default in the NDDOT
Standards and will automatically be selected for most users.

If this option is not used and the active file has a different global origin than the reference file,
the data may appear to reference into the active file correctly, but the coordinate values of the
referenced data may change!

To check the existing global origin of a file, key ‘GO=?" into the key-in box. The value will
appear in the bottom right-hand corner of the screen. Do not key in any other GO commands -
except ‘GO=?’, the coordinate values of existing points in the design file could change!

When creating a new plan view drawing, assumed drawing coordinates should be avoided. Plan
view drawing elements should be drawn as close to real ground coordinates as survey data
allows. Using real ground coordinates will help with the exchange and comparison of data with
other sources (example; wetland delineations can be compared to all plan view drawings if real
ground coordinates are used, GIS data can easily be imported into MicroStation).

If real ground coordinate survey information is not readily available for projects such as ones
that use 90-1 surveys, spatially correct base maps should be used to get reasonably close to real
ground coordinates. MicroStation base maps can be referenced from the directory
R:\project\BaseMaps\. Each county has its own base map because each county has a slightly
different projection. Highway centerlines, Mile Points, and Section lines are some of the
drawing features that can be used to tie plan information to real ground coordinates. The base
maps are exported into MicroStation with a high degree of accuracy, but the accuracy of the GIS
data varies considerably. Users should be conscience of the degree of accuracy when comparing
information. Just because information is very close doesn’t always mean it is acceptable.
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3.3 MicroStation Templates, Tools and Task Navigation
July 2014

The CADD standards use the term “Task Navigation” to describe the way templates, tools and
tasks are used together to manage commands and symbology.

MicroStation “Templates” are the primary way the NDDOT manages element symbology.
Tools are the primary way MicroStation commands are issued. Tools often reference the
symbology in a template. Tools also offer some additional control of symbology that might not
be available in the template. Tasks are used to manage the way tools are delivered — displayed.

A good understanding of Task Navigation will simplify the placement of most drawing elements.
This tool is used to change several settings at one time and select a specific tool. Example; the
level, color, line weight and style, text height and width and justification could all be switched
and the place text tool could all be activated with one click of a button.

There are numerous Task groups. Some are delivered with MicroStation and GEOPAK. Many
other groups have been created by the CADD standards. Several Task groups are organized to
draw specific elements in a specific drawing or group of drawings. These task groups promote
drawing with the correct standard in the correct drawing. For example, existing power poles are
found in the Topog task group and they should be drawn in the file named Topog.dgn. Several
task groups are intended for only one particular type of drawing. Some task groups are intended
for a group of drawings. Appendix A explains which task groups are used with which drawings.

The standard NDDOT interface hides some task groups based on the active drawing name. The
standard interface makes it easier to pick the appropriate task group while promoting the use of
standard drawing names by limiting the available task groups. For example; to display the Topog
task group, the active drawing typically needs to have a name starting out with the word
“Topog”. If you were in a drawing named “Design.dgn” you would not typically be able to see
the Topog task group. The hiding of task groups uses a function called “Named Expressions”.

Task groups can be organized in a directory structure with parent child relationships. For
example the Topog task group is found under the Photo task. The Photo task is the parent task
and the Topog task is the child task. The following list shows how the standard task group
parent child relationships.
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Bridge Work Flow

Design

Section 170

001TS Title
004SW Scope
011DT Data Tables
020GD Details
030TP Typical
100WZ_ConSign
AutoTurn
Consign
Countour

Cut Sheets Design
Design

DS Align

DS Util

DTM
Environmental
Fencing

Paving

Profile

Removal
P_Erosion_C

T Erosion_C
Shape

Wetland Impacts
Xsec

Materials

Photo

Materials
180PT_PitPlat

081CD_Survey
Control

RW Bndry
Topog

DTM

Planning

Planning



Traffic Work Flow
Section 100
ConSign
CsDitl
DTmpLtDe
LTmpLt
DintDe
Lint
Section 110
DOHDet
DSignDet
LOH
LRemSign
LSign
Section 120
LPvmt
DPvmtDet
Section 130
LGdrl
LJBar
GdriDe
DBarrier
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Section 140

DHMDet
DLitDe
DLitOH
DULDet
LHM
LLight
LLitOH
LUL

Section 150

DFlsh
DintDe
DSigDet
DATRDet
LFlsh
Lint
LRemSgl|
LScop
LSgnl
LATR

Section 160

DITSDet
LITS

NDDOT symbology (templates) rely heavily on Annotation scale (Drawing Scale) settings.

In order to use the standards correctly, the drawing scale must be set. Guidelines have been set
up for placing cells, custom line styles, text, patterns, etc. to insure uniformity in all prints. Most
of these settings are automated in Task Navigation. For example, one user is creating a border
sheet set to plot at 1"=40" and another user is creating a border sheet set to plot at 1"=200". If
both sheets were plotted and compared, the text in the title block should be the same size even
though they were plotted using different scales. By using Task Navigation, a user can place
cells, custom line styles, text, patterns, etc. quickly and easily, because the individual element
scale factor are adjusted by the drawing scale. See the next section on “Annotation Scale”.
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3.4.1 Levels

Sept 2010

Many levels are named with the noun first and then the adjectives, example “Pole Wood Cell
Exst”. Abbreviations are often used. The “Exst” (Existing) adjective is used at the end of level
names when applicable. Level names without the “Exst” adjective are intended to indicate an
undefined or proposed state of presence.

Levels have been set up for specific pay items. The names and descriptions for these levels are
based on the pay item spec-code number and description, example “722-3690 INLET SPECIAL
42IN”

Level descriptions are similar to level names except the “Exst” adjective, when used, is first and
the element type is not used, example “Exst Pole Wood”.

Level numbers have been set up as an identification number. The digits in the number represent
attributes of the items on that level. Most standard levels are numbered from 1,000,000,000 to
4,294,967,294. The numbering system is as follows: “A,BCC,CDD,DDE”

A — 1 digit — Type of element
1= Points, Lines, Curves, and shapes 2=Cells, 3=Text and Dimensions, 4=Patterns
B - 1 digit — Presence
0=Undefined, 1=Existing, 2=Proposed
C - 3 digits — Closest NDDOT Specification Number
Some CADD specific specifications have been added.
D - 4 digits — Subsection or NDDOT Code.
When used as subsection it helps ensure uniqueness.
E — 1 digit — Pay Item Use
0=No, 1=Yes

Notes
e The maximum level number in V8 is 2/32-2= 4,294,967,294.
e Component names are usually based on the level names except that the element type is
not used in the component name.
e Special levels have been set up for raster attachments.

Level Name Level Number
“Raster Group 1” 101
“Raster Group 2” 102
“Raster Group 3” 103

Rasters should be attached to the level named “Raster Group 1”. The levels “Raster
Group 2” and “Raster Group 3” can also be used if you desire to stratify rasters by level.
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3.4.2 “Bylevel” Settings

July 2013

The standard Levels have been set up for “ByLevel” use. However, the linestyle scales have to
be manually set by the user and only a few components of the “Tasks - Element Templates” and
the D&C Manager use “ByLevel” settings. Presently, “ByLevel” settings are only recommended
when they are used by the standard “Tasks - Element Templates” or “D&C Manager” files.

3.4.3 Level Libraries

Sept 2010

The level information is stored in drawing libraries (dgnlib) files. They are located in the
directory “S:\Standard\V8I \dgnlib\Levels\”. Most levels are automatically attached with the
NDDOT standards. Presently the NDDOT has only one supplemental level library that can be
used for additional pay item levels.
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3.5 Line Styles

Sept 2010

Users are strongly encouraged to use Task Navigation and Annotation Scale to set the
appropriate line style settings (see Section 3.3). A user could individually set the Level, Color,
Weight, Style and Style Scale for each element. However, this is not recommended because
changing each setting individually/manually takes more effort and time and has a higher
potential for user errors.

Many line styles use both a line style scale factor and Annotation scale. One of the common line
style scale factors is 1/240 = 0.004167. This factor is based on how the original line styles were

created. The displayed line style uses the product of line style scale and Annotation Scale. Task
Navigation — Templates automates the line style scale factor.

There are a few line styles that are not plotted with a “Scale Factor”. These line styles typically
represent the true physical size of a feature such as guardrails, curbs, curb and gutter and dowel
joints. These features are always drawn at the same scale and will be plotted on paper
proportional to the plotting scale. These line styles are digitized by turning off the scale factor
toggle and ignoring the Annotation Scale. Again, Task Navigation — Templates automates the
line style scale factor. The line styles that are drawn to a physical size are highlighted with an
asterisk in Appendix B.

Certain line styles are directional, in that their pattern component is not symmetrical. An
example would be the *Exst Wetland Delineated’ custom line style. The small filaments that
represent vegetation and grasses should point in toward the water side of the wetland.
Consequently, the line needs to be digitized in the direction that will produce this effect (counter-
clockwise on a closed shape.) Check Appendix B for directional information.

Tech Tip: To easily change the direction of a line style, do the following:
On the menu bar under Tools —> Tool Boxes —> Check the Curves tool box

Gy
¢

—> Click OK
Click on the Change Element Direction icon.
Identify the Element needing new direction
Direction of element changed!
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3.6 Cells

July 2013

NDDOT cell libraries are located at “S:\STANDARD\V8I\cell\”. The following is a list of the
active NDDOT cell libraries:

Bridge.cel Bridge items

Bridge_RCBox.cel Reinforce concrete box items
Cells 1 scale.cel General cells placed at 1 scale
Cells plot Scale.cel General cells placed at plot scale
CSP_end_sections.cel Corrugated steel pipe end sections
drainage_structures.cel Drainage structures

Driveway.cel Dimension driven driveway cells
Guardrail.cel Guardrail items

Hatch.cel Patterning items

Ltg schematic.cel Lighting schematic items
Manholes.cel Manholes

Pipe.cel Pipe End View

pipe_bends.cel Pipe Bends

Pvmtmkg.cel Pavement marking
RCP_end_sections.cel Reinforce concrete pipe end sections
Sheets.cel Sheet borders (see Appendix H)
Signal_Det.cell Signal Detail Items

Signals.cel Signal items

Signs.cel Signing items

For a comprehensive listing of the available cells (see Appendix C).

Some cells in the Signs.cel library contain “Data Fields”. By using data fields there is no need to
drop the cell to edit the text in the cell. These cells can be easily identified by looking for the
letters DF at the beginning of the cell’s description. For example, the description for the cell
named R1 2U, is DF SPEED LIMIT. To use these cells, place the cells and simply select the
“Fill in Single Enter-Data Field” tool and click on the data field that needs to be changed.

Text
B 7 & R aa Al &
A vr | s b P Sy U]

| Fil In Single Erter-D ata Field|

Then type in the text and press “ENTER”. The data field will fill in with the text that was just
entered. Data fields will appear as “ ” within the cells. To ensure that these lines do not
show up when the drawing is plotted, access the “View Attributes” through “Settings” and make
sure the “Data Fields” box does not have an X in it.
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3.7.1 Annotation and Fonts
May 2016

All features on plan sheets should be annotated whenever possible. To ensure the final plans
have a consistent and clear readability, operators must follow the standard guidelines for upper
and lowercase letters, font type, annotation size, underlining and bolding, use of levels and
abbreviations.

Lowercase annotation is used for all annotation except for:
e Capitalization at the beginning of a description (e.g. Bridge begins 1200+65.0)
e Abbreviations for separate words (e.g., the abbreviation for power pole is PP, for cable
guardrail is C Gdrl, for corrugated metal pipe is CMP).
e Pay Item Headings and Descriptions

The most common text font used for NDDOT plans is “NDDOT” (true type font). Some
standard annotation is placed with font “engineer” or true type font “Dot Matrix”. The use of
the “engineer” and “DotMatrix” fonts are for unique situations as programmed into the
Templates, “D&C Manager” or other NDDOT standard tools. Engineer font is used with some
documentation created by GEOPAK in order to avoid formatting problems such as spacing and
special characters. “DotMatrix” font is used with particular labels used on ROW plats. The only
fonts to be used on NDDOT plans and related drawings are fonts “NDDOT”, “engineer”, and
“DotMatrix”.

Annotation should be underlined when it is in a title that is outside of a title block, or when it is a
Pay Item. Slanted or italicized text will not be used on plan sheets.

Pay Items Pay Items that are itemized on sheets should use the following format.

1. Include heading labels in capital letters on each sheet at the beginning of a pay
item list. The headings are; SPEC, CODE, BID ITEM, QTY, and UNIT.

2. Include Spec and Code Numbers. A hyphen should not be used between the sec
and code. Always use 7 digits for the spec and code (example: 123 0001).

3. Include Pay Item Name In All Capital Letters.

4. Underline the Spec and Code and Pay Item Name. The underline should extend
through the quantity and unit columns.

5. The itemized quantity information should be indented from the spec and code.
The itemized quantity information should be left aligned with the bid item name.

6. Include measurement units with the quantities.

7. Use the font size specified by the MicroStation task group for the applicable
sheet.

8. Individual sheet subtotals should not be used.

Designers should use their discretion for pay item location descriptions. Station and offset
information doesn’t have to be used for all quantities.
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This formatting is not required for pay item used in tables such as the “Traffic Control Device
List” and earthwork summary tables.

The following is an example of Pay Item formatting.

SPEC CODE BID ITEM QTY UNIT
867 5309 GARBAGE CAN
Sta 6+00 83’ Rt 1 Ea
Sta 7+00 97" Lt 1 Ea

328 1722 EXTENSION CORD
Sta 6+00 83’ Rt to 7+00 97’ Lt 145 LF
Sta 7+00 97’ Lt to 8+00 97° Lt 100 LF

Additional characters have been added to the font tables to enable the placement of such
characters as fractions, Greek symbols and mathematical symbols. Appendix L lists the
available characters. To draw a special character into a MicroStation drawing, open the “Place
Text” box and enter back slash (\) followed by the special character number designation (from
0-255). The special character will be visualized on the screen and it can be placed by left mouse
clicking.

A special character was added to the NDDOT true type font library in March, 2014. This
character looks like a question mark with a box around it. This character is located after the
square root symbol. The character is in keystroke \208 which is not normally programmed on
most keyboards.

This character is used to describe some surveyed items that “Indicate a feature that has an
unknown characteristic, potentially based on: lack of description, location accuracy or purpose.”
This special character will simplify CADD labeling.

True type fonts are not resources that are directly installed on the network. Users will need to
have the fonts installed or updated on their computer every time there is a font update.

Standards have been set for the size (height and width) of annotation. Task Navigation —
Templates have been programmed with the standard sizes and should be used for the placement
of most annotation. The typical annotation heights used on NDDOT plans range from 0.05 to
0.17 inches when plotted to paper.

Plan Note sheets should use a 0.12” text height - (12) Arial font. The summary of “Estimated
Quantities” should use a 0.09” text height - (9) Arial font.
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3.7.2 Abbreviations

Sept 2013

When so many features are annotated in a set of plans, space is at a premium. To generate more
available space, operators should use abbreviations as often as possible. We have established a
comprehensive list of abbreviations that are commonly used by the DOT. These abbreviation
lists can be found in Appendices E and F.

The NDDOT also has a glossary tool (macro). This is used to look up NDDOT abbreviations
and send them to your clip board and MicroStation Text editor — Word Processor dialog. This
macro can be accessed from the main pull down menu NDDOT>Tools>Glossary. Itis also
accessible with short cut key combination “Ctrl + F10” if the NDDOT function key menus are
used.

Abbreviations are placed without any punctuation (e.g., Cl is 23.9' It of hyd at elev 1800.6").

If additional abbreviations need to be added to the glossary or appendix, contact a Standards
Committee representative or use the Standards Request Form at the end of this manual.
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3.8 Dimensioning
Sept 2010

Commonly used dimension settings are grouped and stored in dimension styles. Dimension
styles are available to the designer through the “Dimension and Text Styles” dgn library file. A
complete list of styles and their settings can be found in Appendix P.

There are several settings within the standard dimension styles that can be modified. The
following is an overview of these settings.

Tool Settings

Alignment:  Determines the axis along which the dimension is aligned (View, Drawing, True,
or Arbitrary

Location: Controls the location of dimension text (Automatic, Semi-Auto, or Manual.)

Dim Offset: Sets a standard offset for the placement of a dimension.

Style Settings

Fit Options

Text/Terminator:  Selects the minimum fit dependant on the text, terminator or combination
(Text Moves First, Terminator Moves First, Smallest Moves, Both Move, Text
Inside, Term. Qutside, Term Inside, or Term. Reversed.)

Angle Format
Units: Sets the units of measurement for angular dimensions (Length or Angle.)

Display: Sets the display format for angular dimension text (D.DDDD, DD*MM',
DD"MM'SS", C.CCCC, or Radians.)

Accuracy:  Sets the number of decimal places to display for angular dimensions.
Text Format

Orientation: Sets the orientation of dimension text relative to the dimension line (Aligned or
Horizontal.)

Location: Sets the location of the text relative to the dimension line (Inline, Above, Outside,
or Top Left.)
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3.9 Patterning and Hatching

Sept 2010

Patterning and hatching is used for drawings that require material definitions, such as concrete,
rock and excavations. A list of patterns is shown in Appendix G.

Users are encouraged to use “Tasks” for patterning and hatching because several of the settings
are automated. If “Tasks” are not used, settings such as scale, row spacing, column spacing and
angle will have to be manually calculated and entered.

The standard patterns are stored in the cell library S:\Standard\\VV81\Cell\Hatch.cel. To establish
the correct values for the “Pattern Area” box, multiply the values given in Appendix G (for scale,
row spacing and column spacing) by the final plot scale. For example, if the final plot scale is 1"
=200, and the pattern cell is “Lignite Coal,” the scale will be 0.5 x 200 = 100. Row spacing will
be 0.15 x 200 = 30. Column spacing will be 0.15 x 200 = 30. And the angle remains at 45
degrees. Remember if “Tasks” is used, these settings are automated.

If an operator is working in a file with a lot of hatching or patterning, they should probably
toggle off “Patterns” under “Settings,” “View Attributes.” This will help with refresh speed. If
they toggle on “Associative Pattern” in the “Pattern Area” box, the operator will be able to
manipulate the closed shape and still have the pattern fill the altered shape.
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3.10 Print Drivers

Sept 2010

NDDOT customized print drivers have been setup for printing. These print drivers files have the
extension “pltcfg”. These files work together with the Windows system print drivers. These
files adjust many configurations for NDDOT work. Appendix M is a catalog of the printers and
drivers set up for the NDDOT. The following is an overview of some of the adjusted print
configurations.

Printers

The drivers in the “...\plotdrv\Manually_Pick_Printer” folder don’t force a certain printer. You
need to select a printer during the printing process or your default windows printer will be used.
The drivers in the “... plotdrv\Printer_Specific” folder automatically select a designated printer.

Forms and Sheet Sizes
Some printer drivers work more efficiently with designated form names and sheet sizes. These
have adjusted accordingly.

Pen Tables
Several pen tables have been set up to control the way some drawing elements are printed such
as sheet stamps, tags, border comments and general color control.

Print Styles
Print Styles can control most of the same settings found in plot drivers. One key feature of print
styles is automatically coordinating the print area with the sheet cell boundary.

Color Settings
Print drivers control what is printed in color, black and white, and gray scale.

Points Size
Most NDDOT print drivers don’t display points in output.
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Weights

The table on the right is a line weight guide. Itis

provided as a cross reference for evaluating your printer

output. These widths have been used to develop the

CADD standards.

MicroStation

Line Weight | Millimeter
0 0.0423
1 0.1270
2 0.2540
3 0.3810
4 0.5080
5 0.6350
6 0.7620
7 0.8890
8 1.0160
9 1.1430
10 1.2700
11 1.3970
12 1.5240
13 1.6510
14 1.7780
15 1.9050

Line Caps and Joins

The "NDDOT print drivers"

print lines with the following Endcap = Butt

This setting keeps the spaces in |inestyles

attributes: constant as the weights are increased

—___

Linejoin = Round

This setting rounds the corners of joined |ines
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3.11 Print Organizer

Sept 2010

Print organizer is a utility for plotting one or more design files at a time. A single print organizer
job can print drawings from multiple directories. This section only discusses the NDDOT
standards set up for print organizer. The following is a quick guide.

1.

Use the NDDOT standard sheet cells.

a. The NDDOT standards for print organizer use a plot boundary defined by a
particular shape. These shapes are included in all of our sheet cells. The
shape is the outer box with attributes; level = Sht Lines, color = 102, Weight =

1, Style = 1.

b. Do not use the “Use Shared Cells” option when placing sheets. Printing will
not work correctly if this option is used.

C. Borders in reference files will not be found.

Invoke print organizer under MicroStation file commands.

Check the current assigned printer in the lower right of the screen. If it is correct,
skip to step 5, if not, follow step 4.

I} untitled.pset - Print Organizer -10] x|
File  Edit View Tools

NS XA AV Y [E- |

Mame | File Name | Model | View Group

[l 3
. 2+
= Wtdprintla'\DOT—RMﬂrZ‘l—ColcﬂischJraems (0 selected) _.:

Under the File command, select Printer Setup. In the new window, choose printer
from the drop down box. Click OK.

a. If the file you intend to print contains multiple sheets within on drawing, such
as a cross-section file, changing printers later in the process will be more
complicated.

Select files to batch plot under the print organizer “add files to set” icon. Click the
Add button to browse for files. Select desired files and click Done. You may click
the Add button again to browse for files in other directories. When all files have been
selected, browse for the print style name that matches your printer and desired output



CADD Standards

format. Click OK.

a. Print style must match the chosen printer or output errors may occur. The
drawings will print to the printer indicated in the lower right, see #3. If the
print style does not match the printer; paper size or color output may be
incorrect; ex. a color drawing may print in grayscale.

b. If the file you intend to print contains multiple sheets within one drawing,
changing print styles later in the process will be more complicated.

If this is for the final set of plans, add any Standard Drawings that you may need.
The Standard Drawings can be found at R:\\SUPPORT\DESSTD. Add these files the
same way you would add any other MicroStation files.

Sort the files into the correct order by clicking on the File Name in the left-hand
column. The up and down arrow icons in the tool bar will now be active. The same
options are available under the Edit command.

Click “File>Save As” on the menu bar and save the print set into a working directory,
in case you need to make any changes later. The print sets should be saved in the
corresponding ePlan folder under the project directory. For example, you are in
Bridge and are working on PS&E plans. First you would navigate to the PS&E folder
under the ePlan directory. Next create a new Bridge folder by clicking on the Create
New Folder &/ button. Double click on the newly created Bridge folder. Type
“Bridge PSE01” in the File name field and click the Save button.

Review the paper size for each document. Paper size should default to 11 x 17. If
adjustments are needed; double click the individual paper size you want to edit or
highlight all entries that need correction to change them at the same time. Double
clicking directly on a paper size will allow you to change all highlighted entries.

a. Check the print area size ( X Size and Y Size) as well. It can be adjusted in
the same manner. For 11 x 17 sheets, the X Size should be 16.
b. When a print style is applied, one sheet will be printed for each sheet cell

found in your files. Print preview will show if this is working. If your
drawing does not have a sheet cell, it will default to saved view.
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10. Selecting the print command will give you a pop-up box.

a.

C.

d.

There is a box that allows a choice of “send to printer”, “create print file”, and
“create Windows metafile”. For paper copies, the “send to printer” option
should show. For PDF or electronic files, this box should be grayed out.
There is also a box that allows a choice of “single print job” or “separate print
jobs” when a PDF or electronic file is to be created. “Single print job” should
be selected to create a single file that contains all the pages. This box will be
grayed out for paper copies.

Review the Destination box for desired location and name for PDF or
electronic files.

Click OK when ready to print.

11.  Changing Printer or Print Style

a.

If NONE your drawings contain multiple sheets, you may change either of
these items at any time. Printer may be changed from Printer Setup under the
File command. Print Style can be changed by using “apply print style” under
the Tools icon. Be sure to match printer and print style. If you do this step to
change printer or print style for a file that contains multiple sheets, you will
receive a single sheet printed multiple times.
If any your files contain multiple sheets and you must change the printer or
print style, follow these steps:

I. Delete only the files with multiple sheets

ii. To change the printer, follow step #4 above.

iii. To change the print style:

1. If you have other files still existing, select the Tools icon and
“apply print style” to apply your new selection, otherwise skip
to step B.

2. Re-add the deleted files following step #5 above, being sure to
use the correct, new print style.

iv. Follow steps #6 - 10 as necessary.
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3.12 Referencing Drawings and Attaching Rasters
May 2016

Reference Paths

All users, especially District and Consultant users, need to use the “Save Relative Path” options
when referencing files. The “Save Relative Path” option will help keep the reference path
integrity when the files are moved from one drive to another. The “Save Relative Path” option
requires that the original directory structure is similar to the final directory structure. Reference
paths must be the same through a common parent directory (higher level directory). See section
2.1 of this manual.

Referencing by “Primary Search Paths” or by “Configuration Variables” is not the preferred
method to reference drawings and attach rasters. Sometimes rasters are referenced from
drawings in multiple directories. If this type of raster attachment is necessary, a project
configuration variable file can be used. This project configuration file must be submitted with
the project files. Consultants must discuss their use of “Primary Search Paths” and
“Configuration Variables” for referencing with their assigned “Technical Support Contact”.

Broken reference paths are CADD Standard violations even if the references are not important.
Unimportant-Temporary-Junk references and raster attachments should be deleted when final
plans are completed. Consultants and District users should do this before the electronic files are
submitted.

Reference Transparency

Reference Transparency settings for the following sections and reference files are an option to be
used at the designer’s discretion. In sections 40, 55, 60, and 80 the reference files Topog.dgn
and RW_Bndry.dgn can be referenced with a transparency setting of 50%. These optional
setting can help clarify dense urban drawing. Using transparency will lighten up some reference
files, allowing other files to have more of an emphases.

Note, The NDDOT is using transparency as interpreted by Adobe which doesn’t require the
rasterized option. In order to print with transparency with only MicroStation, the rasterized
option needs to be used.
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Live Nesting

“Pointer Files” are used in an optional work flows. They are not required for plan production,
but are encouraged because they can simplify revisions in drawings that use nested referencing.
The following is an overview of “Live Nesting” referencing and “Pointer Files”.

A nested reference file is a reference file that is referenced by way of at least one other reference
file. If file “A” is referenced by file “B”, and then file “C” references file “B” with a nested
depth of 1, then file “A” would be a nested reference file when viewed in file “C”.

“Pointer Files” are drawings that should have nothing drawn directly in them. They consist of
only references to other files. These files are used to manage reference files for sheet drawings in
the plans. Each section of the plans could have its own pointer file (“Pointer_" and Section
Number); Pointer_040.dgn, Pointer_055.dgn, Pointer_060.dgn, Pointer_070.dgn,
Pointer_075.dgn, Pointer_076.dgn, Pointer_077.dgn, Pointer_080.dgn, Pointer_082.dgn,
Pointer_090.dgn, Pointer_100.dgn, Pointer_110.dgn, Pointer_120.dgn, Pointer_130.dgn,
Pointer_140.dgn.

The Pointer file controls which reference files and level will be displayed in your sheet drawings.
The Pointer file can be used to turn on and off levels in multiple drawings. They can also be
used to attach or detach reference files in multiple drawings. The Pointer file makes it easier to
consistently adjust what is displayed in your plan sheet drawings. Multiple sheet drawings can
reference the Pointer files and reference adjustments including level display can be made in one
place.

Level display settings can be changed for the active file, a reference file and a nested reference
file. MicroStation has “Display Overrides” for “nested” reference files. The “Display
Overrides” are not applicable to regular reference files. This is an important difference between
reference files and nested reference files. Whenever you reference a “Pointer” file, “Live
Nesting” should be set, Display Overrides should be set to “Never” and the Nesting Depth is
usually set to “1”.

Sy m— i
Tools  Settings
‘ ‘?j}_ -—ﬁé |:| ’@ {@ :, rbj '*J I'j; —'" :3 gEE‘ @ }‘j Hilte Mode:  Boundaries 'l

Slot | ¥ | 3 | File Name - Maodel Description Logical Qrientation Presentation |[= ] o | &

Test3.dgn Default Global Origin aligne... Coincident - World Wireframe

BT G » <« o7 2

Mew Level Display: Config Variable ¥| Georsferenced: o |

When you reference files into the Pointer file, Live Nesting is not typically used because the
Pointer file is usually referenced by others with nesting depth of 1. If the Pointer file is
referenced with a Nesting Depth of 2 or more then the Live Nesting and Display Override
options within the Pointer file are also important. The Nesting Option outcomes become more
complicated as the Nesting Depth increases.
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3.13 Printing Rasters (Pictures)

Oct 2008

Embedding pictures within a MicroStation drawing is discouraged. Don’t cut and paste pictures
into MicroStation. Pictures should be attached to drawings using Raster Manager. Pictures
attached with raster manager are easier to adjust then embedded pictures.

Printing color pictures in grayscale is easier to do with raster manager than with embedded
pictures. Color Pictures should be printed as grayscale when creating black and white plan sets.

The raster settings for printing with just MicroStation can be found in the “Print” dialog box
under “Settings>Raster Options.

] Print (NDDOT_pdf.plt) I =] | Print - Raster Options
File Configuration | Settings PenTable G |
- Genera

Iy 2=  Units 3
£ E | 4 :
‘j Q‘; l_.l Update from View
r General Settings — . \ ) -

| Wi Raster Options ~ Raster Color

View: Wiew 1 S - - _

o & < Print raster in grayscale
Color: True Color  Preferences

Pentable: DATE_NAME.TBL [~ Print monochrome raster as-s

- Printer and Paper Size ————————————— e Brightress: |0 -100 [4] | 100
%YMI Q . P Frr=ar ID 100 Iil [ 100
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r Raster Quality

Landscape 'l Create plot file Vl Ml E e "
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Sige: [11.000 | [7.12¢4 . |-}] Maimize Rotation: None __ ¥|
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3.14 Annotation Scale

Sept 2010

The NDDOT CADD standards use annotation scale. Annotation scale (for placement) should
typically be left on all the time. Annotation scale affects more than just annotation. Annotation
scale affects the scale for line styles, cells, text, and dimensions. The CADD standards also use
annotation scale indirectly, through macros (VBA), to adjust hatching and patterning.

XM and V8i standards are not directly compatible. Basic standards like level, color, weight and
style are consistent but scale factors will be different. The tools for symbology in XM (Select
Settings and Task Navigation) are different then the tools in VV8i (Task Navigation Only). Like
the CADD standards, the tools are not directly compatible with the different versions.

x

Annotation Scale is part of the Drawing Scale. The Drawing scale

also contains the working units settings and Annotation Scale Lock
. . Custom -

toggle. The Annotation Scale can be selected from the main - .

MicroStation menu under “Settings>Drawing Scale”. QA 1" =100 ;}

MicroStation drawing elements that directly use annotation scale will ¢ IEUSTOM s ﬁ'

automatically change scale when the Annotation scale is changed. =T =
One drawing model can use only one Annotation scale at a time. Example, you can’t correctly
draw two different scaled typical sections in one drawing. The annotation scale for one of the
typical sections will be off.

There are a lot of settings related to annotations scale. Most of these settings are AUTOMATED
in the standard NDDOT tools.

Annotation Scale for Line Styles

e This is a model property. XM Standards use a global line style scale that is set to 1. V8i
Standards use “Annotation Scale for Line Styles”.
e This property has been changed in the V8i seed files.
e The V8i standard resource file (dotlst.rsc) uses a property named “physical” to indicate
which line styles should not be adjusted by annotation scale such as “24 inch RCP”,
e The custom Line Style scale factor is still used in V8i.
0 Annotation Scale and line style scale factors are different properties.
0 Line styles that should not be scaled will use a factor of 1.
o Line styles that should be scaled, dependent on annotation scale, will use a factor
of 0.0041666 (1/240).
o0 Line Style Scale Factor is it used in conjunction with annotation scale. What you
see is the product of the two different factors (annotation scale x line style scale).
o0 Task Navigation tools will automatically adjust the line style scale factors as
needed.
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Annotation Scale for Cells

e Annotation Scale for Cells consists of two properties; model and placement.

e The V8i version of Element Info calls these properties “Annotation Purpose” (model) and
“Is Annotation” (placement).

e Both of these properties need to be on if the cell is to be directly adjusted by annotation
scale.

e The cell property “Annotation Purpose” (model) is set by CADD standards. User will
not adjust this setting.

e The cell property “Is Annotation” (placement) can be toggle on or off during placement.
Users could change is setting but typically shouldn’t. NDDOT standard task navigation
automates this setting.

Annotation Scale for Text (Text Styles)

Text Styles are used in V8i to help implement annotation scale for text. The actual paper scale
values are use for text height and width. You are probably familiar with the values in units of
inch. The actual values will be in master units — feet. The style “text 0.07” will display a text
height and width of 0.0058 feet. For this standard the text height and width shown in the tool
settings will not change. But the actual drawing text height and width will be a product of the
text style values x the annotation scale. At an annotation scale of 1” = 40’, the actual drawing
height, not the value shown in the tool settings, will be 2.8 Feet (0.07 x 40 =2.8 = 2.784 =
0.0058 x 12 x 40).

Annotation Scale for Dimension Styles

V8i Dimension settings are dependent on text height values. The NDDOT Dimension Styles
have been set up using text styles.

Annotation Scale for Hatching and Patterning

Hatching and Patterning do not directly use annotation scale. The NDDOT standard tools read
the annotation scale that is presently active and it adjust the Hatching and Patterning settings
according to this scale. However subsequent changes to the annotation scale will not change the
hatching and patterning settings. If the annotation scale is changed after hatching or patterning is
placed, this hatching — patterning will have to manually be edited to the correct scale or replaced.
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Annotation Scale and Referencing

In the references dialog box the “Use Active Annotation Scale” toggle can make the reference
file use the active model’s annotation scale.

[Ei References (1 of 1 unique, 1 displayed) ;Iglil
Tools  Settings
- ) £ D00 2 gn D 39 Q) 0 thelose: Bundaes ~|
Siot | ¥ | 3 | File Name Model

design.dgn Default

Description Logical

Orientation Presentation | (= 1| o | & | L5

Global Origin aligne... Coincident - World Wireframe

o o .

Scale [1.000000 : [1.000000 Rotation [00°00°00" Offset X [0.000000
Elax @ 2 < @ .7 = No Nesting
-

Georeferenced: Mo

¥ | 0.000000
vI Allow Overides Vl Depth: |'| Mew Level Display: Config Variable vI
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GEOPAK

4.1 GEOPAK User Preference

Oct 2008

The following is a brief discussion on the “working directory” and “job directory” as set in the
GEOPAK Users Preferences. The “working directory” is the location of the directory in which
the working and support files are located. This directory can be set three different ways.

1. GEOPAK User Preference -Empty Default
2. GEOPAK User Preference -Defined Location
3. Project Manager

All users should be aware that there are three ways to set your working directory.
1. GEOPAK User Preference - Empty Default Method.

Many GEOPAK functions work properly without setting the “working directory”
preference. If this preference is empty, GEOPAK will default to the directory of the
first opened drawing. One disadvantage of this method is it can not be used when
using GEOPAK to clip sheets that reference drawings in different directories; the
working directory must be set to the directory that contains the clipped sheets. See
Method 2 or 3.

2. GEOPAK User Preference - Defined Location Method.

This method is straight forward. Manually set the working directory to the
appropriate location. This location is usually the directory in which your .gpk file
resides.

3. Project Manager.

The working directory along with many other settings can be defined within the
Project Manager. Once project manager is setup, the settings for the particular
project are automatically implemented when project manager is invoked.

The settings in project manager overwrite the GEOPAK User Preferences. Therefore,
using the project manager method to set the working directory, supersedes both
methods 1 and 2, as described above. Note, just invoking project manager can set or
reset the working directory to the project manager settings.
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The GEOPAK user - Cogo preference “job directory” is similar to the “working directory”
preference. The “job directory” preference is used for Cogo files and if not set it will default to
your working directory. Most users can leave this preference empty because they keep their
Cogo files and drawings in the same directory. If the job directory is set, it also must be reset
when switching between projects.

Notes:
e The “project name” field is optional.
e The initials “nd” (North Dakota) should be used for the “operator code” field.
e The “job number” field is required and is usually 001.

e The “subject” field is optional.



CADD Standards

4.2.1 GEOPAK Database (GPK file)

October 2005

The gpk file is the main project related GEOPAK file. It is usually stored in the working
directory. Individual projects may have multiple .gpk files. Multiple .gpk files are often created
and copied to protect the integrity of work. Users should be conscious of all .gpk files used on a
project. Users are often required to copy other .gpk files and use the copied .gpk file as a starting
point.

When users are first involved in a project they should closely examine what information is
presently available in existing .gpk files before creating .gpk files of their own. Users are
encouraged to copy .gpk information, in order to save time.

4.2.2 Cogo (Coordinate Geometry)

July 2007

Cogo is an acronym for Coordinate Geometry. GEOPAK’s Cogo is an application that allows
the operator to define alignments and other elements within a data base (gpk file). This data base
is the backbone of a GEOPAK project.
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Elements stored in GEOPAK should follow the numbering convention shown below. The
GEOPAK POINT NUMBERING SYSTEM should be followed even if multiple *.gpk files are
created for a single project.

GEOPAK NUMBERING SYSTEM
Numbers Information at the Point Typical User
1-100 Existing Alignment Survey - Photo
100-5999 Existing Primary\Other Control Survey - Photo
100-5999 Existing Earth Survey - Photo
100-5999 Existing Public Land Survey System (Section Survey - Photo

Data)
100-5999 Existing Photo Panels Survey - Photo
100-5999 Existing | Topog Survey - Photo
100-5999 Existing Utility Survey - Photo
6000-7999 Property Lines and Right of Way ROW
8000-8999 Proposed | Alignment - Office Location Design
9000-9999 Proposed | Topog Info (curb returns, sidewalk Design

control points, etc)
10000-10999 | Proposed | Utilities-Drainage Design
11000-11999 Bridge Bridge
12000-13999 Testing and Sample Locations Materials and Research
14000-14999 Construction - Change Order - As- District

builts
15000-19999 Reserved for CADD Standards

Development
20000-30000 | Existing Survey Data Overflow Survey - Photo

Curve names should include a prefix “C” and use the same number as the PI point number.
Example; the name for curve with a P1 at point number 11, should be “C11”. Spirals should also
be named in a similar fashion with an additional suffix. The entry spiral should have a suffix “A”
and the exit spiral should have a suffix “B”. Example: a SCS with its combination P1 at point
number 11 would be made up of a spiral named C11A, a curve named C11, and spiral named
CliB.
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Alignments

Alignments stored in GEOPAK should follow the naming convention shown below. All

alignments require a standard prefix.

Standard GEOPAK Alignment Prefixes

Alignment Prefix
Type of Alignment Horizontal | Existing Proposed
Vertical Vertical
Survey Center Line SCL EXS PRS
Existing Alignment — Alignment previously Defined EX EXE PRE
in another set of plans — older plans
Proposed Alignment — New Alignment Defined PR EXP PRP

The prefix is based on the type of chain — alignment being stored. The rest of the name (body of
the name) should be based on the street-roadway name and/or location. The body of the name
should consistently be used in the horizontal alignment, existing vertical alignment, and

proposed vertical alignment.

The following is a list of example Names:

Example Names for Alignments

Alignment Name

Type of Alignment Horizontal | Existing Proposed
Vertical Vertical

Survey Center Line for US Highway 85 SCL85 EXS85 PRS85
Existing Alignment for US Highway 85 EX85 EXE85 PRE85
Proposed Alignment for US Highway 85 PR85 EXP85 PRP85
Existing Alignment for the North West Loop Ramp | EXIONWL | EXELIONWL | EXP1ONWL
for 10" Street
Proposed Alignment for the North West Loop Ramp | PRIONWL | EXP1IONWL | PRP1IONWL
for 10" Street
Existing Alignment for Interstate 94 Westbound EX94WB | EXE94WB | PRE94WB
Proposed Alignment for Interstate 94 Westbound PR9AWB | EXP94WB | PRP94WB
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Note, some of the alignments/profiles in the above examples might not be applicable or typical.
You probably would not need to design a profile for EXPLONWL if you were going to have a
profile for PRPIONWL. The combinations of example names were listed to show the naming
pattern.

Cogo input files, journals, and output files have not been standardized, but users are strongly
encouraged to develop and save these files in a manner which can easily be reviewed.

Parcels

A parcel is stored in GEOPAK using points, curves, spiral curves, or chains that were previously
stored. Points can be stored from electronic field book data, graphical data from intersecting
lines or traverse courses drawn into MicroStation. An owner’s name and address can be stored
with each parcel by invoking Coordinate Geometry and by keying in “Own Parcel” followed by
the parcel name and the owner’s name and address.

=10 x|

|:[. : = i 1+234—@/@%
@ ﬁ ¥ Bedefine | Pemmanent Visualization "”EIFF [Feature] :I Browsze ILI_I

[

COGO Key-in | Own Parcel 1-3 W apiti LLLPN 235 East Highland Acres FoadlBismarck, D 58503 El

| =

The Design and Computation Manager can read the information of the parcels and prints it into a
dgn file along with the parcel boundary.
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4.3  Project Manager

October 2005

Project Manager is a coordination tool, organizing both GEOPAK functions and project
information. Project Manager incorporates most GEOPAK road functions. Some road tools are
only found in Project Manager (example: “Port Viewer” is only found in Project Manager).
Project Manager can be used to set and store many project settings. It also provides dialog boxes
that help create input files.

Notes:

e Projects should be created and maintained within each separate project’s working
directory. Example, The Survey and Photogrammetry section should set up one Project
Manager and the Design section should set another Project Manager, separate Project
Managers for the same project.

e The use of Project Manager will create sub-directories and files under the working
directory.

e Project Manager Users Names should not be shared. Problems may occur if users try to
share the same user name at the same time. Users should use their own name (email
name) when working in project manager, but they should share the same "Operator
Code". The initials "nd" (North Dakota) should be used for the "operator code" field.
The "Name™" field should be your email name (example: jcollado). The "Full Name" field
should simply be your full name.
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4.4  Design and Computation Manager
October 2008

GEOPAK:’s Design and Computation Manager (D&C Manager) is used to draw features into a
MicroStation design file using preset attributes and a designated GPK file. The D&C Manager is
similar to the MicroStation Settings Manager, in that it can be used to draw a feature into a
drawing and it will set the attributes of that specific feature to the current NDDOT Drafting
Standards.

There are 2 standard Design and Computation Manager databases; NDDOT.ddb and NDDOT
Payltems.ddb. The default database for the D&C Manager should be NDDOT.ddb. If itisn’t
your default, see Section 2.5 of this manual. The following outlines describe the general
hierarchies of the database.

1. NDDOT.ddb
a. Drafting Standards

I. Alignments
1. Horizontal
2. Profiles

ii. Cross Sections and Typicals Sections
ii. Pavement Details
iv. Right of Way and Easements
b. Applications - 3 Port Criteria — Special GEOPAK programs-scripts

2. NDDOT Payltems.ddb - Features that can be used in calculations of costs
a. SECTION - Section Number Divisions by hundreds
I. SPEC - Specification Number
1. UNIT - Pay Unit Measurement

The DC Manager has several advantages over the MicroStation Settings Manager; The DC
Manager draws Cogo features quickly, performs many quantity calculations and has advanced
highlighting capabilities. The disadvantage is that the DC Manager does not contain all the
standard features.

Note the scale factors in the DC Manager “Design ~ Element Connectivity
Settings” needs to be adjusted for some cells and custom Masimum Gap Tolerance - (78000
line styles to be drawn correctly. The line style scale Deduction Telerance : [ 50000
factor is equal to the plot scale / 20.

— Cusztom Line Style Creation

Note, hatching and patterning symbology used in D&C R

Manager pay items don’t automatically adjust for scale.
Settings such as hatch spacing will need to be adjusted
manually.

— Cell Creation

Flot Scale: | 200,000/ Creation Scale
W Influence Graphic Cell Level Symbology
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The majority of the NDDOT pay items are in the D&C Manager (over 4000 items included).
Some pay items units are difficult to visualize in a drawing like “Lump Sum” and “Hours”.
These types of pay items are not included in the D&C manager. Most of the pay items don’t
have unique symbology.

Notes for Drawing Profiles
The NDDOT D&C Manager’s Profiles were created with specific exaggerations (ratios of the

horizontal scale to the vertical scale). If you don’t use these scales your curve table data may
need to be manually adjusted.

Horizontal | Vertical | Exaggeration | Strip Grades
Scale Scale

40 5 8 20°

60 10 6 20’

80 10 8 50’

100 10 10 50’

200 20 10 100°

The vertical curve tables have been set up to display the VVPI station, elevation, stopping sight
distance (SSD), k, and Length. Most of this information will display by default. However, user
will need to manually turn on SSD and K. See the diagram below.

£ Plan ¢ =10
Operation
{ Profiles | 40PROT 40 Scale Profile {
Turn on these settings selectProfe
g TEST [V %P Labels From Pl _|
TESTP Circle |
N ¥ Horizontal fxiz Labels

v ertical Axis Labels

[ W.C. Incremental Elevations
¥ % C. Parameters

¥ Grade Labels '+ and ™ |
IV K value

[" Estemal Length

[~ Station Equation Mo Gaps I

[~ WPCAPT Label

Don’t forget to set the correct “label scale” ¥ Stopping Sight Distance

based on the final drawing scale. Examples; 40
scale profiles can only be draw when the label Label Seale [100
scale is set to 40, and 200 scale profiles can

only be draw when the label scale is set to 200.

Notes for Drawing Horizontal Alignments

The horizontal alignment items have been setup for specific label scales. “Small — 80 scale and
less” D&C manager alignments can be used for 40, 60 and 80 scale drawings. “Large — 100
scale and greater” D&C manager alignments can be used 100, 200 and 400 scale drawings.
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4.5 Digital Terrain Model (DTM)

June 2012

The Triangulated Irregular Network (TIN) files are the basis for creating cross-sections and
vertical profiles. TINs are normally created in GEOPAK, using the "Applications”, "GEOPAK
Road", "DTM tools" box. From here a user extracts graphical information from a dgn file.

The type of graphical data extracted determines the name of the TIN file. The primary sources
for graphical data are: Field Surveys, Aerial Stereo Compilation and Aerial Automatic Elevation
data. The title "DTM" refers to data collected using field survey and aerial stereo compilation
methods. The title of "ISAE" refers to data collected using automatic elevation extraction using
aerial imagery. Beyond just the source of the data, files can also be named based on whether or
not bridge data within the graphical data was extracted or not. These files will also include a
description of "Bridge_In" or "Bridge_Out".

ISAE surface data

Photogrammetry uses a suite of ImageStation programs created and distributed by Intergraph.
ImageStation Automatic Elevations (ISAE) is a program designed to use stereo aerial image
pairs to automatically create a grid of points in a variety of configurations. The grid size can be
constant or variable. The default grid size is based on the Height Above Ground (HAG).
Generally speaking a low level flight at 1500' HAG will have a default grid size of 4'. A variable
grid of 1, 2, 4, 8 and 16' may also be used within the same surface. The less the elevations
change from point to point, the larger the grid space becomes. This tends to minimize the size of
the file while providing a more accurate representation of the ground.

ISAE generates elevation points from the stereo imagery. The program does not necessarily
differentiate between a gravel pile and a house. The program will create elevation points on top
of both features. This is also true for large trees and thick vegetation. That being said, ISAE
does have several options available to choose from when creating surface data. For example, if
the area being generated is extremely flat and uniform, with very few quick elevation changes
then the software can be set to minimize collecting data on top of features and stays on the
ground more consistently.

ISAE surfaces can be generated from Controlled and Non Controlled aerial surveys. The major
difference between the two is the basic plane that is extracted. Controlled project have points
that anchor it to the ground. This creates a surface that is based off of the ground. Non
Controlled surveys do not have any points tying them to the ground this makes it possible for the
surface to be based off of a plane that may be 20’ different than the actual ground elevation. The
non controlled data may have an absolute shift to it but in general the relative accuracy is similar
to a controlled survey.
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The most basic format of an ISAE generated surface is a MicroStation DGN file. A DGN file
will be created for every pair of stereo photos (models) that are included. These individual
DGNs for each model are reference together to create the entire surface. Within the DGNs are
points (MicroStation Zero-length line elements) created by ISAE. ISAE will have 3 types of
points. These points can be defined as points with: High confidence\redundancy, Medium
confidence\redundancy and Low confidence\redundancy. These points are placed on levels
"ISAE Confidence High Point Exst " color 6, "ISAE Confidence Medium Point Exst" color 7
and " ISAE Confidence Low Point Exst " color 10 respectively.

The confidence level of ISAE is based on the initial settings used by the operator. The most
basic of the ISAE settings are Flat\Hilly\Mountainous and a high smoothing weight. If you take
a patch of thick brush as an example with a setting of Flat and High smoothing, the area would
either be completely flattened or possibly the surface would go over the top of the brush. In
either case the ground surrounding the brush would be on "Level 06" with high
confidence\redundancy. The area immediately surrounding the brush and the brush area itself
would be on levels 7 and 10 with medium and low confidence. Using the same example with the
setting of Mountainous and a low smoothing weight then more likely than not, ISAE would go
right over the top of the brush with High to medium confidence. In other words just because a
point is on a lower confidence level does not mean it is accurate or inaccurate. The interpolation
of the ISAE surface by the end user requires the use of the accompanying aerial mosaic that will
be available for every surface made.

ISAE DTM surface data

ISAE_DTM files contain a hybrid of manually digitized stereo compilation data and ISAE
surface points. There are many variations of this hybrid data but generally it is used to extend
the limited coverage of the stereo compilation data with quickly generated ISAE data. A few
examples of these ISAE_DTM files are:

e DTM data from R\W line to R\W line and a 500' ISAE surface outside the R\W

e DTM data covering only the road surfaces with ISAE data for everything else out to the
R\W.

e Typical DTM data for the entire project corridor with a 1000' ISAE surface at the
beginning of the project.

The ISAE data included in the ISAE_DTM files can have different levels of editing completed.
Some of the edits to the ISAE data that may be completed are:

e Limiting the extents of the included ISAE data (generally completed to conserve space)

e Removal of major anomalies (trees, buildings, trucks, etc.)

¢ Removal of minor anomalies (brush, vegetation, random object, processing ambiguities,
etc.)

The user should consult the AAreadme file for the project (or the project editor) to determine the
level of editing completed for the ISAE portion of the data in the ISAE_DTM files.
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4.6  Survey Manager Database (SMD)

Dec 2010

The SMD file is used in the translation of data from survey data collectors to MicroStation
Design files using GEOPAK Survey.

To begin the translation of data, the operator invokes the “Preferences” from
Applications>GEOPAK SURVEY>Project>Preferences. Within the Preferences dialog box
navigate to the Visualization tab. The SMD Feature File path should be set to
s\STANDARD\V8I\GEOPAK\SURVEY\NDDOT.SMD. The “Apply Feature Best Match”
toggle should be turned on and the “Plot Scale” should be set to "1" for all projects. The scale of
graphical data will be determined by the Annotation Scale set in the DGN.

Once the data is visualized the key-in "ANNOTATATIONSCALE ADD™ must be issued
for the graphic to assume the scale set for the DGN.

The .SMD files are protected files and cannot be edited. If any operators have a need for
additional items to be added into the .SMD they should contact a support person.

The feature codes, used by field personnel to enter data into their data collectors, are listed in
Appendix 1.

Linking Codes

The linking codes need to be set in the Preferences dialog box. They can be found under
the Dataset tab in the Linking Codes item. They should be set as follows:

Begin Line: =+
End Line: =|-
Close Figure: =11
Beg/End Curve: =/
PC Curve: =| XPC
PT Curve: = | XPT
Curve Fit: = | XCF
PCC Curve: =| XCC
Continuation: = | XCN
Left Right: = | XLR
Front Back: = | XFB
Up Down: = | XUD
Duplicate Prefix: = | XDU
Comment Char: =|*

The linking codes that are prefixed with an “X” are not intended to be used, however they do
need to be set to eliminate conflicts with the EFB codes. Note: The Continuation linking code
may be grayed out. You will have to set the definition of this code once you create a dataset in
the XYZ to Coordinates dialog box.
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4.7 Cross Sections and Earthwork
Dec 2013

Corridor modeling (roadway designer) is the preferred tool for generating surface models.
Corridor modeling should be used because the proposed surfaces created from roadway designer
are better suited for Automatic Machine Guidance (AMG) projects. Specific surface tolerances
can be prescribed and a 3d review of the model and surface can easily be done.

Corridor modeling shall be used for proposed cross sections and surface modeling unless one of
these conditions is met.

e Projects that were substantially completed with Geopak criteria by July 22, 2013, do not
need to be converted to corridor modeling. Consultants that have started a project with
Geopak criteria files, but are not substantially complete, should discuss how to proceed
with their NDDOT technical support contact.

e Projects that do not have an existing surface file (dtm, tin, xml) available through typical
survey practices can be completed with Geopak criteria. Roadway Designer tools require
a DTM. Geopak criteria files only require cross sections. Some NDDOT surveys only
provide cross sections directly from raw data. With these surveys, a surface is not
created. If cross sections were directly surveyed as linear — transverse shots or cross
sections were developed from old plans, an existing surface file might not be created.
Sliver grading projects are examples of earthwork projects that usually don’t use surface
files. Creating cross sections from criteria may be easier in these circumstances and will
be allowed.

Request for additional exceptions to use criteria will be considered. This new standard is not
intended to increase project development costs or time. This standard is intended to provide
opportunities to use AMG on future projects. Consultants can request exceptions through their
NDDOT technical support contact to the NDDOT CADD Support Specialist (Jon Collado).
Internal (NDDOT) staff can request exceptions through Jon Collado. Request should indicate
specific projects, present status of proposed cross section modeling, and reasons why Geopak
criteria is desired for project.

Note a combination of Roadway Designer and Geopak Criteria can be used in some
circumstances. Geopak Criteria can supplement the cross sections, but should not be used in
any part of the proposed surface modeling.

. Criteria for labeling is allowed.

. Criteria for utilities is allowed.

. Criteria for existing surfaces and As-builts is allowed.
Note.

The NDDOT spec book discusses benching for embankment (see 203.02.F). This construction
benching requirement shall not be shown on cross sections and the earthwork involved with the
embankment benching shall be incidental to excavation and borrow.
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4.7.1 Cross Sections Interval (Pattern Line Spacing)
July 2013

Cross sections should accurately represent a roadway. Cross Sections that are closer together
(shorter interval) may represent the roadway better than cross sections at a longer interval
because important details between the cross sections are more likely to be missed with a longer
interval.

The following standards are for plan preparation. These standards are not necessarily a
construction field staking requirement.

Recommended Minimums

e Rural projects should use an interval of 100" and 50 within super elevated curves and
spirals.

e Urban (curb and gutter) projects should use an interval of 25’.

e Extra cross sections should be added for all centerline pipe.

e Extra cross sections should be added at all super elevation key stations such as; end
normal crown, begin super, begin full super, end full super, end super, and begin normal
crown.

e Extra cross sections should be added for wetland areas. The interval of cross sections
through a wetland should be between 10’ and 50°. If the wetland cross section is
generally uniform in shape such as a linear ditch wetland, a long interval can be used. If
the wetland doesn’t have a uniform linear shape a shorter interval should be used to show
changes in in-slope, width and depth. If there is onsite wetland mitigation or a wetland is
to be moved, the cross sections need to show enough detail and use a short enough
interval to properly construct the wetlands. Designers should also consider providing
additional drawings in the plans if these changed wetlands have an irregular shape.

Note, the Draw Pattern Lines tool has an option (i ers—"ry=—" HEE

to draw at “Super-elevation Transitions”. Job: [011_| Q. Chain: [OLWB v I Select>
Pattern lines need to be drawn in the shape — ==
. . . . Left Offset(+): [ 500 Left Offset(+): 500
drawing in order to use this option. Station: [ 0+00.00 @ Station: [ 834-37.15 o
Right Offset+): [ 500 Fight Offset(+): | 500

Other additional “Optional” cross sections have ¥
been considered in the CADD standards. The Level Symbology: | —
base intervals prescribed above are close

together and address these “Optional” cross sections to a degree. These “optional”” cross sections
are used at the designer’s discretion.

H Superelevatinn Transtior v [] Skew Angle

Optional (extra cross sections)
e Intersections, approaches and driveways
e Inlets, ADA ramps, building entrances
e Horizontal roadway breaks such as begin taper, end taper, begin lane, end lane, PC’s,
PT’s, curve returns and others.
e Vertical curve breaks such as PVC’s and PVT’s.
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These optional cross sections could help produce better surfaces for Automated Machine
Guidance.

Limited Cross Sections

Cross sections are sometimes created without a DTM. They are created from non-triangulated
survey data or old plans. In these cases, meeting the required cross section interval may be
difficult. In these cases, designers use cross section data that is available. Caution shall be used
when interpolating data over long distances.
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4.7.2 Roadway Designer

Nov 2011

This manual will not discuss Roadway Designer and “Corridor Modeling” in detail. It will only
discuss how the standards pertain to these tools.

Roadway Designer File Overview

Two files (NDDOT.itl and NDDOT.xin) are delivered with the CADD standards. The” itl” file is
an Inroads Template Library. Templates are cross sections or pieces of cross sections. The ‘xin”
file contains drafting standards and some of the roadway designer preferences. The NDDOT.itl
file should be copied to your project folder. This file will be edited for your project. The
NDDOT.xin file usually doesn’t need to be copied to your project folder. This file is usually
only referenced.

As a Roadway Designer project is developed, the following files should be created: (project).ird,
rd_*.dgn, and rd_Plan_Graphics_*.dgn.

The “ird” is the main roadway designer file. This will contain project specific model
information.

The drawing rd_*.dgn is a 3d project model. Roadway designer features, components and
surfaces should be drawn into a 3d drawing with a “rd_" prefix. Multiple “rd_" files may be
desired. Descriptive suffixes for these files are strongly encouraged.

Plan view graphics are usually required to develop a roadway Designer Model. The Corridor
Modeling tool imports plan view information from only one drawing. The drawing
“rd_Plan_Graphics_*.dgn” is used to perform this import. Needed graphics are referenced and
copied into this drawing.
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Template Library

The NDDOT template library contains the following main folders”
Components (No End Conditions)

End Conditions

Labeling

Project Specific

Templates

Training

SourwNdE

Copy the templates to be used for your template drops into the “Project Specific” folder. Project
templates are typically customized. This folder will help manage edits.

The right side of the road is used as the default for individual roadway components and
templates.

Use the underscore () to delineate affixes. Hyphens(-) can be used to tie phrases together, but
spaces are also acceptable.

Parametric Constraints (Template Variables)

Parametric Constraints such as Inslopel R will have to be manually edited to Inslopel L if
mirrored.

Default variables values should be used in the library. This makes editing and building templates
easier. See Appendix R

Parametric constraints are rounded to the accuracy set in the Geopak user preferences. Four
decimal places are used in the template library for consistency purposes (example, 4” = 0.3333’,
4” is not equal to 0.33)

Widths on the right side are typically positive values. Widths on the left side are typically
negative values. Thickness are typically negative values because parent because they are
referenced in a downward direction.

Parametric Variables are case sensitive. Parametric Variables should be title case.
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Point Names

Standard point names aid with point styles, template transitions, point controls, labeling and
alternate surfaces. The Names also provide a partial description. The names have up to 5 parts.
The standard point name is the combinations of the parts:

Layer Description

Horizontal Description

Repetitive Affix (count)

Parent Component Name (Optional-use to avoid duplicate names)
Right or Left Side Affix

arwDE

There are 3 common layer descriptions:
T (Top - Finished Grade),
B1 (Top of Base 1),
DG (Dirt Grade)

If there are multiple base (alternate surfaces) then use B2 (Top of Base 2), B3 (Top of Base 3),
etc.

Some points don’t belong to a surface. These points still have a layer description.
DNC (Do Not Construct — This is a marking point)
Find (This point is usually part of an end condition looking for a style.)

The “Horizontal Location” describes common horizontal markers. If one of the following points
doesn’t adequately describe a point this part of the name is optional and the Repetitive Affix
(count) is used.

CL (Center Line)

EOL (Edge of Lane)

Shidr (Shoulder)

EOSP (Edge of Slough Pavement)

EOSB (Edge of Slough Base)

Gutter

FOC (Face of Curb)

BOC (Back of Curb)

Tie (Tie Between Finished and Existing Grade)

Bnch-Front (Bench Front)

Bnch-Back (Bench Back)

Ditch
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The number —repetitive affix or count part of the name is used to keep the name unique. If the

name would be unique without the count part of the name, this part of the name is unnecessary
and should be omitted. Points are typically number away from center line (bigger number used
when it is further from center line).

Repetitive affixes that are automatically assigned, should be renumbered (example: xx_L,
xx1_L, xx2_L should be renumbered xx_1 L, xx_2 L, xx_3_L).

The component part of the name is used for points in different end conditions within the same
template. Again, if the name would be unique without the component part of the name, this part
of the name is unnecessary and should be omitted.

The last part of the name is the right or left affix. This affix can be automatically included in the

name by the Roadway Designer tools. It is often used to keep the point names unique when a
component is mirrored.

Super Elevation and In-slope Relationships

Super elevation and inslope rates are project variables that indirectly affect dirt grade widths.
Consistent relationships between these slope rates help facilitate template transitions and the
comparison of alternates. The development of the NDDOT template library uses the following
philosophies:

1. The top edge of dirt grade offsets will be variable through a supper elevated curve.
These offsets will be controlled by slope rates.

2. The edge of the roadway dirt grade will be determined by projecting a point from the

top edge of pavement (top of sluff) to the bottom of base line at the in-slope rate for

both concrete and asphalt templates. Topsoil will be projected up for both asphalt

and concrete templates.

The templates will address safety edges and traversable stuffs.

4. Topsoil extensions that are parallel to the roadway pavement are desirable. Topsoil
should tie to the top of asphalt slough pavement.

w
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Tips
Make regular backup copies of your itl and ird as your project progress.

The template interval must be reviewed and adjusted throughout project development. The
interval must account for the cross sections cut with Geopak. The template interval must account
for short components. All components must start with a template and end with a template.
Components reflected with just one template will not be drawn correctly when cut into cross
sections with GEOPAK. Example; if there is only one template (drop) for a driveway, it may
appear in Roadway Designer but it won’t appear in the cross sections cut with Geopak.

Limits of construction lines must be drawn as line and not line segments. Geopak Earthwork
may not recognize a 2 point (smart) line segment.

Template priority conflicts can occur without warnings if the same priority is nested in a
different end conduction of the same branch.
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4.7.3 Criteria Files and Related Input Files.

July 2007

Criteria files are tools used for creating cross sections, calculating earthwork and generating
reports. This is a major function of GEOPAK. This manual will not discuss criteria or
earthwork in detail. It will only discuss how the standards pertain to criteria files.

All criteria files shall be included with the projects so that cross sections could be re-run. Hand
editing should be avoided whenever feasible. Copy the standard criteria directory into the
project directory every time a new project is started or use the typical generator. Certain criteria
files may have to be edited. Also, the standard criteria files are edited from time to time.
Creating - copying project criteria files will avoid multiple user complications. See Section 2.4
for the location of earthwork related files.

Revisions to criteria and the typical generator can be requested through the Standards
Committee. If a user has a new criteria idea, they should discuss or submit the criteria file to the
Standards Committee. New criteria ideas might be used to improve the standard criteria library.
Following is the standard criteria requirements.

1. Standard criteria files should have a unique purpose. Redundancy is discouraged.

2. All standard criteria shall be documented. A labeled drawing shall be included in the
standards. Standard criteria shall include a header. The criteria header shall include
the following information; criteria name, author, revision date, description, inclusion
sequence information, and list of variables. Criteria points and variables shall be
cataloged in a spreadsheet. Appendix J contains a data base of criteria points and
variables.

3. Criteria points and variable names shall be approved by the Standards Committee.
Criteria points and variable names shall follow the following format. Criteria points
shall be labeled for report generation. Points should have two labels; point number
(level = “Xsec Point Number Labels Text”) and another label that would be useful
in a segregated report (level =”Xsec Point Description Labels Text”). Example; a
segregated report for just “Topsoil Bottom” points might be desired, so all topsoil
bottom points should have a unique label like “TSB”. Note all labels need to be in
capital letters in order to be recognized by GEOPAK. Test points do not need to be
labeled. Generic text should be on level “Xsec General Text”.

The following information contains recommendations and notes for using criteria. Some of this
information is not contained in the GEOPAK Manuals.

When using super elevation shapes to create cross sections, first process the proposed
cross sections without using criteria files - no side slope conditions. This should only
draw the roadway super elevation surfaces into the cross sections. Then check and
correct any shape and input errors. Reprocess until there is a run without errors. After
processing an error free run, reprocess with the criteria. Separating the proposed cross
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section process into smaller incremental steps should help users identify problems.

The standard.x criteria file defines how all GEOPAK cross section elements are located
and then drawn. All standard criteria symbology should be located in this file. The
standard.x criteria file may look for elements that do not exist in your drawings. This
should not be a problem as long as the drawing file, in which the criteria is to search,
exists. The log file will comment “element not found” and continue.
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4.7.4 Slope Stake Reports

July 2007

All cross sections should have important points labeled in a manner such that blue top- slope
staking reports can be generated.

Designers are responsible for creating a working cross section file in which a GEOPAK Blue
top-slope stake report can be generated. At a minimum, a slope staking report showing the break
points and tie points to the top of the topsoil shall be developed and provided to the field
engineer. See Design Memo No. 01-2005. Reports for the bottom of topsoil and the bottom of
base (top of dirt grade) should also be provided. However, the cross sections should be drawn so
other base layer surfaces can be reported if the District or Design chooses to generate these

reports at a later date. Presently the preferred x|
file format for the’:se reports is _ Comma _ Job [0 S —
Separated Values” (CSV). This type of file Chain [F190— [3] Report Decimal 3 |
can be opened with Excel and it is much easier BegSta  11+75.00R 1 L

to edit. ErdSta  31+25.00R 1 [1E+50.00F 1

— Existing Ground Line

Level |5 Color | 0-253 Selact |

‘weight [ 015 Shle |07

~ Propoged Finish Grade

Level |7.31.3540,  Color [1181081¢ . |

‘wieight | 1-2 Shle [0

Blue [ Span  Eattom "'I

~  Red
\ Yellow | ¥ Pause on Each 5
I ;:ge hairi |E><I2E| :I Separatar I_
c:AB0029065.0654DESIGM vslopes! File |

Apply |
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4.7.5 Earthwork

April 2013

Earthwork shapes must be saved with the cross sections. The earthwork shapes can be used to
check earthwork calculations.

Earthwork end areas should be written to 3 decimals if a Mass Diagram is used. The Mass
Diagram uses these end areas to recalculate mass ordinates (MO). The MO in the mass diagram
may be slightly different than the MO in the earth log.

A Mass Diagram shall be included in the plans for all rural grading and widening projects.

Detailed earthwork summaries (include station by station volumes) shall be include in the plans
whenever Geopak earthwork calculations from cross section are used. This summary shall be
under section number 11 in the plans (typically after the mass diagram).

The detailed earthwork summary shall include the following fields — columns:
Station

Excavation End Area

Fill End Area

Other End Areas that Affect the Mass Ordinate *

Excavation Volume

Fill Volume

Other Volumes that Affect the Mass Ordinate *

Mass Ordinate

LN~ wWNE

* There may be materials other than suitable grading — soil on the project that affect the
mass ordinate and should be listed in separate columns. For example, a grading project
may contain a grade raise with a different volume adjustment factor for embankment
placed in the water than embankment place outside the water. Most undercut materials
such as aggregate base and paving shall be excluded from the mass ordinate.

Use the earthwork “Sheet Quantity” e — =10

options to create this summary. This Bie
tool will make an ASCI file which
can be reformatted and included in
the plans. Only end area and
volumes used for pay items should be
included. “Informational only

%5 DM File ¥ ‘write Sheet Quantities Fils

Seil Types ASCI File: [ ML_earth Q
Earthwark Shapes

Dutput Farmat P Decimal Places 1 'l Tatal Quantity Length 10 '|
Add/Subtract Yolume - = - -
Centraid Adjustment Colunr Soil Type E arthwark, Operation Quantity Type +-

Skip Areas

Comman Exc End drea

Sail Subsoil Exc End Area

1
& es Quanity 1 Soi SubgradeExc  EndArea i
quantities” such as for pavement and 2l HI End Aves :
base should not be included in this 4 o CommonExc  AdustedVolmes  + ]
table. 1| i | Common Exe_ ¥ | End Area | + |

sdd | Delete | Modify |
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There are many different ways to reformat the “Sheet Quantity” text file. Ultimately, the data
must be stored in a pdf, formatted for NDDOT sheet boarders — title blocks, and it must remain
extractable for use by contractors. The table shall not be stored as images within the pdf. The
numbers from table cannot be extracted as values if they are stored as an image. The ability to
electronically cut data from the table and pasted it into other programs as “values” must be
maintained.

The following is an example workflow for processing the “Sheet Quantity” text file.

1. Import the “Sheet Quantity” text file into Excel.

2. Use the “Text Import Wizard” or “Text to Columns Tool” to parse your data into
columns.

3. Provide Headings and additional formatting as necessary such as cell borders and
bolding.

4. The next step is formatting the data with a sheet border. The sheet border format is

presently stored in 2 formats; a MicroStation cell and Microsoft Word document.
This example is going to use Microsoft Word because this application automates
column rapping past the PE Stamp and onto additional pages. Create a new word
document using the “Blank Template for Plan Sheets” found in the Plan Preparation
Guide. See http://www.ugpti.org/dotsc/prepguide/plansheets/templates.php.

5. Select and copy the formatted data from Excel and paste it into your Word document.
6. Within WOI’d, set “Page LaVOUt Insert Page Layout References Mailings
> Columns”. Using multiple . -
P By 3 b=, Breaks =
columns helps minimize the =) [j E
number of sheets needed and Marains Orientati . 1 Line Numbers ~
dargins Crientation Size
uses the paper space more - - - be~ Hyphenation -
efficiently. Page Setup
1. Use the macro built into the document to print (o -

to a PDF.

Choose which format to print.

Print Hard Print DIP
Copy Copy
Help



http://www.ugpti.org/dotsc/prepguide/plansheets/templates.php
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Tips
Look for material layer complications. These may have to be manually corrected.

The line below the earthwork centroid will determine the earthwork material

If the centroid is here, the matenal type will be set by the "Asph B Line".
This line symbology may need to be edited

If the centroid is here, the material type will be set by the "Aggr B Line".

This line symbology may need o be edited —— /
Ts Line //‘ = Asph B Line

If the centraid is here, the matarial type will be set by the "Ts Battorn Lina®, Aggr B Line

Ts Botiom Line
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4.7.6 DTMs (Digital Terrain Models) for AMG (Automated Machine

Guidance)
March 2014

DTMs for proposed surfaces shall be created for most earthwork projects. Three surfaces are
usually provided for AMG: Dirt Grade (DG), top of Base (B1), and the top surface (T). Projects
designed with Roadway Designer (Corridor Modeling) shall provide surfaces with the following

chord height tolerances.

Minor Rehabilitation *,
Structural Improvement

Major Rehabilitation,
New/Reconstruction

Horizontal Chord Height 0.1ft 0.1ft
Tolerance

Vertical Chord Height 0.1ft 0.05 ft
Tolerance

* AMG surfaces for sliver grading projects are not required.

All curves that are modeled within a DTM are actually a series of chords drawn along the curve.

Curve geometry is better
represented with shorter and
more chords. Chord height is the
distance between a cord and the
arc it subtends (middle
ordinated). Chords with smaller
chord heights are closer to the
arc by definition. Tolerance for
horizontal and vertical chord
heights can be set with in the
Corridor Modeling Tools.

o
Corridor Modeling - R:\project\10031012.017\Design\ND 31.rdp = &=
Fle Tools
i 41 A
seo: (001 Q| o [Pl 22 A
B Preferences Preferences
B8 DTM
3 Geometry _
3 Plan Graphics Station Lock: |Even =
B ALG Viewer Slope Readout: W‘
Horizontal Chord Height: | 0.100000
Vertical Chord Height: | 0.050000
Template Library: | R:\project'.10031 01201 T4Design ' NDDOT.itl Q.
DTM Files Path: Q.
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4.7.7 AMG (Automated Machine Guidance) Deliverables

May 2016

The following is an example list of file to provide for AMG.

*Existing.tin AAReadMe.docx
"‘Existing.dtmI jobOObl.gpk |
*Existing.xm cmjob001.alg
*T.tin Alignment.xml
*T.dtm Control.dgn
*T.xml Design.dgn
*Bl.tin DS_Align.dgn
*Bl.dtm Profile.dgn
*Bl.xml RW_Bndry.dgn
*DG.tininc Topog.dgn
*DG.dtm XSEC.dgn
*DG.xml RDM.dgn

Supplemental Design Data-zz.PDF

T = top of all finished surface
B1 = top of base 1 surface
DG = top of dirt grade surface including fore slopes, ditch and back slopes

Within the AMG workflow, designers are responsible for more than just DTM surfaces.
Additional Deliverables are required;

Supplemental Design Data Notification SDDN
Alignment information

AMG AAreadme file for contractor

Drawings

ApwnhE

Supplemental Design Data (SDD)

1. Create a pdf file to notify contractors of the availability of SDD. The SDDN should
be copied from;
http://www.dot.nd.gov/manuals/design/caddmanual/Supplemental Design Data.docx.
This is a Microsoft Word Document.

2. The SDDN page should be edited with the appropriate project number. The body of
this document should not be edited or appended. The SDD disclaimer is now part of
the NDDOT Standards Specifications Manual.



http://www.dot.nd.gov/manuals/design/caddmanual/Supplemental%20Design%20Data.docx
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3. Only a partial path to the SDD (ftp://ftp.state.nd.us/Supplemental_Bid_Information/)
shall be included in the advertisement page. Projects sometimes change bid openings
and job numbers. A partial path may minimize the need to edit the advertisement in
the future. The edited advertisement should be saved as a pdf and named
“Supplemental Design Data-zz.pdf”. The *“-zz” suffix is required for an automated
web post. This document will be posted with the eplans used for bidding purposes.

Alignment Information

Projects created with Geopak and Corridor Modeling typically store alignment information in
both gpk and alg formats. Both of these files should be included with the supplemental design
data.

Procedure for Creating Alignment file in XML

1. Open Geopak Coordinate Geometry
2. Select File > Export > LandXML 1.2 Geometry

el
| Fle Edt Eement View Tools
Preferences L WL o ik o A aE JE ote 2 a)
KRS RO R D - AL
Pt FIe LY b ctagtion v [[OFF Featurs) | v| Browse | s9123¢  w|swenzr  v| «<| <[ > |

Input File Restore

. Database Lltilities

E|

: Impaort 4
IETED s
Edt SDMS Points
SDMS AMlignments

LandXML 1.2 Geometry

Alignments and Profiles




CADD Standards

The Export LandXML 1.2 dialog should open. Make the appropriate dialog
selections.
M, Export LandXML 1.2 =10 x|

Project Name: | U585

Description;, | Fortuna Project|

LandXML File: |test xml Q,
Output Mode:  Create Al
English Unit: _Intemational F vI Profile A|

Blement Type: Chains | |PRODITCHRT

[~ Export All Chains EESE_STRSSTNE

Chain: IUSRE vI dt§ US85_MB_EXST
p E:q:mrt PI"UﬁlE{S:l VPLSER
Export |
a. Most of the settings are intuitive. However there is one setting that is not

commonly understood. The English Unit must be set to “International
Foot”. The NDDOT always uses “International Feet”.

b. Project Name and Description fields can be provided as desired. These
fields are optional.

C. The Output Mode > Create or Append lets your create a file from scratch
or append an existing file

d. The Element Type options let you pick the type of cogo element to export;

points or chains.

Select Export and the xml file should be written to your working directory.
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AMG AAreadme file for Contractor.

An informational text file shall be provided to the contractor. An Alignment Index (informational
key — general description) shall be included. The aareadme file should also describe general
limitations with the model (examples; driveways were not modeled, the terrain near bridge XYZ
was not modeled, approaches were modeled without the appropriate in-slopes — use plan
information to build approaches, etc). Include the following phrase.
“This aareadme file does not list all limitations with the model. It is only provided as a
place to start your review. The contractor is responsible for reviewing model information
and determining if and where it may be applicable.”

Drawings Provided to Contractor

The following drawings should be provided to the contractor if available. These drawings do

not need to be created if they are not needed for plan preparation.

Control

Design

DS_Align

Profile

RW_Bndry

Topog

XSEC

RDM

a. Corridor Modeling Style Features (break lines representing template points) shall
be drawn in 3d.

b. Corridor Modeling Components (surfaces and meshes) shall be drawn in 3d.

N~ WNE
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4.8 Cross Section Sheet Library

Dec 2010

The NDDOT standard cross section sheet library (XSSL) is “NDDOT.xssl”. For NDDOT users,
GEOPAK should default to this library when the “Cross Section Sheet Composition” tool is
invoked. This tool can be found in the “Cross Sections” tool tray or from the pull down menu
(Application>GEOPAK Road>Cross Section> Cross Section Sheet Composition). If the
NDDOT.xssl is not your default XSSL, see Section 2.5.

Users may need to save minor layout changes to the XSSL, such as the display of earthwork
quantities on the cross section sheets. The XSSL in the standards directory is “write” protected.
If changes to the XSSL are required, the file (NDDOT.xssl) should be copied to the project
directory so that changes can be saved. Then the XSSL in the project directory should be used
for creating cross section layout sheets.

There are several sub-dialog boxes within the “Cross Section Sheet Composition” dialog box.
Most users only need to edit information in the “XS DGN File”, “Sheet DGN File” and the
“Earthwork Quantity Labels” sub-dialog boxes. See the GEOPAK Manual if additional help is
needed.

Most users will use the “Active Cross Section Sheet” layout of “XS 20 scale or Less” witha 1 to
1 grid. However, other layouts are available from the pull down field.

The XSSL is used in conjunction with the cross section sheet cells found in the NDDOT sheets
library (sheets.cel). The library uses a scalable cross section sheet and references the working
cross sections into your cross section sheet layout drawing.

The drawing scale of your cross sections layout drawing needs to be set to “Full Size 1=1" and
settings need to be saved before you cut cross sections.

. |E:E-... _||:||5|
The final plot scale for the cell Fie
?he.eds to bel Sei I_n GtEtOF;-%K In Active Cross Section Sheet: [S A 20 Scale or Less x| Layout Sheets |
IS example It IS set to
(111:101) p %5 DGN File - r Sheet Dimensions
' Shest DGN Fils Width: [15.50 Height: [10.00

Sheet Dimensions / Cell

After your sheets are cut, set your
drawing scale to the correct scale.
In this example 1”=10".

If you don’t incorporate these
steps your sheet cell might be the
wrong scale and your tags may be
placed in the wrong spot.

XS Search Criteria
Sheet Stack Orientation
Sheet Stack Columns
Margins and Spacing
Station Labels

(Offset Labels

¥ Place Sheet Cel
Library: |sheets.csl Q

[ Place as Shared Cell

Scale: I 10.00

~ Sheet Uffsel Trom Cell Origin
K Offset: ID.DD Y Offset: ID.DD +i

~ Sheet Cell Placement
Place Sheet Cellin XS Sheet File -|
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On large projects, hundreds of cross sections may be referenced into one drawing. Users may
find it is easier to manage these drawings if they draw only one sheet per drawing model. This
option is found in the “Sheet DGN File” sub-dialog box.
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4.9 Plan Sheet Library

May 2016

The GEOPAK Plan and Profile sheet layout tool is used to automate the creation of plan and
profile sheets. In this process, many new drawings are created that can contain a number of
referenced drawings. These newly created drawings are formatted to present information in
traditional, manageable sized sheets.

The table below lists the sheet layouts that are presently available. If additional types of layouts
are needed, please contact a Standards Committee Representative.

SHEET NAME CELL NAME
Double Plan Sheet 1 Plan-Planl
Double Plan Sheet 2 Plan-Plan2
Plan and Profile Sheets1 PP10
Plan and Profile Sheets?2 PP10S60
Plan and Profile Sheets3 PP10S80
Plan and Profile Sheets4 PP12
PLAN A (Margins; Lt.=0 Rt.=0.0 Top=0.5 Bottom=1.5) PLAN
PLAN B (Margins; Lt.=0 Rt.=0.0 Top=0.5 Bottom=2.5) PLAN
PLAN C (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=0.0) PLAN
PLAN D (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=1.5) PLAN
PLAN E (Margins; Lt.=0 Rt.=4.5 Top=0.0 Bottom=2.5) PLAN
PLAN F (Margins; Lt.=0 Rt.=4.5 Top=0.5 Bottom=2.5) PLAN
PLAN T (Margins; Lt.=1 Rt.=1.0 Top=0.5 Bottom=1.5) PLAN
PLAN MAX (No Margins) PLAN
ROWPLAT RWPLAT

All the different sheet layouts, such as cross section sheets, right of way plats and plan and
profile sheets, are designed to be placed as cells. Some sheet cells can be plotted at different
scales, others are designed to be plotted at only one scale.

Sheet cell origins are located in the lower left corner, at the intersection of the bottom and left
borders. A list of available sheets is included in Appendix H.

Most sheets laid out with the NDDOT standards are designed with an overlap. The total overlap
is the sum of the beginning and ending overlap. Two different sheet compositions are used
within the CADD Standard Plan Sheet Library. The CADD Standards only use 2 out of the 4
“sheet composition” methods.
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For Plan and Profiles Sheets, you should use the sheet composition method of “By Station
Range: Inside Out”. For all other sheets, you should use the sheet composition method of “By

BeginStation\Overlap™.

“By Station Range: Inside Out” Example:

A user wants to layout plan and profile sheets at a
horizontal scale of 100. The user would select
“Plan & Profile Sheets1” from the
“NDDOTSheet.psl” and set the scale to 100. The
primary coverage (Station Range) is set to 1000 ft.
However, this does not include the overlap. The
actual plan drawing area will be noted in the Sheet
Composition dialog box, in this case, 1100" x 512.5'
(see dialog box shown). The primary horizontal
coverage is 1000' and the actual coverage is 1100".
In this case the horizontal clip is actually an
additional clip outward of 50" on both sides
(50+1000+50=1100). Users are expected to realize
from these numbers that the overlap is 100" (1100'-
1000'=100"). This overlap is split equally between
the beginning overlap and ending overlap, in this
case 50" and 50’ respectively. See diagram below.
The user must start the sheet layout process at an
even station if they want their sheets to line up with
the grid lines.

_{o x|

Clip Vertical

r~ Clip

By Station Ranage: Inside Out "|

Station Range: | 1000.00

Maximum Drawing Area: | 1100.00x 512,50

Horizortal: | 50.00 ierica: [N

Active Drawing Area: |vanable 1100.00x 512,50

The following table summarizes composition settings for plan and profile sheets. These sheets

use the “By Station Range: Inside Out” method.

Scale | Clip Horizontal | Clip Vertical Drawing shown
40 20 0 400
60 30 0 600
80 40 0 800
100 50 0 1000
200 100 0 2000
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“By BeginStation\Overlap” Example:

A user wants to layout plan sheets at a horizontal scale of 100 with 1000 feet of coverage,
starting at station 10+00. In this case, the user would select Plan C from the plan sheet library.
Note that Plan C settings will provide no margins between the clip area and the sheet border cell
for the top, bottom and left edges. However, a 4.5 inch margin will be provided between the clip
area and the sheet border for the right edge. This 4.5 inch margin area is often used for

quantities.

As discussed earlier, most of the sheets are designed
for an overlap. In this example, the actual length of
plan view is 1050’ long. The actual plan drawing
area will be noted in the “Active Drawing Area”
(1050.00 x 1000.00). Users are expected to realize
from this number that there is 50° overlap. The
primary horizontal coverage is 1000' (1050" actual
coverage — 50’ overlap = 1000’ primary coverage).

The overlap is split equally between the beginning
overlap and ending overlap, in this case 25' on the
left and 25' on the right. The user must start the
sheet layout process, half the total overlap distance,
before the desired station. In this case, the starting
station would be 9+75.

~ Clip

CLIF

ORIZONTAL, L.

CLIF YERTICAL

By BeginStation/OverLap Vl

td axirnurm Drawing Area:  1050.00 = 1000.00

Horizontal: 0.0 Wertical: I 0.00
Drrawing Showr: I 1080.00

Active Drawing Area:  1050.00 = 1000.00

DOwerlap: ! A0.00 Fired Digtance "i
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Masking Elements and Priorities

Microstation shape elements with an opaque color matching the back ground color (number 255)
are being used as masking elements within many sheet cells. These masking items are being

used to hide referenced elements that might overlap a title block. These elements are being used
with Microstation “priority” attributes. Reference elements with a lower priority are covered up

and hidden by the masking element.

There are a few things to remember when using these masking elements. First, masking
elements are on their own level (Mask Lv Priority 100). The level can be turn off if you don’t

want to use the masking elements.

Second, the “Fill” view attribute must be turned on.

Third, the reference update sequence may need to be
changed if a 3D drawing is referenced. This step isn’t
needed if all references are 2D. Note, most “Topog”
drawings are 3D.

If a 3D drawing is referenced, all of the cut sheets —
sheet drawings will need to be edited. With the sheet
drawing active, open the reference dialog box and
select “Settings > Update Sequence”. Move the active
sheet drawing to the end of the update sequence list. Be
sure to save settings after the update.

[ ¥iew Attributes - ¥iew 1

View Number: 1+ |Gl G

m Presentation

Display Style: I Meraframe Digplaw)

I ACS Triad E‘l—'ﬂ_|. |

4 Backaround H Grid
1 Boundary Display Qj Level Overrides
Camera Line Styles
N om =1 ... .
Update Sequence

zhvg\l

- I g
Sl—otlm‘l‘ﬂwe to End of Sequence lodel—lL_oF
1 E sisting_R oauwrayogm wefault Eui

2 pattern_linez.dan Defaul pat

3 profile.dgn Defaul pro

4 Motif_Teszt.dgn Defaul Mo
5 E xizting_F oadway.dgn Defaul E=i
E pattern_lines.dgn Default pat

7 profile.dgn Diefault pro

8 Mohf_Testdan Diefault Mo
075w/ _1.dan Default e

| | i

Defaut | ok |

Cancel |

Fourth, if the sheets are being created from a drawing that used an older level priority definition
for sheet lines, this level priority definition will need to be updated. Do this before cutting sheets
if possible. If done after, all cut sheets will need to be edited.

Within Level Manager, =lo)]
select the “sht L‘!nes level. = o 53] v ol <1] D5 it~ oA -
Then SeIeCt the update Bl D?EWLJUpdate levels From library |2 |IE ‘l__-g_?a |I=~; |IUSEE| Tll% |
H (1] wigting_Foadwa I !

levels from _I|_brary button. g =g 5 PR

rofile.dan ' Desc [Det) w Leader text 0 0 0 . 100
LEVGL_CIEfI T]Itlons not ;D; ::S[ ;g_r:_cﬂ Mask Lv Priority 100 W 255 0 0 « 100

. N sht Lines Ho 1] 0 .
matc Ing t e present. . E:ﬁz;g_li:z:‘;‘: ! sh Stamp Text 2 0 1 . 100
CADD Standard definition prliedan. 1.2 § sht Stamp Text Preliminary 51 0 1 « 100
will be marked with the e | T 04 0 o - 100
modified attribute as #L0 Fiters
shown. T — 2l

[Active Level: Default [8 of 1855 displaved; 1 selected;
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Most users will not need to change priority setting. The following is a summary of NDDOT

standard priority attributes. Display priority is determined by a combination of element, level
and reference priorities. Reference priorities are a 1000 times that of level priorities and level
priorities are a 1000 times that of element priorities.

Display priority = (1,000,000 x reference priority) + (1000 x level priority) + element priority.

Most CADD standards don’t use reference and element priorities. Most CADD standards have a
level priority of 100 (display priority 100,000) or less. Many sheet cells have display priorities
greater than 100,000. The following are some of the sheet display priorities. Bigger display
priorities display on top of smaller display priorities.

Items Level Priority Element Priority Display Priority
Masking Element 100 10 100,010
Sheet Lines 100 20 100,020
Sheet Text 100 30 100,030

Additional Notes
Make sure to set the drawing scale to the desired sheet scale before cutting sheets.

When using a Double Plan sheet, the length of the “Drawing Shown” in the Sheet Composition
is only for the top view (port). The actual coverage on the sheet is greater (+ 11 x plotting scale)
than what is listed in this dialog because there are to views.

The “Double Plan Sheet 2” (Plan-Plan2) and “Plan and Profile Sheets4” (PP12) sheets are not
intended to be used in situations where quantities need to be summarized on the sheets.

When sheets are clipped, you are given an option to “Rotate Reference” or “Rotate View”.
Users should always “Rotate View”. If you “Rotate Reference”, your coordinate system will
not be aligned with your drawing and the profile elevation axis within plan and profile sheets
will not be aligned.

The use of a “Motif” files provide several benefits. Motif files can provide a consistent template
of reference files including level display. The Motif file can control what is referenced and what
is displayed. If you are using motif files and creating similar cut sheets several times during plan
preparation, you don’t have to be concerned with what files are referenced to your main
drawings, what is displayed and when settings are changed. These settings are independently
controlled by the motif file. The motif file can also eliminate unnecessary references. Example,
in a plan and profile sheet, references of design.dgn are seldom needed in the profile and tabular
data views. Separate motif files, using different sets of reference files, can be used for each
view.
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“Motif Files” are often used with “Pointer Files” in order to simplify future referencing
adjustments. See previous section 3.12 for “Pointer File”. The Motif File should reference the
Pointer file with “Live Nesting” and the Display Override set to “Never”.

Having cross sections referenced to drawings used to clip plan or plan and profile sheets may
slow down the sheet creation process. Detach unnecessary reference files before clipping sheets.
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4.10 Super Elevation

July 2012

The NDDOT uses a table based on table 3-9 of “A Policy on Geometric Design of Highways and
Streets”, 2011 to calculate super elevation. The 6% e max table is used for most highway
designs. Intermediate values for every tenth of a percent have been interpolated into this table.

Super elevation runoff and tangent runout are based on a “desired relative gradient”. The
“desired relative gradient” is 83.3% of the “maximum relative gradient” as shown on table 3-15
of “A Policy on Geometric Design of Highways and Streets”, 2011. This “desired relative
gradient” results in runoff and runout lengths that are 120 % of the minimum lengths (120 % =1
/ 83.3%)

For non-spiral curve combinations, 1/3 of the runoff is placed on the curve and 2/3 of the runoff
is placed on the tangent. For spiral curve combinations, all of the super elevation runoff is
usually placed on the spiral. Often, the super elevation runoff used in spiral curve combinations
is changed to match the spiral length. Tangent runout should be directly proportional to runoff.
On very long spirals, the tangent runout can be placed on the spiral if the maximum relative
gradient is not exceeded.

Geopak Super Elevation Settings

Default NDDOT GEOPAK preferences have been set up for NDDOT users. The standard
configuration file (standard.cfg) uses the NDDOT Super Elevation Preferences (NDDOT.sep).
See Section 2.5 (Configuration Settings, Preference Settings, and User Interface).

The NDDOT uses “Adjustment Factors” for increasing the runoff and runout length when
multiple lanes are rotated (as shown on table 3-16 of “A Policy on Geometric Design of
Highways and Streets”, 2011). Note, the “Adjustment Factors” are disabled (set to 1) in the
default NDDOT.sep. The “Adjustment Factors” are disabled in order to simplify the modeling —
shaping of shoulders. The majority of NDDOT roadways are modeled with 4 shapes within a
shape cluster (shoulder shape + driving lane shape + driving lane shape + shoulder shape). The
Shoulder widths should not affect the runoff and runout lengths. If a multiple lane facility is
being designed, the NDDOT.sep should be edited with correct “Adjustment Factors” for rotating
multiple lanes.

Note. If designers need to edit the super elevation preference file (NDDOT.sep), it should be
copied, renamed and stored in the project directory.
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Roadway Designer Super Elevation Settings

Custom NDDOT tables for the Roadway Designer Super Elevation Wizard have been created.

They can be found in the following directory:

S\STANDARD\V8I\GEOPAK\SUPERELEVATION\NDDOT_Super_Tables

These tables are based on tables 3-9 and 3-170f “A Policy on Geometric Design of Highways
and Streets”, 2011. The NDDOT has modified these tables. Super elevations have been
interpolated for every tenth of a percent. Runoff values have been adjusted using the NDDOT

Desired Relative Gradient discussed previously.

The “% Runoff on Tangent” field doesn’t display
decimals in the percentage. However decimals are
stored and used by the program. The value “2/3”

will work in this field.

The “Runoff Length Multiplication Factor” should
be set to 1 for the two lane or four lane options.
The runoff lengths have already been adjusted in
the NDDOT tables. However there aren’t preset
options for a 3 or 5 lane roadway where the crown
is in the middle of the lane (rotating 1.5 or 2.5
lanes respectively). When rotating 1.5, 2.5, 3 or
3.5 lanes, the “Runoff Length Multiplication
Factor” should be set according to table 3-16 of “A
Policy on Geometric Design of Highways and
Streets”, 2011 and the “Number of Lanes” option
should be set to “Two”.

Table wizard -ioix]
Comidor: test Help
—General Superelevation Data

Table: IH:"-.Applic:ation_Data"-.Mic:rDStation"-super"-.ND_DE_?S.sup J
% Runoff on Tangent ET% ™ Interpolate Table Values

™ Specify Runout: |j 0000 Transition Lengths Are:

™ Non-Linear Curve Length: l— % Runoff " Total Transition

1

Selected Curves

: Load Values From Table | ™ Update Geometry from Table

< Back | Nedt > | F‘references...l Close |

The tables have been modified to account for rounding and interpolating. The “Interpolate Table
Values” option should not affect NDDOT calculations. It won’t make a difference if it is enabled
or disabled. The NDDOT tables have been designed to use super elevations values to the tenth

of a percent.
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Simple Curve Example

Given
Pl =1409+95.59
PC = 1403+11.54
PT = 1416+73.20
Delta =13d 37m Os left
R =5729.58
\Y/ =75 mph
Solution

e = 3.8 % interpolated from 6 % max table
(Preferences are set to use “Radius Interpolation” as “Conservative Entry”)
(5560° = 3.8 %, 5745* = 3.7 %, 5729.58” => 3.8 %)

Maximum Relative Gradient (MRG) = 0.38 %
Desired Relative Gradient (DRG) = MRG * 83.3 % = 0.317 %

Runoff on high side (Inroads) = 144.0° from table ND_06_75.sup
Runoff on high side (Geopak) = e * width of traffic lane / DRG
Runoff on high side =3.8 % * 12’ / 0.317 % = 143.84° => 144’
(Preferences have been set to round runoff to the even foot.)

Runoff on low side is proportional to runoff on high side.
Runoff on low side = (e - normal crown) / e * Runoff on high side
Runoff on low side = (3.8 -2.1) / 3.8 * 144.0° = 64.42’

Runout is proportional to runoff on high side.
Runout = normal crown / e * Runoff on high side
Runout = 2.1 % /3.8 % * 144.0’ = 79.58’

Begin e on right side (high side) = PC — 2/3 * Runoff — Runout = sta 1401+35.96
Begin full e = PC + 1/3 * Runoff = sta 1403+59.54

End full e = PT - 1/3 * Runoff = sta 1416+25.20

End e on right side (high side) = PT + 2/3 * Runoff + Runout = sta 1418+48.78

Begin e on left side (low side) = Begin full e - (Runoff on low side) = sta 1402+95.12
End e on left side (low side) = End full e + (Runoff on low side) = sta 1416+89.62
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4.11 Legal Description Editor (Right of Way Plats)

Oct 2008

The “Legal Description Editor” is a GEOPAK tool used to create right of way legal descriptions.
The Legal Description Library (NDDOT.ldb) is customized to conform to the standard NDDOT
legal description format (Chapter 20 Right Of Way Plats; Procedures For Creating Right Of Way
Plats). The general statements that are common to all descriptions are stored in the GEOPAK
library. The Editor receives information unique to certain parcels from the GPK file, key-in, or
lists provided in dialog boxes. Legal descriptions and parcel data are typed one time and stored
in GEOPAK.

The Legal Description Editor can be used once the parcel is stored. Points, curves, and parcels
must be stored in GEOPAK before using the Legal Description Editor. The Legal Description
Editor is found in GEOPAK Road or GEOPAK Site under “\Geometry\Legal Description”.
When selected, a dialog box with a menu will appear. The menu bar allows the user to choose a
File, Edit the current file, Insert items into a legal description, select the desired Library, define
Global Settings, or obtain a closure report on the parcel description.

Go into Library to select the NDDOT.Idb library and hit OK. Select “Insert” on the menu bar
then select “Text Phrase” from the pull down menu and the dialog box shown below appears.

Eil=e Edit Inzert Library Settings Closure

[ = l:_m: - 5‘ RefChain: [SECTION [=] B
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Text Folder

Following are steps and explanations concerning the items in the text folder. Select “Insert”,
then “Text Phrase” folder. A dialog box appears with a list of Text Phrases to insert. Double
click on “Text”. This folder contains phrases for parts of the description dealing with text
statements only.

Eil= Ei rt Library -Eettlngs Qiosure m}/ |
O=ld 4 3

3

0 CenterlineStrip
| = Parceltum
= Preamble
l = Adioining
2 Conveyed

B Described
= Closing

N e .

Parcel Number

The first item required to create the NDDOT legal description, is the parcel number. In the text
folder, select “ParcelNum” and hit the “Insert” button on the bottom of the dialog box. The
“library editor” will automatically print the phrase “Parcel Number,” centered over the
description on the first line. A dialog box then appears. At the top of the box is a statement
identifying the information needed to complete the first line of the description. In this case, it is
the parcel number. Place the cursor in the top window and type in the name of the parcel or open
the pull down. Keyed in information is stored in the temporary memory, while creating a legal
description. This information will appear in the pull down. Choose information from the pull
down, hit the “Add” button, and then hit OK. This will automatically add the parcel number to
the text editor.

Preamble or Caption

The next required entry is the “Preamble or Caption,” from the Text Phrase dialog box, select
“Preamble” and hit insert. The “library editor” will automatically print “A portion of” and a
dialog box appears with “Aliquot part” on the top of the box. This is asking the user to type in
the part of the section or subdivision that the parcel is located in. The library editor will fill in
the general statements in a description and for any data unique to a description, a dialog box will
appear to key-in or select data from a list.
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Centerline Strip folder

The centerline description of a strip of land that is parallel or referenced to a survey centerline
follows the preamble. Below are explanations concerning the items in the “CenterlineStrip”
folder, which is found in “Insert\Text Phrase\CenterlineStrip”.

& Lgal Description Editor

File Edit Inzert Librettings Clozure E'wi x|
~u - e i
Oe=d £ v ¢ ER | ki
B BeginStrip
B Multi_widths
B EndStrip

Inzert I
N ] N

BeginStrip

The editor prints “A strip of land” automatically, and then a dialog box appears for input of the
strip width in feet. The next dialog box has a list of cardinal directions (northerly, westerly,
easterly...) to describe which lines of the parcel are parallel.

Multi Widths

The editor prints “And a strip of land” automatically, and then a dialog box appears for input of
the strip width. The next dialog box has a list of cardinal directions to describe which lines of
the parcel are parallel.

EndStrip

A dialog box appears with a list of cardinal directions to select the description of the line on the
strip that is being described. Another dialog box is available with a list to select strip or strips (if
multiple widths strip). The next dialog box contains a key-in to input the offset distance from the
centerline, to the closest described line. The last dialog box has a list with cardinal directions to
indicate the direction the closest line lies from the survey centerline. The Library Editor will
then automatically complete the caption for the centerline description.

Closing
. . - s Z Insert Fext =]
This statement is required at the end of the g
legal description. Select “Closing” then hit D | .
“Insert”, the editor will type in “The legal b= d Bl
description was prepared by”. A dialog box B Adioining,
will appear and on the top bar are the words B Described

“Insert name” this refers to the name of the
person writing the legal description.

In=ert I
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Body Folder
Following are steps and explanations concerning the items in the Center Line folder. This is
obtained by clicking on the "Line\Curve\Spiral Phrase” from the Insert pull down, a dialog box
with a variety of choices pops up for these items. The first selection is outlined by a box with the
heading “Insert By”. Following is a list of the choices and explanations of the choices:
& Insert Lines/Curves x|

Insert By

Library  Settings  Closure % Elements:
! Chains:

D = id o RN CE — Parcels:

A portion of Lot C of the HE |ige Phraze: E = =778
: . 2 rom Pt l
Meridian, County of Adams. |Bod_l,.l"-.Lir'|eS"-.BDd_'.J u

Commgncing at the HE corner Tangent Curve Phraze: Uil ’ 1uis
==ction 9. on a bearing of 5 [BodycurvesCrT angent =]

Mon-T angent Curve Phraze:
|Bodytcurve MonTanCry  [=]

Spiral Phrasze:

|BodytSpiralshStndSpiral  [=]
Inzert I

Elements
To create the “body of the description” based on existing “Elements,” select,

-~ Element Type
= Line:

0 Curve:

! Spiral:

Line: The user may enter points that were stored in the GPK file to identify a line; for
example enter a stored point number in the “From Pt:” field and the end point of the course in
the “To Pt:” field.

Curve or Spiral: the user may choose from a list of previously stored curves or spirals in the
GPK file.

Chains
The user may choose from a list of stored chains in the GPK file from the pull down.
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Parcels

A pull down is available for the Parcels
stored in the GPK file. The window to the
lower right of the dialog box has a list of
the parcel courses. The library will show
each course as a “point-to-point chain” or
a “point-to-curve” chain. If the points,
chains, and/or curves of the parcel are not
in a clockwise direction, check the box
under the window to invert the courses. It
will invert the parcel features but not the
curves themselves. Select the parcel from
the pull down in the upper right corner,
highlight a course, and select the desired

) Chains:

Inzert By
2 Elements:
= Parcels:

Line Phrasze:
[BodytLinessEody

(=]
Tangent Curve Phrasze:
|BodvhcurvetCrvT angent [=]
Mon-T angent Curve Phraze:
|BodyscurvetCrvT angent [=]
Spiral Phraze:
|BodytSpiralsStndSpiral [~

Parcels: [ELOCK1

Parcel ltems: [kMAIN TRACT

1007 » 1006
1006 > PC:Cds,
T,

PT:C45 » PCIC3A
3

PT:C34 > 1001
1007 > 213

™ lreeert List

Insert I

“Line Phrase:” statement. Hit “Insert” and the library editor will read the selected course from
the GPK file in GEOPAK to print the correct data into the description.

Under the “Insert By” box are Line Phrase, Tangent Curve Phrase, Non-Tangent Curve Phrase,
or Spiral Phrase pull down choices. Explanations for “Phrase” statements follow:

Line Phrases

This pull down contains different statements or line styles, which are listed below with an

example. The bearings and distances are read from the data stored in GEOPAK:

Body\Lines\Body

“Commencing at the SE corner of section 26, thence northerly along the east line of section
26, on a bearing of N 01 deg. 11 min. 24 sec. E and a distance of 424.46 feet.”
This should be the first line used in the body. “Insert By” “Elements” or “Chains” can be
used and the first point should be a Section Corner, Quarter Corner, or some known point.

Body\Lines\ToPOBL.ine

“Thence on a bearing of N 90 deg. 00 min. 00 sec. W and a distance of 422.01 feet to the

point of beginning.”

Body\Lines\StdLine

“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet.”

Body\Lines\BegCrv Line

“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet"

This sentence is the same as “Body\Lines\StdLine” but does not have a period at the end; the
purpose is to lead into a curve statement. The editor reads the line data for the course before
the curve in this part of the statement. The remainder of the statement will require data from
a previously stored curve. If the curve is non-tangent, data for the direction of the radius
(Body\Lines\ToNonTanCrv) on the curve is required. Insert this before the curve data.



CADD Standards

Body\Lines\ToNonTanCrv

“to a point on a non-tangent curve concave (right), northwesterly, the radius point of which
bears N 90 deg. 00 min. 00 sec. W.”

The statement for the non-tangent curve is in three different line statements. Insert the
“Body\Line\BegCrv Line” statement first, this statement reads the non-tangent course data
before the curve. Next insert the “Body\Line\ToNonTanCrv” (the present statement), the
data required for this will read the direction of the radius. A data point must be stored at the
curve center or radius point, then go back to the “Insert By” box and click on “Elements:”
Enter the point number of the PC on the parcel in the “From pt” field and the point number of
the curve center in the “To pt” field. From here click on the “Parcels” in the “Insert By” box
and continue with the curve data in the parcel. The explanation for the third part of the
statement, “Body\curve\NonTanCrv,” is in the curve section.

Body\Lines\ComAtForStrip

“Commencing at the NE corner of section 33, thence westerly along the north line of section
33, which is also the survey centerline of ND 6, on a bearing of N 90 deg. 00 min. 00 sec. W
and a distance of 422.01 feet to the beginning of a 37 foot strip.”

This statement begins the body of a centerline description for a strip of land parallel with the
centerline of a highway. The first dialog box contains a list to select the corner of the
section or quarter section where the description begins. The next dialog box is a key-in for
the section number. Then a dialog box with a list to select the direction traveled. The fourth
dialog box contains a list to select the side of the section traveled on. The next dialog box is
a key-in for the section number. Another is a key-in for highway name. The last is a key-in
for the width of the strip.

Body\Lines\CL Multi Widths
“This point is also the beginning of a 37 foot strip.”
This statement describes a change in widths of a continuous strip.

Body\Lines\End of Strip
“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet to the end of the 37 foot
strip.”

Body\Lines\Alongline

“Thence on a bearing of N 90 deg. 00 min. 00 sec. W along section line a distance of 422.01
feet.”

A dialog box appears with a request to “Insert Reference Line” (a section line, Senior
property line, Riparian boundary, or right-of-way line) that the course is to proceed along.
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Curve Phrases

Body\curve\CrvTangent

“to the beginning of a tangent curve, concave (right) northwesterly having a radius of 899.50
feet. Thence northeasterly along said curve 113.23 feet through a central angle of 07 deg. 12
min. 45 sec. to the end of the curve.”

Insert the “Body\Line\BegCrv Line” before this statement. A dialog box that contains a list
to select the direction of the concavity of the curve will appear. Next a dialog box with a list
to select the direction of travel along the curve will appear. The library editor reads the arc
distance and delta angle of the curve data stored in GEOPAK.

Body\curve\NonTanCrv

“a distance of 1095.07 feet. Thence northwesterly along said curve 1990.55 feet through a
central angle of 104 deg. 08 min. 57 sec.”

Insert the “Body\Lines\BegCrv” Line (reads the data from the non-tangent course, before the
curve) and “Body\Lines\ToNonTanCrv” (reads the data concerning the bearing of the radius)
before this curve statement.

The complete statement for the non-tangent curve should read as follows:

“Thence N 90 deg. 00 min. 00 sec. W a distance of 422.01 feet to a point on a non-tangent
curve concave (right), northerly, the radius point of which bears N 90 deg. 00 min. 00 sec.
W. a distance of 1095.07 feet. Thence northwesterly along said curve 1990.55 feet through a
central angle of 104 deg. 08 min. 57 sec.”

Area Phrase

|
Farcels:
I1-1 =l

Farcel ltems:

Arsa Source:
FParcelz/T akings/E asements I

Area Phrazes:
|Area\.5 trip_drea vI

Irsert I

A dialog box appears with a pull down list of all the parcels stored in GEOPAK. A pull down is
also available for the “Area Source:” this is the fractional areas of a parcel. The parcels must be
stored previously with fractional parts. The next pull down on the same dialog box is “Area
Phrases:” The choices in here are “Area\Strip Area” and “Area\Parcel”. The editor will end this
application with “End of description.” on a separate line.

Area\Strip Area

The Editor will print out “Said strip is shown on the plat as parcel.” a dialog box will appear
to type in the parcel name, hit OK and the Editor reads the GEOPAK area data for this
particular parcel and finishes the area portion of the description.
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Area\Parcel
This selection will print out the phrase “Said parcel” rather than “Said strip”.

Temp Easement

This statement is used if the parcel is temporary construction easement.

“It is a condition of this easement that it shall not be filed for record and that all rights conveyed
to the state of North Dakota and North Dakota Department of Transportation by this instrument
shall terminate upon completion of construction of said project, or in five years from the date of
conveyance, whichever comes first.”

Closing Phrase

This statement is required at the end of the legal description. Select “Closing” then hit “Insert”,
the editor will type in “The legal description was prepared by”. A dialog box will appear and on
the top bar are the words “Insert name” this refers to the name of the person writing the legal
description.

Select “Insert\Text Phrase\Text\Closing” the Editor will print out the following statement
automatically, “The legal description was prepared by”. At this point a dialog box appears to
key-in the name of the person creating the legal description. Hit OK, the Editor will complete
the closing portion of the legal description.

Parcel Owner’s Name Phrase

To create a list of owners’ names and addresses on a project select “Parcel Owner’s Name
Phrase” folder, found in the “Insert” pull down. A dialog box appears, the phrase at the top of
the box says “Insert Owner’s Name Phrase”. A pull down is available to select a parcel. The
owner’s name and address, of the selected parcel, will in the window under “Owner’s Names”.
Hit insert and the phrase “Parcel No.” is printed, then a dialog box appears, with a key-in, to
insert the parcel number. After hitting the “OK” button, the Name and address of the owner will
print out.
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4.12 Survey Alignment Data Sheets

Feb 2009

Survey Alignment Data Sheets (081LO ### SDL.dgn) are plan sheets used to communicate
alignment data and points for topographical features such as curb radii and Manholes. In this
process, electronic text files are created that can be imported into survey equipment and
corresponding paper documents are created. Surveyors should not have to key in this
information. This process involves:

1. Storing the alignments and points into cogo.

2. Drawing and labeling the alignments and points.
3. Creating and placing a coordinate table.

4. Exporting the alignments and points.

This section of the manual will give an overview of the process and highlight a few steps. This
section will not provide comprehensive instructions. For additional comprehensive instructions
for tasks such as storing an alignment see the GEOPAK help files.

1. Storing the alignments and points into cogo.

a. Be careful not to redefine important points. If “Redefinition of Elements” is
on, you will be able to rewrite existing points. If it is off, you will only be
able to create new points. Within Coordinate Geometry, use Navigator to find
point ranges not used. Alignments created by design should use points within
the range 8000-8999. Design topographical points should stay within the
range 9000-9999. See Section 4.2.2.

b. Temporary Cogo Visualization is recommended. Use the D&C Manager for
the final symbology displayed in the plans.

C. Design topographical points should be stored =10
with the cell “ADP”. You can leave the cell Pt ame!
scale blank. You can set the scale later when it ¥ e meeren
is drawn by the D&C Manager. If the “Auto Nating: [TTEBE0SST3TTS_ | pp |
Increment” option is turned on, the “Point e 45051 5515651
1] H H H H r Station;
Name _W|II be incremented after a point is o |—|
stored into cogo. T
¥ Point Cel: [ADP Scale: |
. [T Feature: I
d. A system of point ranges should be developed I Desciption |
for each cut sheet. Try to create points in a Store Point |

logical sequence and leave extra numbers

between point ranges in case revisions or additions are needed. Example:
sheet 1 uses points 9000-9043, sheet 2 uses points 9100-9153, sheet 3 uses
points 9200-9241, the point range 9044-9099 is not used unless revisions to
sheet 1 are required and the point range 9154-9199 is not used unless
revisions to sheet 2 are required.



CADD Standards

Drawing and labeling the alignments and points
Alignment Data Points (used for design topographical features) should be
drawn in DS Align.dgn and referenced into the 080LO ### SDL.dgn sheets.

a.

Alignment Data Points are drawn from the Horizontal Alignment items in the
NDDOT Standard D&C Manager
(S\STANDARD\V8I\GEOPAK\DCMAN\NDDQT.ddb). There are 8
alignment symbologies. Each alignment can be used for a different point
level and point annotation level.

File Edit Settings Favorites

Help

i [m] | gPIan & Profile Draw = o] x|

i id O & @ %

(peration
£ FPaints ) | Alignment 15 Small - 80 zcale ¢

Design

[ Drafting Standards
[~ Alignments
= Harizontal

@ 5\ TANDARD Y B kK ADCMANSNDD O T ddb

= Alignment 1 5
By Alignment 1L
é Alignment 2 5
& Alignment 2 L
& Alignment 3 5
é Alignment 3 L
& Alignment 4 5
& Alignment 4 L
é Alignment 5 5
& Alignment 5 L
& Alignment & 5
é Alignment & L
& Alignment 7 5
& Alignment 7 L
é Alignment 8 5
& Alignment 8 L
& sCL

[ Profiles

21 Existing Proafile

Small - 80 scale and less
Large - 100 zcale and greater
Small - 80 scale and lezs
Large - 100 scale and greater
Small - 20 scale and less
Large - 100 zcale and greater
Small - 80 scale and less
Large - 100 zcale and greater
Small - 80 scale and lezs
Large - 100 scale and greater
Small - 20 scale and less
Large - 100 zcale and greater
Small - 80 scale and less
Large - 100 zcale and greater
Small - 80 scale and lezs
Large - 100 scale and greater
Survey Center Line

[ F.ein Points: | 3000-9100

v Cel

[ Scaled Paint [Circle]
¥ Scaled Point Text |

I Label Scale I 40

=l

C. Set the “Label Scale” before you type in the point range that you want to
draw. The options to draw “Cell” and “Scale Point Text” should be on by
default.

3. Creating and Placing a Coordinate Table
a. There are two main ways of Creating and Placing a Coordinate Table

I. Cogo and a text editor can be used to create the Coordinate Table

ii. Cogo and the “Place Coordinate Table” tool can be used to create the
Coordinate Table. This is the recommended method.



Vi.

Vii.

viii.
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To create a Coordinate Table using Cogo and a text editor:

Open Cogo. From Cogo’s

main pull down menu =101
select Baseline: Imj
“Element>Chain>Layout Point |

offsets”.

Select the “Baseline” for
the stationing and offsets

Set the option to “Point”

Provide a “Point List” Point List: [3000-5100 Bl
[ Elevation

Turn off the “Elevation” [ WeerPairt: [B000

option if elevations are not

stored with points. Turn F Eommie ]

off “Near Point” if
projections are not needed.

Select the Compute button. Cogo will calculate coordinate
information.

Create a cogo output file by selecting “File>File Utility” from cogo’s
pull down menu. Set the option to “Output” and provide an “Output
File” name. Note the GPK number will be appended to the name and
the extension will be “.ond” if ND was used as the operator code.
Example if “yyy” was specified as the “Output file” and the GPK
number was 001 then the output file would be named “yyy001.ond”.

Use a text editor to edit and copy the desired information.

Coordinate Data can be =10l
placed into sheet [z siNoD0T fial »] B 2 O 4 Al [ -

drawings using the “Cut =
Sheets Design.stg”, i
“Annotations” group and
the “Note (07)”
component. Using the
MicroStation “Place
Text” tool, right click in
the “Text Editor” text
entry area. A popup menu should appear. Select “Paste”.

[elete

Select Al

Clear

Format and clean up text as needed and place it into the drawing.
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C. To create a Coordinate Table using Cogo and the “Place Coordinate Table”
tool.
I. Activate Cogo and Select your GPK — Job Number.

ii. The “Place Coordinate |
Table” tool |S |n Project  Dataset  visualizabion  Geometry DTM ’m Tool Boxes
GEOPAK Survey :_loa:a:::o:::b:j:niols
SEIECt “Plans ;ace SMD Eeature
Preparations>Place Place Legend
Coordinate Table” to Place Grid
load the “Place S,
Coordinate Table” Place ScaleBar
tool. A survey project Place Text In Object |
does not need to be set
op. e

iii. The “Place Coordinate Table” should open. Load the NDDOT CADD

Standard symbology settings by selecting “Settings>Open” from the
“Place Coordinate Table” dialog box.

=T The settings fi_Ies are located at _

— C:\Program Files\Bentley\GEOPAK\bin\.
- Tijr!;iiormatH%il:trnn Order utf [~ wiite to Dulp.ut- File : Lreate File 'l Ple the approprlate Sel’tlngS f| Ie

[ P> | | JCACADDR/BIraingDemohoooidis < “nddot040.set” is for 40 scale

I_ Ml‘ﬁ_'": Replace "Moo Elevation' With : W “nddot060.set” |S fOI’ 60 Scale

,_ _EI_EZ?B :— Fieplace "Mo Feature" Witk - W “nddOtOSO.SEt" iS fOI’ 80 Scale

[ Station v | _Uiss GPK Poirt Station valus stored with Point ¥ | “nddot100.set” is for 100 scale

I,: %: Chain to measure Station and Offset from - [ERwT | “nddot_200.s_et" is for 200 S_Cale

— (re—— ] B Voo Tl || These settings files can be copied from

S\STANDARD\V8I\GEOPAK\bin

Select Points for Table or Export -

Pointt | Marth[y] | Easti) |ElevZ]__| Gtation | Offsst | Feature | Desc A

3 1147430  2147440... MNoElev  0+00.00 Off Chain NoFeat Note: the settings files don’t a|Ways set the
4 1147455, 2147475 MoElev  0+4328 88834 MoFeat 24 . .

304 1147452 2147504 MoElev  1+66.20 Dff Chain MoFeat ot  appropriate levels for the coordinate table.
9000 1147491 2147462, NoElev  0+0000 -14.6101 NoFeat e ;

00 1147475.. 2147461, MNoElv  0+0000 05633 Mo Feat Bl This is a know bug with GEOPAK. The
9002 1147452 2147476 MNoElev  0+0000 104133 NoFeat prs levels may have to be corrected manually.
005 1146380..  2143051.. MNoElev  0+00.00 No Feat ~

The text is intended to be place on level
_Bece | T “sht Text 2” and the table lines should be
on level “sht Lines 2”



CADD Standards

The default table is set up for the fields; Point Number,
Northing, Easting, Station, and Offset. If additional fields such
as Elevation are needed, use the “Table Format/Colum Order”
area of the dialog box to enable additional fields.

Set Stationing option to “Compute Station value from Ref.

H 7
Chain”.
i
Settings
- Table_Format.-"Equmn Order ) ™ “white to Output File : Lreate File v|
it Poin:ﬂext -| culit | CHEAD D AT raininoDemnskeoord bt Q
[ Moithfy] ¥ Replace "N Elevation” With : [0.0000
I_ Eastfe - o g I_
I_ Nane = Fieplace "Ma Feature" With : | DEFALLT
I Station % “ (Eomgute Station value from Bef. Chain I vI
| Offset = “
I_ NorS:a = "— Chain to measure Station and Offzet fram : I ER'w/1 j

I_ Mone v"_

I Use Duplicate Filter Tolerance : |D.D‘I (H[i]i[a]

Select Points for Table or Export :

Pointd | Morth[v) | Eastf)

| ElevZ) | Station | Difset | Feature | Desc ;I

3 147480 2
4 1147456 21
204 147452 2
3000 1147431 2
q001 47475 2
9002 147452 2
3005 1146830 21

47440....
47475,
47504,
47462
47461,
47476,
43051....

MoElev  Off Chain Off Chain Mo Feat

MoElev 143353 88334 MoFeat 1
MoElev  Off Chain Off Chain Mo Feat @t
MoElev  1+0313 1461001 MoFeat
MoElev 141676 -0.5699 MoFeat Eh
MoElev  1+41.57 104193 MoFeat Jlsf
MoElev  Off Chain Off Chain Mo Feat -

Place | N

Select the desired points.

Select the “Place” button and place a data point to define the
upper left corner of the table.

4. Exporting the alignments and points

a.

To export points from GEOPAK

Giving field personnel electronic output files of points and alignments is NOT
the correct method of exporting design data into the field. GEOPAK output
files (*.ond) can not be directly imported into survey equipments. GEOPAK
Points and Alignments should be exported to files that can be directly
imported by survey equipment. Points are exported to ASCI files (*.asc).
Alignments and Profiles are exported to “Trimble DC” files (*.dc).

Open cogo for the applicable gpk — job.

From the Cogo dialog box, select “File>Export>ASCII Points”



Vi.

Vii.
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The Export GPK # Export GPK Points to ASCII Coordinate Fil | =1o =]
) r Dutpu_t Format% Output File: File Create vI
POIntS'tO ASQII" IM Poin:ﬂextv I% |E:\EADD\VSTrainingDemo\coords.asc Q
C_Oordlnate File [ Moty | [T Replacs "No Elevation” With: [a.0000
dlalog bOX ShOU'd I_ M_vl I_ Replace "Mao Feature™ With : IW
r___ Elew(= r___

open. Clear all [ Mo w|[

prefixes from the ,':—:EEZ - ;

“Output Format”' I_M I_ ™ Use Duplizate Filker Tolerance : ID.DDDD‘ID

A Com ma ( ) ShOU|d Select Points to Export :

' . i Station | Offset | Feature

be used as a suffix ] -. _ o N CuRe

for all fields except | : . HELLo
ao Mo 0+00.00 HELLO

the last one. oEley  0+00.00 HELLD

HELLO

Example, if

t

0 25 000,00 el HELLO ||
elevation is your I~ Include Header Apply et oo Hs ¥
last field, it should
not have a suffix.

Point#, North(Y), East(X) and Elev (Z) are the main fields imported
into survey equipment. The Station and Offset Fields are not usually
used in files to be imported into survey equipment. Station and Offset
Fields are used in coordinate tables that printed in the plans.

The “Include Header” option should be turned off.

Select the points to export to the survey file and select the “Apply
button” to create the file.

The survey ASCII file can be reviewed with a text editor to insure it
was created correctly.

To export alignments and profiles from GEOPAK:

Open cogo for the applicable gpk — job.

From the Cogo dialog box, select “File>Export>Alignments and
Profiles”.

The “Export Alignments =10 x|
and PrOfIIeS" dlalog bOX Expart Format  Trimble DC I Wersion 7.5 | Int'| Footl
should open.

Chain__| |PR_ND32
Set the “Export Format” __Profile | [PRP32
to Trimble DC. Set the OuputFle  [PR_ND3Zde

Version to 7.5. Set the
Foot to international
(“Int’l Foot”). Do not use “US Foot”.

Apply
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V. Select the appropriate Chain and Profile. You will have to create a
separate “dc” file for each alignment.

Vi. The “Output File” should have a “dc” extension. It will be written to
your working directory. Select the “Apply” button to create the file.

Vii. The “dc” file could be viewed with a text editor. However the format
is complex and it will probably not be practical to review without
additional Trimble software.
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Bentley Map

5.1 Geographic Coordinate Systems (GCS)

Dec 2010

The NDDOT has assigned a special coordinate system to each county. Most NDDOT projects
use one of these county coordinate systems. A library of these coordinate systems
(NDDOT_County_Coordinates.dty ) is included in the CADD Standards.

By assigning a GCS to each drawing you
enable additional capabilities. MicroStation

Tools  Utiities  ‘Workspace  Applications  Window Help  Documents MDDOT — Axiom

i [v Agrttes
and Bentley Map can use these GCS to project v emay _ SIEFIEEIIEEERFIEE
and re-project data from differ geographic : standard
coordinate systems. This data includes Bentley ‘1, [
data and many other formats such as pictures T— ;
and ESRI formats. Bose Geonety '

Civil Accudraw 3
The GCS’s are not set with the default NDDOT Changs Tracking ‘
seed files. They need to be set up on an g;'rj;i::::stems : —iEi
individual drawing basis. Set the coordinate Eﬁlf:;Linesmes '
system by gOing to TooIs>Geographic>SeIect Database i’ Current Geographic Coordinate System
Geographic Coordinate System. This will A e X Name: cNone>
bring up the "Geographic Coordinate System ' Diensions » s
D_ialog. Select the second button "From - E— —
| ———
lerary Eeve:js : :. 3 Export Google E:rt:(KML) File
Select the Coordinate system to apply to the | EZZLZ“!?E :'af ;: S
DGN file from the available selections. Most "=t O e,
Projects within the DOT will use one of the Barametris >3 8 Google Earth Settings
nN DDOT_COlJnty_COOI'dInateS" SyStemS E_raotl;:;n::wgation : B 9 Play Camera Animation in Google Earth
After selecting the appropriate Coordinate — y = Open 2 Tookox

System, click OK.

=101 x|

NDDOT_County_Coordinates
+| ora

Ok I Cancel
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Look in: I\'vLocaI Disk (C:) j Q Lf [ e =]

Hint: When working with
different GCS’s, look for and
use options to re-project data
such as in referencing.

E 100wz_CSDTL.dgn @Tupug_]unk. dgn
E 100WZ_ltmplt.dan tupog_red.dgn
m 140LT_DLitDe_Junk.dgn mtcpogjest. dan
160it_ditsdet.dan M topog_test_xM.dgn
Bentley_Seed_Problem.dgn
BridgaLe\rEIs.dgn

design.dan
mDsfmnog.dgn
o ]impart cells.dgn

junk2.dgn
junk3.dgn
(L] junk. dan Attachmert Method
M| LINESTYLE-junk.DGN Ineractive =
=
] ame. dgn Interactive
u\dseed‘dgn Coincident
Ered_{npng‘dgn Coincident World
- rp_test.dan Tep
- p_test.ag Bottom
My Networ test2.dgn Left
Places test3.dgn Right
tEst‘dgn Er:;t(

ETest_Prinﬁng.dgn
mmpcg‘dgn

4]
File name: Iiunk raster.dan j Open I

Fles of type: [CAD Fies " dgn dwg:” ) =l Cancel

Right lsometric
(Geograph

Geographic - AEC Transfom

hd ¥ Save Relative Path [ ptions
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5.2 Rasters and Geographic Coordinate Systems
Dec 2010

This section discusses how to assign GCS’s to rasters in order to enable the re-projection
capabilities. Most of the aerial photos — rasters that are created by the Surveys and
Photogrammetry Section are created using one of the following projection systems.

e State Plane North Zone — NAD83/ North Dakota North (Feet)

e State Plane South Zone — NAD83/ North Dakota South (Feet)

These rasters will reference into drawings that use the county ground GCS’s at a location that
may be close to the appropriate location, but not at the correct location. These rasters need to be
re-projected. Users need to tell MicroStation which GCS was used in each raster and
MicroStation will re-project the raster in the correct location.

First, the data in the drawing must match a defined coordinate system. Most of the drawings that
are delivered by the Surveys and Photogrammetry Sections or other drawings that use Surveys
and Photogrammetry’s drawings as a direct reference have a matching defined coordinate
system.

Second, your user preferences for Raster Manager — Georeference must be set up correctly. See
Section 2.5.

Thirdly, the appropriate GCS needs to be assigned to your drawing. See Section 5.1.

Now the rasters can be attached and GCS assigned.

I

Use Raster Manager to ]

Attach the desired
image(s). Make sure
that "Place
Interactively" is toggled
OFF. Click Open

=
Preview Attachment —————————————
File Folder 9/3f2003 9:35 Al ™ Raster Preview
File Folder 91912010 3:30 PT
91,10...  TIF Image 9/9{2003 4:52 PI
81,18.. TIF Image 9/9{2009 3:42 PI
52,99... TIF Image 9102008 8:52 ¢
91,66, TIF Image 9/3i2003 4:56 FT

I"UEU51 SFlights.tif* "090571 8FlightE. " “09051 Ej

| Common Raster Formats |
¥ Dpen as iead-only
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The Raster Attachment Options Dialog will open. On the
Geometry ribbon make sure that the Geo Priority is set to

Action 2 AttachmEnt-
General <
Image @
| Gen Priority h |
Calor w
Display Print 4
Extended

Attach I Cancel |

The final step is to set the coordinate system for the Raster Image. You can access the selection
Dialog in one of several ways.

&8 Raster Manager : 3 of 3 listed

File Edit View Display Settings  Ukilities
1. Select a single raster in the Raster B~ |_5| B - En B B ® B
Manger Dialog Box. Right Click on the
selected Raster and select Coordinate
System>Select From Library.

il File Mame | Description

% (19051 2Fligh Coordinate System Seleck From Library...
(i) 090518Flight  Transparency...
(igh 090518Flight File Name. ..

Celete

OR

2. Select a single raster
in the Raster Manger
Dialog Box. In the
Raster Manger
Dialog box access

& Raster Manager : 3 of 3 listed
Edit Wiew Display  Settings | Utilities

'I_E‘ B vy B Edwes

Lavers...

File Mame

Coordinake Swstem

e 28 Tl -'_!TT%

the Utilities Menu B, 0505 1 S lghi tf CaRerency —
i (b 09051 8Flights. tf e Mame... v v

ér:)dOfg:ﬁgie i (E 09051 5Flight 7. tif Contrast Brightness Voo
&

System>Select From '

Library.

OR
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This final option will allow you to set
the coordinate system for one or many
images at the same time. Double Click
on One of the images in the Raster
manager which will bring up the
Element Information Dialog Box. If
desired, Select all of the images in the
Raster Manager Dialog box that you
wish to set to a single coordinate
system. All of the selected images
should be shown in the Element
Information Dialog box. To set the
Coordinate system you will need to
access the Geometry section of the
Element Information Dialog box.
Expand the Geocoding item under the
Geometry section by click the Plus sign
next to if necessary to access the Name
field. Click the in the Name Settings
field, which may be set to <None> at
this point and click the Drop down
arrow to access the Coordinate System
operations buttons. Click the "Select
Geographic Coordinate System From
Library" button.

© Element Informatic I ]

:Selection>
B Raster Attachment [T:AControlled Projectst 100830001004 ozaic 09051 £Flig
; B Faster Attachment [T:A\Controlled Projectst 10083000, 1004 ozaic 09051 £Flig
LB Raster Attachment [T:%Controlled Projects41 0053000, 1004 0zaict 03051 8Flig

4 | i

Geometry

-'--__’ Attachment
Azpect R atio Locked
Origin *Waries™  ““Varies™.0.0000
Directional Yectors
Pixel Size
Bl Scale
" *Waries™
It *¥anies™
Bl Dpi
b 300
y 300
Bl Dimension
H **¥Yaries™™
y *¥aries™™
El Mumber of Pixels
] **Varies™™
W **¥aries™™
R otation *Waries™
0*0'o”
t Geocoding
<None> ‘ =
i M % d‘
Inkerit GealS from kodel @l
Extended 2
Raw Data o
Image v
Colar 2
Display Print 5

Each of the 3 options listed above
will bring up the Select

I]) Select Geographic Coordinate System

. ) Library |Search I
Geographic Coordinate System B Favores ~
Dialog. Select the Coordinate R NODOT Gty Coseinstes :I

. —atate_Plane_Morth_Zone - NAD23 / North Dakota Morth ft) (NADE3. NO-RT
system appropriate for the {23 Siate Flane_South_Zons - NAD82 / North Dakota South ) [NADBS.ND—SH_)D
Raster(s) selected. In most cases n;eG el ;ﬂ;’:;:} o
. . round Coordinates Soi nef
thls WI” be one Of the 2 North 423 Bames Courty - ND' Bames Courty Ground Coordinates South Zonefft)
Dakota State Plane SystemS, either -42% Benson Courty - ND Benson County Ground Coordinates North Zonedt)
423 Billings County - ND Billings County Ground Coordinates MNorth Zoneft)
North or SOUth' These GCS have 423 Bottineau Courty - NO' Bottineau County Ground Coordinates Morth Zonefft)
...4m% Prwman County - NN Bowman Caontw Graund Coordinates Sonth Zonaft

been copied to the
NDDOT_County_Coordinates
Folder for easier access.

Click OK

The Raster Images will be re-projected from the coordinate system you selected for them into the

Ok Cancel

Coordinate System selected for the DGN file.
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5.3 Web Map Services (WMS) and Raster Manager

July 2015

A Web Map Service can be used with MicroStation Raster Manager to reference existing data.
Two different data source are discussed in this section; OnRamp and NAIP imagery. These data
sources are used by many NDDOT ArcMap users. Now this data can be accessed directly from
MicroStation.

The following are instructions to reference a WMS.

1. Attach a Geographic Coordinate System to your drawing. See the previous section
5.1 (GCS).
Jo|=TES
2. Open Raster Manager and select 5 R |
FiIe>NeW>WMS from the Raster e o 00 URLfor WHS Seve v@ﬁmm
Manager Dialog. The WMS Map e I r—

Editor dialog box should open.

Mo server selected |

3. Click on the “Servers” button. The
Servers Manager dialog box should
open. Several URL address should
be shown in the left panel. Two of
these addresses should be marked
with a star as favorites by default.

Map Definition

No map defined. |

OnRamp data from the NDDOT GIS server
http://qgis.dot.nd.gov/arcgis/services/cad/basemap dot/MapServer/\WmsServer

NAIP imagery
http://ndgishub.nd.gov/arcgis/services/All Imagery/MapServer/WMSServer

=k
@ x i \

7 s A |
T =

- http://gis dot nd gov/arcgis/services,/cadbasemap_dot/Map Server/ WmsServer
w hitp://ndgishub nd gov/arcgis/services /Al _Imageny/Map Server/ WMSServer
w0 http://ndgishub nd.gov/ArcGIS/services/Imagery/Aeriallmage_DES_BaseMap/|...
http://b5m gipuzkoa net/wms/gipuzkoa_wms
http://ceoware 2.cors nrcan.ge.ca/cubewend/cubeserv/cubesery cgi
http://cgns nrcan.ge.ca/wms/cubeserv cgi
http://datamil delaware gov/wmsconnector/com esr wms Esimap,/DE_zeral 12
http://deli.dnr state . mn us/cgi-bin/wms map=DELI_WMS5_MAFFILE
http://demo.cubewent.com/demo/cubeserv/cubesery cai

http://gecint Imic state mn.us/cgi-bin/wms
it fmms et e i _l;l
3

cad_basemap_dol

URL http://giz_dot_nd_gov./arcgis/services/cad/basemap_dot/Maps
Abstract OGC:WMS



http://gis.dot.nd.gov/arcgis/services/cad/basemap_dot/MapServer/WmsServer
http://ndgishub.nd.gov/arcgis/services/All_Imagery/MapServer/WMSServer
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4. Select one of these addresses and click the Ok button. The Servers Manager dialog
box will close and the address will be entered into the WMS Map Editor dialog box.
Near the upper left corner of this dialog box there will be a panel that shows a layer

tree.

5. Select a desired layer (branch). Then select the “Add to map” button. The Layer will
be added to the Map Layers panel in the lower left. This step can be repeated to add
additional layers from the same server.

It} wins Map Editor - Creating new map _ O] x|
j Servers... |
. Settings | Previewl
. nt_l,l-i_l,l Title microstation/microstation
@ Reference LIRL http: #fitddotnas?. itd_nd_gov/ArcGlS /servi
- Boundaries Sbstiact DGC:WMS
[ T ﬂ
[ Add to map | Layers
\"-—— Fiange Method Usze range limits
Map Lapers [l Map Fange Limits ; ;
- Layer Ranges Use intersection of ranges of layers
| Layer Title | Layer Nan @l todel Coordinate System Use useful range as limit
Map Coordinate System Usze uzeful range asz limit
Gl B Geo Coordinates
Marth 90*00°00.0000"N
> | East 180°00'00.0000"E
- South 90°00°00. 00005
West 180°00"00.0000"w
Coardinate System EP5G:4326
1| | _;I Format image/png _ﬂ
Save... I Save atid Attach.. | Cancel | ,
rd
6. Select the “Save and Attach” button near the lower right. You will be prompted to

name and save a file (.xwms) that contains the WMS linking information. After you
have saved the .xwms file, the Raster Attachment Options dialog box will open.

P:_!Rastern fac =

7. Expand the Geometry panel within
the Raster Attachment Options
dialog. Within this panel set the
property “Inherit GeoCS from
Model” to “Not Inherited”. Then

Click the Attach button.

Note re-projected rasters can’t presently be

clipped in MicroStation.

=

=101 x|

]

------ BA C\Documents and Settings‘jcollado®\Desktop'Dot Boundaries xwn

“| | 2
General L]
Image S

Geo Priority
Inherit GeoCS from Model

Color
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CADD Standards

6.1 Axiom Title Block Manager

Oct 2008

The Axiom Title Block Manager (TBM) tool is used to edit (manage) MicroStation title blocks
and tags. This tool allows multiple title blocks and tags from multiple drawings to be edited
from one spreadsheet.

1. General Title Block Manager Setup

a.

Only the Central Office has access to this tool. The tool “Title Block
Administrator” should be available within MicroStation under the Axiom pull
down menu.

TBM will work with a blank Microsoft Excel spreadsheet. Users can save a
blank spread sheet to their project directory before they start TMB or this can
be created while running TBM (see step 2c). A preformatted spreadsheet was
previously used in early TBM test and demonstrations. However, a couple
complications with using a preformatted spread sheet were discovered.
Presently, using a preformatted spreadsheet is not recommended.

The standard sheet cells published after April 2005 need to be used. These
cells have tags attached. The old standard sheet cells published before April
2005 don’t have tags for title blocks.

Don’t Drop your Sheet Cells. Your Tags and Title Blocks will have to be
recreated. Dropping cells should be avoided, because it takes time and can be
complicated.

This section doesn’t discuss TBM in detail. For more information on TBM
see Axiom’s User Guides;
m:\apps\production\design\axiomV8\tbadmin\tbaminv8.pdf

2. Update Title Block Manager Excel Spreadsheet from Selected Drawings

a.

b.

In Title Block Administrator’s main dialog box, Select Action: “Update
database from selected design files.”

Click the <Select> button to the right of the “Design Files:” field. The dialog
that opens allows you to select a batch of files for processing. Select the files
that you want to manage. You need “write access” to these files and they
should all use standard sheet cells. After selecting the files that you want to
manage, click <OK> to return to the Title Block Administrator main dialog.
Select your database (Excel Spreadsheet). This could be an empty spread
sheet that you created before you started TBM or you can have TBM create
one for you now by typing in a path and file name. Remember Excel files
have an xIs extension. Also note that spreadsheet can’t be open while you run
TBM.

Select a name and location for your report file. Example (c:\temp\TBM.rep).
This file only documents what you have done.
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This step is optional. If you want to work with just one type of tag set within
one spread sheet, the specific tag set or sets can be specified in the TBM
settings. Example, if you only want to edit just DIP tags in one spread sheet,
you would select “Settings>Change Settings” from the TBM pull down menu.
Then you would type “bordercell” in the “Tag sets to process” field. Note, the
character “*” can be used in the “Tag sets to process” field. The “*” character
means it will process all tags within the drawing.

CAUTION, if you process multiple tag sets at one time, your spread sheet
may imply false tag relationships. Example, you may need to process a cell
with the tag sets named “bordercell” and “titleblock”. The tag named
“bridge” is part of the tag set named “bordercell”. However your spread sheet
will contain a cell for the tag named “bridge” in the tag set named
“titleblock”. This is a false relationship. Nothing will happen if you fill it in
because it doesn’t exist within your drawing. These false fields are not
important if you remember that they are not used. You must be aware of
which tags belong to which tag set.

Click the Start button to begin the update. At the end of processing, you will
see summary totals. Click <OK>.

Now you can select <Display Report> to see a summary of what was done.
Open the Excel by pressing the <Edit Database> button to see what was
added.

Update Selected Drawings from Title Block Manager Spreadsheet

a.

b.

If you just completed step 2, your file list is still there as <Edited File List>.
If not, use the <Edit List> dialog to select your files.

Open database by clicking on the <Edit Database> button. You will see all of
your design files represented one row per tag set. Note most sheet cells have
multiple tag sets.

Edit the data fields as needed. The data fields have been grouped by tag sets.
You may have to sort on the tag set name in order to edit groups of data fields.
Note, page and section numbers should not use preceding zeros — place
holding zeros in the title blocks.

Save and close the spreadsheet.

In MicroStation - Axiom, change the “Action:” to <Update selected design
files from Database>. Make sure that your TBM spreadsheet is selected and
you have specified a report file.

Now click <Start> to begin the update. At the end, you will see summary
totals.

Click <OK> to those totals.

Open the MicroStation files to see your changes.
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6.2 Axiom FileRename and FileResequence (Custom Macros)
Oct 2008

The FileRename macro will add the section number and sequence (page) number to the front of
your file name. You can only do one section at a time and the files must be sequential, but the
files do not have to be MicroStation files. You can use this macro for all types of files.

In order to use the FileRaname and FileResequence macros, a list of files names that you want to
rename must be stored in an ASCII file with a “lis” extension. Axiom “Title Block
Administrator” can be used to create this list.

Creating an ASCII list File X
File Settings Help
1. Open a MicroStation drawing file that Agtion:_Update datsbase from selected designfies. |
is not going to be added to the list. - B
2. Click on “Axiom > Title Block F::ab:e: :ci&emp:xgms z:m
.. . ort File: | ctemp = ect...
Administrator” on the menu bar. P
Start | Digplay Report Edit Database I Cloze |

3. Click on the “Select” button.

4. Click the “Browse for files and add to list” button. Select
the file that you want to be first in the sequence. Multiple E Sattings ST
files can be selected by holding down the control key while .J 3| 2
the files are selected. The order that files are selected is @ S | =X ‘ =

. .. ) ) Files to P | si |
important because this influences the order drawings will be  Cromrdor—— 55ks
7] ” H H C:hjunk2 d 1455 KB
renamed. Select “Open” to add the files to the list. i oo 4R K
C:4junkd. dgn B25 KB
. . . C:hjunkaa.d 149KR
5. When your list is complete, click the save button or select e
“File > Save File List” on the menu bar.
Ok | Cancel |
6. A “Save File List” dialog box should open. The “Save as 5 files in st (776.5 KE) Y
type option” needs to be set to “Plain 21 x|
Text LISt Fi IeS (*. |St) Save in: I = Local Disk (C:) j 3 X P -
|1 04c7f2c0dabd 70971839910 |3 GuidSiagn =
7. Type in a name for the file and save the 3*"““_5 3_‘7‘3? g:
. . . . arcgis iplo
file in your project directory. | BentieyDonnloads &m =T
Config.Msi djcollado's Music =
. “ R |__)Documents and Settings [iLotus IF
8. Click OK to close the “Choose Filesto  |=orivers SMainframe =Y
Processn dla|Og bOX |_)Geopak_Legal_Description_Editor Ms0Cache I=r
| | |
0. Close the Title Block Administrator Fie name: EZ
d|alog bOX ECULER R | Plain Texd List Files (*Ist) Cancel |
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Running the FileRename Macro

1. An ASCII list file is needed before running this macro (See creating and ASCII list
file). The files in the list should not be open because the macro will not be able to
rename them while they are open.

2. Click “Utilities > Macro > MicroStation Basic” on the menu bar.
3. In the Macros dialog box scroll down to the ) Macr o]
FileRename macro. Click the Run button. Macro Name
ColConv Traill A -
4. Choose the section number from the list and CoConviValsh
. CoConv\Ward B
click OK. CoCorvWells | =
CoConvWiliams Detail...
5. Enter the starting sequence (page) number and '
click OK. _rowse.. |
Mew
6. Locate the ASCII list file you previously saved
(Creating an ASCI| list file, step 7).
7. Click the OK button on the Information dialog box to finish the process.

If you have to add a file in the middle of a section, you can quickly renumber the files following
the inserted file by using the FileResequence macro. The FileResequence macro will change the
sequence (page) number of existing files. You can only do one section at a time and the files
must be sequential, but the files do not have to be MicroStation files. You can use this macro for
all types of files.

Running the FileResequence Macro

1. An ASCII list file is needed before running this macro (See creating and ASCII list
file). You will only have to add the files that come after the file you added. The files
in the list should not be open because the macro will not be able to rename them
while they are open.

2. Click “Utilities > Macro > MicroStation Basic” on the menu bar.

3. In the Macros dialog box scroll down to the FileResequence macro.

4. Click the Run button.

5. Enter the sequence (page) number that comes after the file you inserted and click OK.

6. Locate the ASCII list file and click OK.

7. Click the OK button on the Information dialog box to finish the process.
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Other Standards and Procedures

7.1  As-built Plans (Record Drawings)

May 2016

The “Construction Records Manual” (Section 7) discusses what is to be included in As Built
Plans. As-Builts can be hand drawn or created electronically. The following instructions for
creating as-built drawings are recommendations. This section of the CADD Standards Manual
elaborates on “how and where” to specifically include this information in the CADD files.

All as built information that is different than the information from Design will be kept in the As-
built Folder located in the project directory (see Section 2.1). As-built plans will be assembled
in the same manner that the Design Plans were assembled. If design details were documented in
one drawing then referenced in cut sheets, then the as-built details should be documented in one
drawing then referenced in cut sheets.

Example: A driveway was not built at the location shown in the design plans. Originally the
driveway information was specifically drawn in the file
R:\project\80046083.017\DESIGN\design.dgn

then referenced into

R:\project\80046083.017\DESIGN\Sheets\pp geelanl.dgn.

The person creating the as-built drawings should create new drawings named “design AB.dgn”
and “pp geelan1AB.dgn”. Note that the file name uses a suffix modifier “AB”. Section 2.2
discusses file naming requirements. As-built drawings are the only drawings where a suffix
modifier is mandatory. All as-built drawings are to be named with a suffix modifier “AB”.

The as-built changes should only be made to the new files within the as-built folder. Include
only the features that have changed from the original design. The as-built driveway would be
drawn within R:\project\80046083.017\Asbuilt\design AB.dgn and then referenced and clipped
into R:\project\80046083.017\Asbuilt\Sheets\pp geelanlAB.dgn. The pp geelan1AB.dgn should
reference the original drawing pp geelanl.dgn. Remember to use a reference nest depth of “1” in
order to reference the original sheet and all of its references.

Most as-built drawings reference the original design drawings. Referencing is usually preferred
over copying because changes can be quickly identified and it is less redundant. However there
are exceptions to referencing for as-builts.

Some as-built files need to be copied from the original design file and then edited in order work
with GEOPAK. The GPK file and Cross Section files should be copied from the original design
folder.

As-built drawings with extensive changes are another exception to referencing. Drawings that

have many revisions can be copied an edited for simplicity. For example a detailed drawing of a
Lift station may have many revisions. This drawing could be copied from the design folder into
the as-built folder. Then the revisions could be made to the typical drawing without referencing.
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Remember to rename these copied drawings with the as-built “AB” suffix modifier.

The element symbology for as-built drawings should be the same as the symbology used for the
design plans. Unique element symbology is desired in as-builts for the same reasons it is
desirable in design plans. We want to be able to quickly identify features both in as-built and
design plans. However all as-built drawings need to use “level symbology”. Traditional as-
builts are black and white with the exception of the as-built information. As-built information
should appear blue. When creating as-built drawings the ‘level symbology” for all design
drawings should be set to color “0” (black and White) and the “level symbology” for all as-built
drawings should be set to color “1” (blue). This symbology should produce a black, white and
blue set of plans.

Creating as-built’s from drawings that were created with Pointer files requires additional
adjustments. See previous section 3.12 for a discussion on Live Nesting and Pointer files. If a
Pointer file is used in the original plan sheet, the as-built sheet should be created by referencing
the as-designed sheet with a nesting level of 2.

As-built plans shall be assembled in the same manner that the Design Plans are assembled except
that the words “As-Built”, shall be placed directly under the project number in the upper right
title block.
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7.2 Design Division’s Quick Maps

July 2015

This tool is used to create maps for “Design Plan Title Sheets” and “Construction Haul Road
Restriction Maps”. It can also be used for other Design Plan Sheets and Project Concept Report
maps.

If you just want a simple county map, don’t use this service. County maps as pdf’s can be
retrieved from www.dot.nd.gov/road-map/county-base/index.htm .

The following steps explain how a plan title sheet image can be created. There could be several
variations to this process.

1. The Design Division’s Quick Maps are accessed through the web;
http://qis.dot.nd.gov/external/ge_html/?viewer=quickmap.

2. The tools for Quick Maps are relatively self-explanatory. Hover your cursor over
these tools to learn what each tool does. A text description of the tool should appear.

Design Divisions Quick Maps:

s Bl Pownrmd by NODOT
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Measuremen
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Measure Area
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= 5h i o Mg
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es - Large Seale
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24 : Locate By: (0} Address | Coondinates
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http://www.dot.nd.gov/road-map/county-base/index.htm
http://gis.dot.nd.gov/external/ge_html/?viewer=quickmap
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3. There are several new features with
this version of Quick Maps. T :
R R Drawing Tools ﬁ
a. Drawing Tools are available
within quick maps. R (soid 2]
Line Color: l srreccerr [  ~ ]
Line Opacity: U
Line Width: z -

Draw Arrow: Yes x

|| Freehand

b. There are “Opacity” (Transparency) % v
tools for layer control. map content €2 €3

4 [] NDDOT Data

> [ cities

|« Transportation
|| water

|« Boundaries

[ |+ State Boundary

» || ND Imagery

Locations can be bookmarked.
“Locator” (Geo-coding) tools are available.
e. The new “Overview Map” helps you keep your perspective when
you are zoomed in. This tool accessed from the lower right corner of
the screen. IE

Qo

4. There are a few changes with the new version of quick maps that may side track
people who have used the old version of quick maps.

a. You may have to click on a
view control tool that you
don’t want to use to see and
use other options (Example,
if you want to zoom in, you
may have to click on the
“zoom out” tool in order to

get to the “zoom in” tool. 200 In Wigueg®  Pan
Identify

b. There is no built in tool to save an image as a pdf. The available options are
jpeg, png and tiff.
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C. All of the layers can‘t be turned off. The background layers are always on.
However they can be overlap or hidden by adding other layers.

d. There is no option to create a legend.

e. There are no querying options.

f. There is no zoom to fence option.

Use the zoom and view control commands to @ .

generate and view a map similar to what you want zoom 7o RS

to use for your design plan sheet. If you’re using (Zoomto Scale v | ZoomTo

“Zoom to Scale” options; 126720 scale works 250,000 v | Seale

good for title sheets, 250000 scale works good for
haul road restriction maps.

Quick Maps has tools that can help you navigate to @
a specific location in the state by selecting either a; Zoom To
l

a. Highway and Reference Point

b. City Ref Pts

C. County Sections

d. Section, Township and Range Cities

e. District Counties
Districts

Zoom to Scale

The Map Content dialog box shows features - layers that can be turned on and off

similar to ArcMap and MicroStation Levels. Set the layers “on” or “off” as needed.

Note that certain levels are only available at certain scales. More levels are available

as you zoom in.

a. Pay special attention to the layer NDDOT Data>Boundaries>County-Large
Scale. Turn on or off this layer to hide or display the background layers.

b. The layer “NDDOT Data>Transportation>Restricted Construction Haul
Roads” is used for “Construction Haul Road Restriction Maps”.

Once you have created a view that you will want to use for your map. Click the
“Save Map Image” icon. Note your view of the image and the actual map that will be
generated will be slightly different. The 15x9.5 aspect ratio — size works well for
plan sheets. Save your image to your project folder.

Additional notes for working in MicroStation:

a. The “Raster Manager>Edit>Clip” tools can be used to further process the
image within the drawing.

b. The PE stamp is not required for the Haul Road Maps. Use the Plan sheet
(Plan3) without title blocks.
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7.3 Tags, Professional Stamping and Signing

Sept 2010

Most Consultants and NDDOT Districts don’t have Axiom Title block Manager. However,
these people still need to use the same sheet library (sheets.cel) and still have to address the
professional engineer stamping requirements. The following notes discuss how these users can
operate.

1. The sheets library has been modified. Most of the title blocks for the sheet cells have
been filled with “tags”. Tags are special MicroStation elements that look like “text”
elements.

a. These tags have been added so that the sheet cells can be used with Axiom
Title Block Manager. However, you don’t need TBM to edit these tags. The
tags can be edited with just the MicroStation “Edit Tags” tool.

b. Title block tags can be deleted without dropping the cell. So if you don’t want
to use them, they can be deleted and you could fill out the title blocks with
normal text. However, the Standard Committee recommends using the “Edit
Tags” tool. The preformatted tags are setup with the standard symbology.

2. Several of the standard sheets have a title block for a profession engineer’s or
registered surveyor’s stamp. A special note is included in these title blocks. The note
must be included when the drawing is transmitted electronically. Do not fill in the PE
stamp tags until the plan sheet has been sealed by a PE. By filling in this information,
you are stating the sheet has been sealed. In order to avoid having to maintain
multiple versions of a drawing (preliminary, one for stamping and one for electronic
distribution), special print drivers and pen tables are being used to control when the
PE note is printed and when it is not printed. The following pen tables are used:;

a. Preliminary.tbl
b. PE_Stamping.tbl
C. Electronic_Distribution.tbl
3. The title sheet has several signature lines. When the design plans are electronically

distributed or archived, these signature lines need to be electronically filled out. The
signatory name should be spelled out followed by characters “/s/*. These lines should
only be filled out after the plans have been signed. The text used for the signature
line should be on the level named “Sht Stamp Text” so that it is displayed through the
pen tables in a manner similar to the standard “Electronic Distribution Statements”.

APPRCVED DATE I hereby certify thatthe attached plans were
preparad by me or under my direct supervision
and thatlam a duly registered professional
engineer under the laws of the state of ND.

OFFICE OF PROJECT DEVELOPMENT
ND DEPARTMENT QF TRANSPORTATION
APPROVED DATE

APPROVED DATE

NDDOT DIV-DIST OR CONSULTANT FIRM

FEDERAL HIGHWAY ADMINISTRATION
U.8. DEPARTMENT OF TRANSPORTATION
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7.4  Addenda and Change Orders

May 2016 — Partial Deletion

Plan revisions before the Bid Opening are referred to as Addenda. Plan Revisions after the Bid
Opening are referred to as Change Orders.

All plan sheets cells have an area (revision block) reserved for addenda and change order
information. This revision block is part of the upper left title block.

2/10/10
3/7/10

SECTION SHEET

JE PROJECT NO. NO. NO

project number sec | page

Addendum and Change Order plan sheets shall include the words “Revised” or “Sheet Added”,
as applicable, and the date in this revision block. If the sheet was previously revised as an
addendum or change order, keep the original revised note and add another one (example:
Revised 2-10-10, Revised 3-07-10). If the project is moved to a later bid opening or if the
project is rebid, the revision block should be reset to “null” entries (blank fields) and the sheet
should be included in the plans as a normal sheet.

This revision block contains a MicroStation tag set Named “Revision_Box”. This block contains
enough tags for 4 revisions. There are tags to describe the type of change (“Revision” or “Sheet
Added”) and tags for the dates. The Revision_Box tag set can be edited with Axiom Title
Block Manager or the standard MicroStation “Edit Tag” tool. The default tag values are empty.
You cannot see the tags when the sheet cell is first placed, but they are still part of the cell.

If an addendum or change order added or voided a plan sheet, the plan sheet containing the table
of contents must also be revised as part of the change. The table of contents does not need to be
revised if the revised sheets are already listed.

If sheets need to be added in the middle of a section, alphabetical suffixes should be added to the
sheet number (example: section 80 sheet 10A, section 80 sheet 10B, section 80 sheet 10C ...).
Alphabetical suffixes should only be used for sheets added with an addendum or a change order.
These suffixes should not be used in the original plans. The original plans should always be
renumbered if sheets are added.

A separate pdf shall be created for each Addendum or Change Order. The original posted PDF
file shall never be edited. The separate pdf shall only include the sheets that have been revised.

When the plans are signed, all of the files should be set to read only. The read only setting shall
not be turned off.
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All plan revisions (addenda and change orders) shall never be made in the original files. The
original files shall never be edited after they have been signed and sealed. If changes are needed,
copies of the files should be made.

All plan revision information shall be kept in separate folders located in the designers
corresponding project directory (see Section 2.1). A separate folder shall be used for each
addenda and change order that is issued. A new folder named “Addendum (followed by a letter)
shall be added for each addendum that is issued (Ex. “Addendum A”). Likewise, a new change
order folder (followed by a letter) shall be added for each change order that is issued

(Ex. ChangeOrder A.) When the next revision is added, the folder should end with the next letter
in the alphabet. When starting a revision, check the other designer’s folders for previous
revisions. If someone is already working on a revision, check to see if your sheets can be added
to it.

Examples:  R:\project\80046083.017\DESIGN\Addendum_A
R:\project\80046083.017\DESIGN\Addendum_B
R:\project\80046083.017\DESIGN\Addendum_C
R:\project\80046083.017\DESIGN\ChangeOrder_A
R:\project\80046083.017\BRIDGE\ChangeOrder_ A
R:\project\80046083.017\BRIDGE\ChangeOrder_B
R:\project\80046083.017\TRAFFIC\ChangeOrder_A

The original files should not be modified for addenda and change orders. If changes need to
be made to a file, the file should be copied into the respective addenda or change order folder
and a suffix modifier shall be added to the end of the filename. Addenda shall use the modifier
“AD” followed by the group letter. Change Orders shall use the modifier “CO” followed by the
group letter (example: 060PP_004_PP_AD-A or 060PP_004 PP_CO-A). If sheets were added,
the sheet number suffix should be used in the file name (example: 060PP_004A_PP_AD-A).

If design details were documented in one drawing then referenced in cut sheets, then the revised
details should be documented in one drawing then referenced in cut sheets.

Example: A driveway should not be built at the location shown in the original design plans.
Originally the driveway information was specifically drawn in the file
R:\project\80046083.017\DESIGN\design.dgn then referenced into
R:\project\80046083.017\DESIGN\Sheets\060PP_006_pp_geelanl.dgn. The
person creating the change order drawings should create new drawings named
“design_CO-A.dgn and 060PP_006_pp_geelanl_CO-A.dgn. Note that the file
name uses a suffix modifier “CO-#,” where # is the change order group letter.

The change order modifications should only be made to the new files within the
Change Order folders. Include only the features that have changed from the
original design.dgn file to the design CO A.dgn. The change order driveway
would be drawn within
R:\project\80046083.017\DESIGN\ChangeOrder_A\design_CO-A.dgn and
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then referenced and clipped into
R:\project\80046083.017\DESIGN\ChangeOrder_A\Sheets\060PP_006_pp_
geelan1-CO-A.dgn.

When changes are made to a drawing that is referenced into other drawings, all parties involved
in making the original plans shall be notified of the changes and the location of the new revised
drawing.

Most revised drawings reference the original design drawings. Referencing is usually preferred
over copying because changes can be quickly identified and it is less redundant. However, there
are exceptions to referencing for addenda and change orders.

Some addenda and change order files need to be copied from the original design file and then
edited in order work with GEOPAK. The GPK file and Cross Section files should be copied
from the original design folder.

Drawings that do not have reference files attached or drawings with extensive changes can be
copied directly into the Change Order folder and do not need to be referenced back into the new
change order drawing. All of the changes can then be made in the change order drawing. For
example, a detailed drawing of a Lift station may have many revisions. This drawing could be
copied from the design folder into the Change Order folder.

Remember to rename these copied drawings with the addenda “AD-#" or change order “CO-#"
suffix modifier.

The element symbology for these revised drawings should be the same as the symbology used
for the design plans.

Refer to the Design Manual, Section 1-11, Plan Revisions and Change Orders, for additional
administrative requirements.
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7.5 Roadway Inventory Management System (RIMS)

Mar 2011

The Roadway Inventory Management System (RIMS) tool can export information to a PDF.
This manual does not intend to explain how to use RIMS. This manual only highlights some of
the options while print to a PDF.

RIMS files exported to PDF are named after your RIMS User ID, Year, Month, day and Time
(example, JONCOL1.080917085600.PDF). RIMS documents exported to PDF are created in the
directory: O:\000 Reports.

Print Sequence Numbers are used to control the print format. Some print formats don’t work
with some reports. Data may be clipped from the print or hard to read. The table below can be
used to help select the correct print format.

RIMS | Print Characters | Lines | Orientation | Size Typical Use

Printer | Sequence | per Inch per

ID Number | (CPI) Inch

(LPD

PDF 1 12 6 Portrait 8.5x11

PDF 2 12 8 Portrait 8.5x11

PDF 3 Landscape | 11x8.5

PDF 4 18 Landscape | 11x8.5

PDF 5 18 10 Portrait 8.5x11 Most Milestone Reports

PDF 6 18 10 Landscape | 11x17 Quantity Sheets with
Border

PDF 7 18 10 Landscape | 11x17 Quantity Sheets without
Border

PDF 8 8.5 Portrait 8.5x11 Milestone Reports with
less margins

Additional Notes
e PDF’s of the Quantity sheets and other should be stored in the project Directory.
e Please review, print, or store this report, then delete it from the site in order to keep this
folder manageable. The folder will be purged each month.
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7.6 Incorporating Microsoft Word and Excel Documents in PDF Plan Sets
Oct 2008

Plan sets contain some sheets that are created from Microsoft Word and Excel. These sheets
include the Table of Contents, Notes, and Traffic Control Devices List.

1. There are templates available for these sheets on the Plan Preparation Guide website
at http://www.ugpti.org/dotsc/prepguide/index.php. These are special sheets that
have macros built into them for printing.

2. Put the page numbers in the upper right-hand corner.

3. When printing these sheets, do not use the File => Print option from the menu bar.
Instead use the following method to print the sheets:
b. The Table of Contents and Notes sheets have dialog boxes that launch when

you first open the files. If you accidentally closed the dialog boxes, they can
be opened by closing and then reopening the file.

C. The Traffic Control Devices List has a Print Plan Sheet button located at the
top of the Input sheet.

7.7  Scanning Documents into PDF Plan Sets
Oct 2008

1. Assemble the plan sheets and put the section and page numbers in the upper right-
hand corner.

2. Scan the plan sheets and save them into the appropriate project directory with the
correct file name (see Section 2.2 and Appendix A.)

3. If this is a plan sheet that requires sealing by a PE, you will need two versions of

these sheets; one with the electronic distribution statement and one without it. The
version without the statement is needed for preliminary and PS&E plans. The version
with the statement is needed for final plans, addendums, change orders, and as-builts.
Do not put the statement on the plan sheet until it has been sealed by a PE.


http://www.ugpti.org/dotsc/prepguide/index.php
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Miscellaneous Help

8.1 Using MicroStation Files in Microsoft Word

Nov 2011

There are several ways to export a MicroStation drawing to a format that can be imported into
Microsoft Word. The following is a list of some of the common methods.

Windows Cut and Paste

Print Screen

MicroStation Image Capture Tool

Print Drawing to an Image file

Encapsulated Postscript (.eps)

Tagged Image Format (.tif)

Joint Photographic Expert Group (.jpg)
Microsoft Document Imaging

Clear Water

MPwnh e

Pop o

Window Cut and Paste is one of the easiest way to bring a drawing into Word. However, the
image quality is poor. Linestyles appear altered. Sometimes text is not exported. Images
imported using this method are not typically good enough for reports. This procedure is not
documented in this manual.

Print screen is another easy way to bring a drawing into Word. This method usually requires
considerable cropping once imported into Word. The background color usually needs to be
changed to white. Image quality is OK. This procedure is not documented in this manual.

The MicroStation Image Capture tool can be used to export images to a wide variety of image
file formats. This tool allows for cropping during the export process. The background color
usually needs to be changed to white. Image quality is OK. This tool can be found in the main
MicroStation pull down menu “Utilities>Image>Capture”. No further documentation on this
procedure is given in this manual.

Using MicroStation printing tools to export a drawing to an image file is typically the best
method to use for most NDDOT reports in the Word document format. Good image quality can
usually be maintained. There are numerous variations with this process. The active background
color used during the export process is less of a concern.
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Printing a Drawing to an Image File

There are several variations of this process. This manual will discuss how to export an
“postscript” (.eps) file from MicroStation. This format is recommended for word documents
because file sizes are small and image integrity is good.

The same techniques used to print a drawing to paper, using MicroStation print tools, are used to
print a drawing to an image file. The main difference is that different plot drivers are used.
Several plot drivers have been modified for NDDOT use. They are located at:
S\STANDARD\VS8I\plotdrv. From the MicroStation “Print” dialog box, select “File>Select
Bentley Driver”. The “Select Bentley Driver File” dialog box should open. In order to create
an eps file select S\STANDARD\VS8I \plotdrvANDDOT-pscript.plt. When you print the
drawing, you will be prompted for an eps file name and a location to save the file.

Once the image file (*.eps) has been created, it can be imported into Microsoft Word. In Word,
select “Insert>Picture>From File”. Then select the eps file.
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8.2 Bentley View

Oct 2008

If you don’t have MicroStation and you just want to view and print CADD drawings, this might
be the tool for you. This tool is relatively easy to use and it is free. People like district engineers
and administrative assistants could use this tool to view and print MicroStation drawings.

Exporting drawings to PDF takes little time. However, some reviews benefit from eliminating
even the smallest step. If all reviewers have CADD viewers, drawing preparation effort is
minimized. Bentley View does not “push” the information to the end user as much as PDF, but
it is more flexible in terms of not needing to process drawings into another format. Bentley
View reads directly from raw CADD - dgn files.

Some people don’t have MicroStation installed on their computer. It is not practical for them to
become proficient nor is it cost efficient to install a full version of MicroStation on their
computer. But occasionally they may need to review a drawing, (example a drawing was sent to
them by email). If this person had Bentley View, they would not have to ask the sender to
convert the drawing to another format or ask someone with MicroStation to help them view the
drawing. They could view and or print the drawing themselves.

This tool is free and is relatively easy to use. Addition help using Bentley View can be found in
its own help files.

NDDOT personnel should submit a work order request through the Work Management System if
they want Bentley View loaded on their computer.

Note, privileges to certain servers for certain uses may need to be adjusted. Some people may
benefit if they had access to the CADD Server.
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